
HPjmeter 4.3 User's Guide

HP Part Number: 5900-2630
Published: March 2013
Edition: 1



© Copyright 2005-2013 Hewlett-Packard Development Company, L.P.

Copy of Software License

END USER LICENSE AGREEMENT FOR SOFTWARE

PLEASE READ CAREFULLY: THE USE OF THE SOFTWARE IS SUBJECT TO THE TERMS AND CONDITIONS THAT FOLLOW (“AGREEMENT”),
UNLESS THE SOFTWARE IS SUBJECT TO A SEPARATE LICENSE AGREEMENT BETWEEN YOU AND HP OR ITS SUPPLIERS. BY DOWNLOADING,
INSTALLING, COPYING, ACCESSING, OR USING THE SOFTWARE, OR BY CHOOSING THE “I ACCEPT” OPTION LOCATED ON OR ADJACENT
TO THE SCREEN WHERE THIS AGREEMENT MAY BE DISPLAYED, YOU AGREE TO THE TERMS OF THIS AGREEMENT, ANY APPLICABLE
WARRANTY STATEMENT AND THE TERMS AND CONDITIONS CONTAINED IN THE “ANCILLARY SOFTWARE” (as defined below). IF YOU ARE
ACCEPTING THESE TERMS ON BEHALF OF ANOTHER PERSON OR A COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT AND WARRANT
THAT YOU HAVE FULL AUTHORITY TO BIND THAT PERSON, COMPANY, OR LEGAL ENTITY TO THESE TERMS. IF YOU DO NOT AGREE TO
THESE TERMS, DO NOT DOWNLOAD, INSTALL, COPY, ACCESS, OR USE THE SOFTWARE, AND PROMPTLY RETURN THE SOFTWARE WITH
PROOF OF PURCHASE TO THE PARTY FROM WHOM YOU ACQUIRED IT AND OBTAIN A REFUND OF THE AMOUNT YOU PAID, IF ANY. IF
YOU DOWNLOADED THE SOFTWARE, CONTACT THE PARTY FROM WHOM YOU ACQUIRED IT.

QUANTITY OF DEVICES:

1. GENERAL TERMS

a. You and Your refer either to an individual person or to a single legal entity.

b. HP means Hewlett-Packard Company or one of its subsidiaries.

c. HP Branded means Software products bearing a trademark or service mark of Hewlett-Packard Company or any Hewlett-Packard
Company Affiliate, and embedded HP selected third party Software that is not offered under a third party license agreement.

d. Software means machine-readable instructions and data (and copies thereof) including middleware and related updates and upgrades
You may be separately authorized to receive, licensed materials, user documentation, user manuals, and operating procedures.
“Ancillary Software” means all or any portion of Software provided under public, open source, or third party license terms.

e. Specification means technical information about Software products published in HP product manuals, user documentation, and technical
data sheets in effect on the date HP delivers Software products to You.

f. Transaction Document(s) means an accepted customer order (excluding pre-printed terms) and in relation to that order, valid HP
quotations, license to use certificates or invoices.

2. LICENSE TERMS AND RESTRICTIONS

a. Subject to the terms and conditions of this Agreement and the payment of any applicable license fee, HP grants You a non-exclusive,
non-transferable license to Use (as defined below) in object code form one copy of the Software on one device at a time for Your
internal business purposes, unless otherwise indicated above or in applicable Transaction Document(s). “Use” means to install, store,
load, execute and display the Software in accordance with the Specifications. Your Use of the Software is subject to these license terms
and to the other restrictions specified by HP in any other tangible or electronic documentation delivered or otherwise made available
to You with or at the time of purchase of the Software, including license terms, warranty statements, Specifications, and “readme” or
other informational files included in the Software itself. Such restrictions are hereby incorporated in this Agreement by reference. Some
Software may require license keys or contain other technical protection measures. You acknowledge that HP may monitor your compliance
with Use restrictions remotely or otherwise. If HP makes a license management program available which records and reports license
usage information, You agree to appropriately install, configure and execute such license management program beginning no later
than one hundred and eighty (180) days from the date it is made available to You and continuing for the period that the Software is
Used.

b. This Agreement confers no title or ownership and is not a sale of any rights in the Software. Third-party suppliers are intended beneficiaries
under this Agreement and independently may protect their rights in the Software in the event of any infringement. All rights not expressly
granted to You are reserved solely to HP or its suppliers. Nothing herein should be construed as granting You, by implication, estoppel
or otherwise, a license relating to Software other than as expressly stated above in this section 2.

c. Unless otherwise permitted by HP, You (a) may only make copies or adaptations of the Software for archival purposes or when copying
or adaptation is an essential step in the authorized Use of the Software on a backup device, provided that copies and adaptations are
used in no other manner and provided further that the Use on the backup device is discontinued when the original or replacement
device becomes operable, and (b) may not copy the Software onto or otherwise Use or make it available on, to, or through any public
or external distributed network.

d. To Use Software identified as an update or upgrade, You must first be licensed for the original Software identified by HP as eligible
for the update or upgrade. If the update or upgrade is intended to substantially replace the original Software, after updating or
upgrading, You may no longer Use the original Software that formed the basis for Your update or upgrade eligibility unless otherwise



provided by HP in writing. Nothing in this Agreement grants You any right to purchase or receive Software updates, upgrades, or
support, and HP is under no obligation to make such support available to you. Updates, upgrades, enhancements, or other Support
may only be available under separate HP support agreements. You may contact HP to learn more about any support offerings HP may
make available. HP reserves the right to require additional licenses and fees for Software upgrades or other enhancements, or for Use
of the Software on upgraded devices.

e. You must reproduce all copyright notices that appear in or on the Software (including documentation) on all permitted copies or
adaptations. Copies of documentation are limited to internal use.

f. Notwithstanding anything to the contrary herein, if the Transaction Document(s) identifies that the Software may be utilized on another
Designated System(s) (as defined below), Your license to Use the Software may be transferred to another Designated System(s). A
“Designated System” means a computer system owned, controlled, or operated by or solely on behalf of You and may be further
identified by HP by the combination of a unique number and a specific system type. Such license will terminate in the event of a change
in either the system number or system type, an unauthorized relocation, or if the Designated System ceases to be within Your possession
or control.

g. Operating system Software may only be Used when operating the associated hardware in configurations as approved, sold, or
subsequently upgraded by HP or an HP authorized reseller.

h. Software is not specifically designed, manufactured, or intended for use as parts, components, or assemblies for the planning, construction,
maintenance, or direct operation of a nuclear facility. You are solely liable if Software is Used for these applications and will indemnify
and hold HP harmless from all loss, damage, expense, or liability in connection with such Use.

i. You will not modify, reverse engineer, disassemble, decrypt, decompile, or make derivative works of the Software. Where You have
other rights mandated under statute, You will provide HP with reasonably detailed information regarding any intended modifications,
reverse engineering, disassembly, decryption, or decompilation and the purposes therefore.

j. Extending the Use of Software to any person or entity other than You as a function of providing services, (i.e.; making the Software
available through a commercial timesharing or service bureau) must be authorized in writing by HP prior to such Use and may require
additional licenses and fees. You may not distribute, resell, or sublicense the Software.

k. Notwithstanding anything in this Agreement to the contrary, all or any portion of the Software which constitutes Ancillary Software is
licensed to You subject to the terms and conditions of the Software license agreement accompanying such Ancillary Software, whether
in the form of a separate agreement, shrink wrap license or electronic license terms accepted at time of download. Use of the Ancillary
Software by You shall be governed entirely by the terms and conditions of such license and, with respect to HP, by the limitations and
disclaimers of sections 3 and 5 hereof. HP has identified any Ancillary Software by either noting the Ancillary Software provider's
ownership within each Ancillary Software program file and/or by providing information in the “ancillary.txt” or “readme” file that is
provided as part of the installation of the Software. The Ancillary Software licenses are also set forth in the “ancillary.txt” or “readme”
file. By accepting the terms and conditions of this Agreement, You are also accepting the terms and conditions of each Ancillary
Software license in the ancillary.txt or “readme” file. If the Software includes Ancillary Software licensed under the GNU General Public
License and/or under the GNU Lesser General Pubic License ("GPL Software"), a complete machine-readable copy of the GPL Software
Source Code ("GPL Source Code") is either: (i) included with the Software that is delivered to You; or (ii) upon your written request,
HP will provide to You, for a fee covering the cost of distribution, a complete machine-readable copy of the GPL Source Code, by mail,
or (iii) if You obtained the Software by downloading it from a HP website and neither of the preceding options are available, you may
download the GPL Source Code from the same website. Information about how to make a written request for GPL Source Code may
be found in the ancillary.txt file or, if an address is not listed in that file, at the following website: http://www.hp.com/.

3. WARRANTY

(i) IF SOFTWARE IS PROVIDED WITHOUT A LICENSE FEE, THE FOLLOWING AS-IS WARRANTY STATEMENT APPLIES TO THE SOFTWARE

DISCLAIMER OF WARRANTIES:

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, HP AND ITS SUPPLIERS PROVIDE THE SOFTWARE “AS IS” AND WITH ALL
FAULTS, AND HEREBY DISCLAIM ALL INDEMNITIES, WARRANTIES AND CONDITIONS, EITHER EXPRESS, IMPLIED, WHETHER BY STATUE,
COMMON LAW, CUSTOM OR OTHERWISE, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF TITLE AND NON-INFRINGEMENT,
ANY IMPLIED WARRANTIES, DUTIES OR CONDITIONS OF MERCHANTABILITY, OF FITNESS FOR A PARTICULAR PURPOSE, AND OF
LACK OF VIRUSES. HP does not warrant that the operation of Software will be uninterrupted or error free or that the Software will meet Your
requirements. Some states/jurisdictions do not allow exclusion of implied warranties or limitations on the duration of implied warranties, so
the above disclaimer may not apply to You in its entirety.

(ii) IF SOFTWARE IS PROVIDED FOR A LICENSE FEE, THE FOLLOWING LIMITED WARRANTY APPLIES TO THE SOFTWARE:

a. HP Branded Software will materially conform to its Specifications. If a warranty period is not specified for HP Branded Software, the
warranty period will be ninety (90) days from the delivery date, or the date of installation if installed by HP. If You schedule or delay



installation by HP more than thirty (30) days after delivery, the warranty period begins on the 31st day after delivery. This limited
warranty is subject to the terms, limitations, and exclusions contained in the limited warranty statement provide for Software in the
country where the Software is located when the warranty claim is made.

b. HP warrants that any physical media containing HP Branded Software will be shipped free of viruses.

c. HP does not warrant that the operation of Software will be uninterrupted or error free, or that Software will operate in hardware and
Software combinations other than as expressly required by HP in the Specifications or that Software will meet requirements specified
by You.

d. HP is not obligated to provide warranty services or support for any claims resulting from:

1) improper site preparation, or site or environmental conditions that do not conform to HP’s site specifications;

2) Your non-compliance with Specifications;

3) improper or inadequate maintenance or calibration;

4) Your or third-party media, software, interfacing, supplies, or other products;

5) modifications not performed or authorized by HP;

6) virus, infection, worm or similar malicious code not introduced by HP; or

7) abuse, negligence, accident, loss or damage in transit, fire or water damage, electrical disturbances, transportation by You, or
other causes beyond HP’s control.

e. HP provides third-party products, software, and services that are not HP Branded “AS IS” without warranties of any kind, although the
original manufacturers or third party suppliers of such products, software and services may provide their own warranties.

f. If notified of a valid warranty claim during the warranty period, HP will, at its option, correct the warranty defect for HP Branded
Software, or replace such Software. If HP is unable, within a reasonable time, to complete the correction, or replace such Software,
You will be entitled to a refund of the purchase price paid upon prompt return of such Software to HP. You will pay expenses for return
of such Software to HP. HP will pay expenses for shipment of repaired or replacement Software to You. This section 3.(ii) f states HP's
entire liability for warranty claims.

g. DISCLAIMER OF WARRANTIES

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, EXCEPT AS EXPRESSLY WARRANTED IN SECTION 3.(ii) a and b
ABOVE, HP AND ITS SUPPLIERS PROVIDE THE SOFTWARE “AS IS” AND WITH ALL FAULTS, AND HEREBY DISCLAIM ALL OTHER
WARRANTIES AND CONDITIONS, EITHER EXPRESS, IMPLIED, OR STATUTORY, INCLUDING, BUT NOT LIMITED TO, WARRANTIES
OF TITLE AND NON-INFRINGEMENT, ANY IMPLIED WARRANTIES, DUTIES OR CONDITIONS OF MERCHANTABILITY, OF FITNESS
FOR A PARTICULAR PURPOSE, AND OF LACK OF VIRUSES. Some states/jurisdictions do not allow exclusion of implied warranties
or limitations on the duration of implied warranties, so the above disclaimer may not apply to You in its entirety.

4. INTELLECTUAL PROPERTY INFRINGEMENT FOR SOFTWARE PROVIDED FOR A LICENSE FEE:

a. In the event Software was provided to You for a License Fee, HP will defend or settle any claim against You alleging that HP Branded
Software products provided under this Agreement infringes intellectual property rights in the country where they were sold, if You:

1) promptly notify HP of the claim in writing;

2) cooperate with HP in the defense of the claim; and

3) grant HP sole control of the defense or settlement of the claim. HP will pay infringement claim defense costs, HP–negotiated
settlement amounts, and court-awarded damages.

b. If such a claim appears likely, then HP may modify the HP Branded Software products, procure any necessary license, or replace the
affected item with one that is at least functionally equivalent. If HP determines that none of these alternatives is reasonably available,
then HP will issue You a refund equal to the purchase price paid for the affected item if within one year of delivery, or Your net book
value thereafter.

c. HP has no obligation for any claim of infringement arising from:

1) HP’s compliance with Your or third party designs, specifications, instructions, or technical information;

2) modifications made by You or a third party;

3) Your non-compliance with the Specifications or the documentation described in section 2. a above; or

4) Your use with products, software, or services that are not HP Branded.

d. This section 4 states HP's entire liability for claims of intellectual property infringement for Software provided for a license fee.



5. LIMITATION OF LIABILITY AND REMEDIES

Notwithstanding any damages that You might incur, and except for damages for bodily injury (including death) and for the amounts in section
4.a, the entire aggregate liability of HP and any of its suppliers relating to the Software or this Agreement, and Your exclusive remedy for
all of the foregoing, shall be limited to the greater of the amount actually paid by You separately for the Software or U.S. $5.00. TO THE
MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL HP OR ITS SUPPLIERS BE LIABLE FOR ANY SPECIAL, INCIDENTAL,
INDIRECT, OR CONSEQUENTIAL DAMAGES WHATSOEVER INCLUDING, BUT NOT LIMITED TO, DAMAGES FOR LOSS OF PROFITS OR
REVENUES, BUSINESS INTERRUPTION, DOWNTIME COSTS, FAILURE TO REALIZE EXPECTED SAVINGS, LOSS, DISCLOSURE, UNAVAILABILITY
OF OR DAMAGE TO DATA, SOFTWARE RESTORATION, OR LOSS OF PRIVACY ARISING OUT OF OR IN ANY WAY RELATED TO THE
USE OF OR INABILITY TO USE THE SOFTWARE, OR OTHERWISE IN CONNECTION WITH ANY PROVISION OF THIS AGREEMENT, EVEN
IF HP OR ANY SUPPLIER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES AND EVEN IF THE REMEDY FAILS OF ITS ESSENTIAL
PURPOSE. Some states/jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above limitation
or exclusion may not apply to you.

6. TERMINATION

This Agreement is effective unless terminated or rejected. Notwithstanding the foregoing, this Agreement will also terminate upon conditions
set forth elsewhere in this Agreement or if You fail to comply with any term or condition hereof. Immediately upon termination You will destroy
the Software and all copies of the Software or return them to HP. You may retain one copy of the Software subsequent to termination solely
for archival purposes only. At HP’s request, You will certify in writing to HP that You have complied with these requirements. Sections 3.(i),
3.(ii) g, 5, 6 and 7 of this Agreement will survive termination of this Agreement.

7. GENERAL

a. You may not assign, sublicense, delegate or otherwise transfer (“Assign”) all or any part of this Agreement without prior written consent
from HP, payment to HP of any applicable fees, and compliance with HP's Software license transfer policies and any applicable third
party license terms. Any such attempted Assignment will be null and void. Where an authorized Assignment occurs in accordance with
this section, Your rights under this Agreement will terminate, and You will immediately deliver the Software and all copies to the
Assignee. The Assignee must agree in writing to the terms of this Agreement, and the transferee thereafter will be considered “You”
for purposes of this Agreement. You may transfer firmware only upon transfer of the associated hardware.

b. If the Software is licensed for use in the performance of a U.S. Government prime contract or subcontract, You agree that, consistent
with FAR 12.211 and 12.212, commercial computer Software, computer Software documentation and technical data for commercial
items are licensed under HP’s standard commercial license.

c. To the extent You export, re-export, or import Software, technology, or technical data licensed or provided hereunder, You assume
sole responsibility for complying with applicable laws and regulations and for obtaining required export and import authorizations.
HP may suspend performance if You are in violation of any applicable laws or regulations.

d. You agree that HP may audit Your compliance with this Agreement. Any such audit would be at HP’s expense, require reasonable
notice, and would be performed during normal business hours. If an audit reveals underpayments then You will immediately pay HP
such underpayments together with the costs reasonably incurred by HP in connection with the audit and seeking compliance with this
section.

e. This Agreement is governed by the laws of the State of California, U.S.A., excluding rules as to choice and conflict of law. You and
HP agree that the United Nations Convention on Contracts for the International Sale of Goods will not apply to this Agreement.

f. Subject to the other terms and conditions of this Agreement, this Agreement is the entire agreement between HP and You regarding
Your Use of the Software, and supersedes and replaces any previous communications, representations, or agreements, or Your additional
or inconsistent terms, whether oral or written. In the event any provision of this Agreement is held invalid or unenforceable the remainder
of the Agreement will remain enforceable and unaffected thereby.

g. HP’s failure to exercise or delay in exercising any of its rights under this Agreement will not constitute or be deemed a waiver or
forfeiture of those rights.

HPjmeter v4.3 Ancillary Software Licenses

The following Ancillary Software is included in or with the Software:

1. ASM 4.0.0

2. Jfreechart 1.0.14

3. Oracle Help for Java 5.0.0.433

4. JSch - Java Secure Channel

(1) ASM (v4.0.0) - ASM v4.0.0 License



ASM: a very small and fast Java bytecode manipulation framework Copyright (c) 2000-2011 INRIA, France Telecom All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

3. Neither the name of the copyright holders nor the names of its contributors may be used to endorse or promote products derived from this
software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

(2) Jfreechart (v1.0.14) – LGPL Version 2.1

GNU LESSER GENERAL PUBLIC LICENSE Version 2.1, February 1999 Copyright (C) 1991, 1999 Free Software Foundation, Inc. 51 Franklin Street,
Fifth Floor, Boston, MA 02110-1301 USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed. [This is the first released version
of the Lesser GPL. It also counts as the successor of the GNU Library Public License, version 2, hence the version number 2.1.]

Preamble. The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU General Public
Licenses are intended to guarantee your freedom to share and change free software--to make sure the software is free for all its users.

This license, the Lesser General Public License, applies to some specially designated software packages--typically libraries--of the Free Software
Foundation and other authors who decide to use it. You can use it too, but we suggest you first think carefully about whether this license or the
ordinary General Public License is the better strategy to use in any particular case, based on the explanations below.

When we speak of free software, we are referring to freedom of use, not price. Our General Public Licenses are designed to make sure that you
have the freedom to distribute copies of free software (and charge for this service if you wish); that you receive source code or can get it if you want
it; that you can change the software and use pieces of it in new free programs; and that you are informed that you can do these things.

To protect your rights, we need to make restrictions that forbid distributors to deny you these rights or to ask you to surrender these rights. These
restrictions translate to certain responsibilities for you if you distribute copies of the library or if you modify it.

For example, if you distribute copies of the library, whether gratis or for a fee, you must give the recipients all the rights that we gave you. You must
make sure that they, too, receive or can get the source code. If you link other code with the library, you must provide complete object files to the
recipients, so that they can relink them with the library after making changes to the library and recompiling it. And you must show them these terms
so they know their rights. We protect your rights with a two-step method: (1) we copyright the library, and (2) we offer you this license, which gives
you legal permission to copy, distribute and/or modify the library.

To protect each distributor, we want to make it very clear that there is no warranty for the free library. Also, if the library is modified by someone
else and passed on, the recipients should know that what they have is not the original version, so that the original author's reputation will not be
affected by problems that might be introduced by others.

Finally, software patents pose a constant threat to the existence of any free program. We wish to make sure that a company cannot effectively
restrict the users of a free program by obtaining a restrictive license from a patent holder. Therefore, we insist that any patent license obtained for
a version of the library must be consistent with the full freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the ordinary GNU General Public License. This license, the GNU Lesser General Public
License, applies to certain designated libraries, and is quite different from the ordinary General Public License. We use this license for certain
libraries in order to permit linking those libraries into non-free programs.

When a program is linked with a library, whether statically or using a shared library, the combination of the two is legally speaking a combined
work, a derivative of the original library. The ordinary General Public License therefore permits such linking only if the entire combination fits its
criteria of freedom. The Lesser General Public License permits more lax criteria for linking other code with the library.

We call this license the “Lesser” General Public License because it does Less to protect the user's freedom than the ordinary General Public License.
It also provides other free software developers Less of an advantage over competing non-free programs. These disadvantages are the reason we
use the ordinary General Public License for many libraries. However, the Lesser license provides advantages in certain special circumstances.



For example, on rare occasions, there may be a special need to encourage the widest possible use of a certain library, so that it becomes a de-facto
standard. To achieve this, non-free programs must be allowed to use the library. A more frequent case is that a free library does the same job as
widely used non-free libraries. In this case, there is little to gain by limiting the free library to free software only, so we use the Lesser General Public
License.

In other cases, permission to use a particular library in non-free programs enables a greater number of people to use a large body of free software.
For example, permission to use the GNU C Library in non-free programs enables many more people to use the whole GNU operating system, as
well as its variant, the GNU/Linux operating system. Although the Lesser General Public License is Less protective of the users' freedom, it does
ensure that the user of a program that is linked with the Library has the freedom and the wherewithal to run that program using a modified version
of the Library.

The precise terms and conditions for copying, distribution and modification follow. Pay close attention to the difference between a “work based on
the library” and a “work that uses the library” The former contains code derived from the library, whereas the latter must be combined with the
library in order to run.

GNU LESSER GENERAL PUBLIC LICENSE TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

This License Agreement applies to any software library or other program which contains a notice placed by the copyright holder or other authorized
party saying it may be distributed under the terms of this Lesser General Public License (also called “this License” Each licensee is addressed as
"you". A “library” means a collection of software functions and/or data prepared so as to be conveniently linked with application programs (which
use some of those functions and data) to form executables. The “Library” below, refers to any such software library or work which has been distributed
under these terms. A “work based on the Library” means either the Library or any derivative work under copyright law: that is to say, a work
containing the Library or a portion of it, either verbatim or with modifications and/or translated straightforwardly into another language. (Hereinafter,
translation is included without limitation in the term “modification” “Source code” for a work means the preferred form of the work for making
modifications to it. For a library, complete source code means all the source code for all modules it contains, plus any associated interface definition
files, plus the scripts used to control compilation and installation of the library. Activities other than copying, distribution and modification are not
covered by this License; they are outside its scope. The act of running a program using the Library is not restricted, and output from such a program
is covered only if its contents constitute a work based on the Library (independent of the use of the Library in a tool for writing it). Whether that is
true depends on what the Library does and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library's complete source code as you receive it, in any medium, provided that you
conspicuously and appropriately publish on each copy an appropriate copyright notice and disclaimer of warranty; keep intact all the notices
that refer to this License and to the absence of any warranty; and distribute a copy of this License along with the Library. You may charge a
fee for the physical act of transferring a copy, and you may at your option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Library or any portion of it, thus forming a work based on the Library, and copy and distribute
such modifications or work under the terms of Section 1 above, provided that you also meet all of these conditions:

a. The modified work must itself be a software library.

b. You must cause the files modified to carry prominent notices stating that you changed the files and the date of any change.

c. You must cause the whole of the work to be licensed at no charge to all third parties under the terms of this License.

d. If a facility in the modified Library refers to a function or a table of data to be supplied by an application program that uses the facility,
other than as an argument passed when the facility is invoked, then you must make a good faith effort to ensure that, in the event an
application does not supply such function or table, the facility still operates, and performs whatever part of its purpose remains meaningful.
(For example, a function in a library to compute square roots has a purpose that is entirely well-defined independent of the application.
Therefore, Subsection 2d requires that any application-supplied function or table used by this function must be optional: if the application
does not supply it, the square root function must still compute square roots.) These requirements apply to the modified work as a whole.
If identifiable sections of that work are not derived from the Library, and can be reasonably considered independent and separate
works in themselves, then this License, and its terms, do not apply to those sections when you distribute them as separate works. But
when you distribute the same sections as part of a whole which is a work based on the Library, the distribution of the whole must be
on the terms of this License, whose permissions for other licensees extend to the entire whole, and thus to each and every part regardless
of who wrote it. Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the
intent is to exercise the right to control the distribution of derivative or collective works based on the Library. In addition, mere aggregation
of another work not based on the Library with the Library (or with a work based on the Library) on a volume of a storage or distribution
medium does not bring the other work under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public License instead of this License to a given copy of the Library. To do this,
you must alter all the notices that refer to this License, so that they refer to the ordinary GNU General Public License, version 2, instead of to
this License. (If a newer version than version 2 of the ordinary GNU General Public License has appeared, then you can specify that version
instead if you wish.) Do not make any other change in these notices. Once this change is made in a given copy, it is irreversible for that



copy, so the ordinary GNU General Public License applies to all subsequent copies and derivative works made from that copy. This option
is useful when you wish to copy part of the code of the Library into a program that is not a library.

4. You may copy and distribute the Library (or a portion or derivative of it, under Section 2) in object code or executable form under the terms
of Sections 1 and 2 above provided that you accompany it with the complete corresponding machine-readable source code, which must be
distributed under the terms of Sections 1 and 2 above on a medium customarily used for software interchange. If distribution of object code
is made by offering access to copy from a designated place, then offering equivalent access to copy the source code from the same place
satisfies the requirement to distribute the source code, even though third parties are not compelled to copy the source along with the object
code.

5. A program that contains no derivative of any portion of the Library, but is designed to work with the Library by being compiled or linked with
it, is called a “work that uses the Library” Such a work, in isolation, is not a derivative work of the Library, and therefore falls outside the
scope of this License. However, linking a “work that uses the Library” with the Library creates an executable that is a derivative of the Library
(because it contains portions of the Library), rather than a “work that uses the library” The executable is therefore covered by this License.
Section 6 states terms for distribution of such executables. When a “work that uses the Library” uses material from a header file that is part
of the Library, the object code for the work may be a derivative work of the Library even though the source code is not. Whether this is true
is especially significant if the work can be linked without the Library, or if the work is itself a library. The threshold for this to be true is not
precisely defined by law. If such an object file uses only numerical parameters, data structure layouts and accessors, and small macros and
small inline functions (ten lines or less in length), then the use of the object file is unrestricted, regardless of whether it is legally a derivative
work. (Executables containing this object code plus portions of the Library will still fall under Section 6.) Otherwise, if the work is a derivative
of the Library, you may distribute the object code for the work under the terms of Section 6. Any executables containing that work also fall
under Section 6, whether or not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or link a “work that uses the Library” with the Library to produce a work
containing portions of the Library, and distribute that work under terms of your choice, provided that the terms permit modification of the work
for the customer's own use and reverse engineering for debugging such modifications. You must give prominent notice with each copy of the
work that the Library is used in it and that the Library and its use are covered by this License. You must supply a copy of this License. If the
work during execution displays copyright notices, you must include the copyright notice for the Library among them, as well as a reference
directing the user to the copy of this License. Also, you must do one of these things:

a. Accompany the work with the complete corresponding machine-readable source code for the Library including whatever changes were
used in the work (which must be distributed under Sections 1 and 2 above); and, if the work is an executable linked with the Library,
with the complete machine-readable "work that uses the Library", as object code and/or source code, so that the user can modify the
Library and then relink to produce a modified executable containing the modified Library. (It is understood that the user who changes
the contents of definitions files in the Library will not necessarily be able to recompile the application to use the modified definitions.)

b. Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that (1) uses at run time a copy of
the library already present on the user's computer system, rather than copying library functions into the executable, and (2) will operate
properly with a modified version of the library, if the user installs one, as long as the modified version is interface-compatible with the
version with which the work was done.

c. Accompany the work with a written offer, valid for at least three years, to give the same user the materials specified in Subsection 6a,
above, for a charge no more than the cost of performing this distribution.

d. If distribution of the work is made by offering access to copy from a designated place, offer equivalent access to copy the above
specified materials from the same place.

e. Verify that the user has already received a copy of these materials or that you have already sent this user a copy. For an executable,
the required form of the “work that uses the Library” must include any data and utility programs needed for reproducing the executable
from it. However, as a special exception, the materials to be distributed need not include anything that is normally distributed (in either
source or binary form) with the major components (compiler, kernel, and so on) of the operating system on which the executable runs,
unless that component itself accompanies the executable. It may happen that this requirement contradicts the license restrictions of other
proprietary libraries that do not normally accompany the operating system. Such a contradiction means you cannot use both them and
the Library together in an executable that you distribute.

7. You may place library facilities that are a work based on the Library side-by-side in a single library together with other library facilities not
covered by this License, and distribute such a combined library, provided that the separate distribution of the work based on the Library and
of the other library facilities is otherwise permitted, and provided that you do these two things:

a. Accompany the combined library with a copy of the same work based on the Library, uncombined with any other library facilities. This
must be distributed under the terms of the Sections above.

b. Give prominent notice with the combined library of the fact that part of it is a work based on the Library, and explaining where to find
the accompanying uncombined form of the same work.



8. You may not copy, modify, sublicense, link with, or distribute the Library except as expressly provided under this License. Any attempt otherwise
to copy, modify, sublicense, link with, or distribute the Library is void, and will automatically terminate your rights under this License. However,
parties who have received copies, or rights, from you under this License will not have their licenses terminated so long as such parties remain
in full compliance.

9. You are not required to accept this License, since you have not signed it. However, nothing else grants you permission to modify or distribute
the Library or its derivative works. These actions are prohibited by law if you do not accept this License. Therefore, by modifying or distributing
the Library (or any work based on the Library), you indicate your acceptance of this License to do so, and all its terms and conditions for
copying, distributing or modifying the Library or works based on it.

10. Each time you redistribute the Library (or any work based on the Library), the recipient automatically receives a license from the original
licensor to copy, distribute, link with or modify the Library subject to these terms and conditions. You may not impose any further restrictions
on the recipients' exercise of the rights granted herein. You are not responsible for enforcing compliance by third parties with this License.

11. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to patent issues), conditions
are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you
from the conditions of this License. If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other
pertinent obligations, then as a consequence you may not distribute the Library at all. For example, if a patent license would not permit
royalty-free redistribution of the Library by all those who receive copies directly or indirectly through you, then the only way you could satisfy
both it and this License would be to refrain entirely from distribution of the Library. If any portion of this section is held invalid or unenforceable
under any particular circumstance, the balance of the section is intended to apply, and the section as a whole is intended to apply in other
circumstances. It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest validity of
any such claims; this section has the sole purpose of protecting the integrity of the free software distribution system which is implemented by
public license practices. Many people have made generous contributions to the wide range of software distributed through that system in
reliance on consistent application of that system; it is up to the author/donor to decide if he or she is willing to distribute software through
any other system and a licensee cannot impose that choice. This section is intended to make thoroughly clear what is believed to be a
consequence of the rest of this License.

12. If the distribution and/or use of the Library is restricted in certain countries either by patents or by copyrighted interfaces, the original copyright
holder who places the Library under this License may add an explicit geographical distribution limitation excluding those countries, so that
distribution is permitted only in or among countries not thus excluded. In such case, this License incorporates the limitation as if written in the
body of this License.

13. The Free Software Foundation may publish revised and/or new versions of the Lesser General Public License from time to time. Such new
versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns. Each version is given a
distinguishing version number. If the Library specifies a version number of this License which applies to it and “any later version” you have
the option of following the terms and conditions either of that version or of any later version published by the Free Software Foundation. If
the Library does not specify a license version number, you may choose any version ever published by the Free Software Foundation.

14. If you wish to incorporate parts of the Library into other free programs whose distribution conditions are incompatible with these, write to the
author to ask for permission. For software which is copyrighted by the Free Software Foundation, write to the Free Software Foundation; we
sometimes make exceptions for this. Our decision will be guided by the two goals of preserving the free status of all derivatives of our free
software and of promoting the sharing and reuse of software generally.

NO WARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY
APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE
LIBRARY “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY
SERVICING, REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER
PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING
ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE LIBRARY
(INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR
THIRD PARTIES OR A FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER OR OTHER PARTY
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. END OF TERMS AND CONDITIONS

(3) Oracle Help for Java (OHJ) version 5.0.0.433



1. License. Oracle grants to Licensee a personal, non-exclusive, non-transferable license to use the Program only: (i) to provide an online help
system for Licensee’s use with Licensee’s applications, and in accord with the terms set forth in this Agreement, and (ii) to distribute the Program
as part of Licensee’s own products, provided that the Program is only used as an online help system with Licensee’s applications.

Licensee shall not:

a. transfer, sell, assign or otherwise convey the license for the Program to another party without Oracle’s prior written consent;

b. cause or permit reverse engineering, disassembly, or decompilation of the Program;

c. disclose results of any benchmark tests of any Program to any third party without Oracle’s prior written approval; or

d. use or distribute any individual component of the Program for any other purpose except as set forth in the preceding paragraph.

The Program is the proprietary product of Oracle or its licensors and is protected by copyright and other intellectual property laws. Licensee
acquires only the right to use and distribute the Program and does not acquire any rights, express or implied, in the Program other than those
specified in this Agreement. Oracle, or its licensors, shall at all times retain all rights, title, interest, including intellectual property rights, in
the Program.

Failure to comply with the above restrictions may result in termination of this license and will not limit Oracle from pursuing other remedies
available to it, including injunctive relief.

2. No Warranty. Oracle does not warrant that: (a) the Program will meet Licensee’s requirements, (b) the Program will operate in combinations
Licensee may select for use, or (c) operations of the Program will be uninterrupted or error-free. The Program is provided "as is" without
warranty of any kind, and Oracle expressly disclaims all express or implied warranties, including but not limited to implied warranties of
merchantability or fitness for a particular purpose.

3. Limitation of Liability. ORACLE SHALL NOT BE LIABLE FOR ANY DAMAGESWHATSOEVER, INCLUDING DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
OR CONSEQUENTIAL DAMAGES, OR DAMAGES FOR LOSS OF PROFITS, REVENUE, DATA OR DATA USE, INCURRED BY LICENSEE OR ANY
THIRD PARTY, WHETHER IN ACTION IN CONTRACT OR TORT, EVEN IF ORACLE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

4. Governing Law and Jurisdiction. This Agreement, and all matters arising out of or relating to this Agreement, shall be governed by the laws
of the State of California. Any legal action or proceeding relating to this Agreement shall be instituted in a state or federal court in San
Francisco or San Mateo County, California. Oracle and Licensee agree to submit to the exclusive jurisdiction of, and agree that venue is
proper in, these courts in any such legal action or proceeding.

5. Severability. If any provision of this Agreement is held to be invalid or unenforceable, the remaining provisions of this Agreement will remain
in full force.

6. Export Administration. Licensee agrees to comply fully with all relevant export laws and regulations of the United States ("Export Laws") to
assure that the Program is (1) exported, directly or indirectly, in violation of Export Laws; or (2) are intended to be used for any purposes
prohibited by the Export Laws, including, without limitation, nuclear, chemical, or biological weapons proliferation.

7. Entire Agreement. This Agreement constitutes the entire Agreement between Licensee and Oracle with reference to this transaction and shall
supersede any other prior or contemporaneous agreements or representations, written or oral, concerning the subject matter of this Agreement.
Any additions or modifications must be made in a subsequent, written agreement signed by both parties.

(4) JSch - Java Secure Channel

Copyright (c) 2002-2011 Atsuhiko Yamanaka, JCraft,Inc. All rights reserved. Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

3. The names of the authors may not be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED ''AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL JCRAFT, INC. OR
ANY CONTRIBUTORS TO THIS SOFTWARE BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

Document Notice

The information in this document is subject to change without notice.



Hewlett-Packard makes no warranty of any kind with regard to this manual, including, but not limited to, the implied warranties of merchantability
and fitness for a particular purpose. Hewlett-Packard shall not be held liable for errors contained herein or direct, indirect, special, incidental, or
consequential damages in connection with the furnishing, performance, or use of this material.

Warranty

A copy of the specific warranty terms applicable to your Hewlett-Packard product and replacement parts can be obtained from your local Sales
and Service Office.

U.S. Government License

Proprietary computer software. Valid license from HP required for possession, use or copying. Consistent with FAR 12.211 and 12.212, Commercial
Computer Software, Computer Software Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government under
vendor's standard commercial license.

You can find printable PDF versions of this user's guide and the release notes in the installation directory (doc subdirectory).

Copyright Notices

© Copyright 2005–2013 Hewlett-Packard Development Company, L.P. All rights reserved. Reproduction, adaptation, or translation of this document
without prior written permission is prohibited, except as allowed under copyright laws.

Trademark Notices

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

Intel and Itanium are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the United States and other countries.

Microsoft and Windows are U.S. registered trademarks of Microsoft Corporation.

UNIX is a registered trademark of The Open Group.

Java™ and all Java based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates in the United States and
other countries.

HP-UX Release 11i and later (in both 32- and 64-bit configurations) are Open Group UNIX 95 branded products.
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About This Document
This document provides updated information about product features, known problems, and
workarounds for the 4.3 release of HPjmeter.

Intended Audience
This document is intended for application administrators and software developers responsible for
monitoring Java application performance and operation on HP-UX. Users are expected to have
some knowledge of concepts and/or commands for the HP-UX operating system, usage of the Java
Virtual Machine on HP-UX, and Java application performance. When running the HPjmeter console
on a Microsoft® Windows® platform, the user is expected to be familiar with installing executables
and navigating the Windows file system.

Typographic Conventions
This document uses the following typographical conventions.
audit(5) A man page. The man page name is audit, and it is located in Section 5.
Command A command name or qualified command phrase.
ComputerOut Text displayed by the computer.
ENVIRONVAR The name of an environment variable, for example, PATH.
ERRORNAME The name of an error, usually returned in the errno variable.
Key The name of a keyboard key. Return and Enter both refer to the same key.
UserInput Commands and other text that you type.
Variable The name of a placeholder in a command, function, or other syntax display

that you replace with an actual value.
... The preceding element can be repeated an arbitrary number of times. A vertical

ellipsis indicates the continuation of a code example.
| Separates items in a list of choices.

Additional HPjmeter Documents
• HPjmeter 4.3.00.00 Release Notes and Installation Guide:

http://www.hp.com/go/hpux-hpjmeter-docs.
• HPjmeter overview and access to software:

https://h20392.www2.hp.com/portal/swdepot/displayProductInfo.do?productNumber=HPJMETER.

Related Information
• JSR 174: Monitoring and Management Specification for the Java™ Virtual Machine at Java

Community Process web site: http://www.jcp.org/en/jsr/detail?id=174
• Java™ Troubleshooting Guide for HP-UX Systems: http://www.hp.com/go/hpux-java-docs

• Patch Information for Java on HP-UX:
http://ftp.hp.com/pub/softlib/hpuxjava-patchinfo/index.html

• HP-UX Secure Shell Getting Started Guide: http://www.hp.com/go/hpux-security-docs

• HP-UX System Administrator's Guide: Security Management, “Securing Remote Sessions Using
HP-UX Secure Shell” : http://www.hp.com/go/hpux-core-docs-11iv3

• Memory Management in the Java HotSpot™ Virtual Machine (Sun Developer Network):
http://java.sun.com/j2se/reference/whitepapers/memorymanagement_whitepaper.pdf



HP Encourages Your Comments
We encourage your comments concerning this document. We are committed to providing
documentation that meets your needs.
Please send your comments via the Customer Feedback web page: http://www.hp.com/bizsupport/
feedback/ww/webfeedback.html. Include the document title, HP part number, and any comment,
error found, or suggestion for improvement you have concerning this document. Also, please let
us know what we did right so we can incorporate it into other documents.



1 Introducing HPjmeter 4.3.00.00
HPjmeter is a performance analysis tool for deployed Java applications. It will help you identify
performance problems in your production environment as well as during development.

NOTE: You cannot use HPjmeter to monitor Java applets in a production environment.

HPjmeter helps you diagnose many types of Java application problems that occur only after a
product is deployed. The types of problems you can identify include:
• Memory-retention problems
• Performance bottlenecks in Java code
• Improper JVM heap settings
• Certain application logic errors, such as deadlocks
• Ineffective or problematic garbage collection
These problems may not be apparent or reproducible before you deploy your application because
they depend on unique conditions present only in deployment.
With HPjmeter you can also gain a comprehensive overview of certain states of a running JVM
and running applications, including details on memory usage, garbage collection, runtime, and
class loading, for example. Using HPjmeter's ability to interact with the Java Management Extensions
(JMX) component in the JVM, you can also manipulate operations during a monitoring session to
control the state of some logging mechanisms, to gather snapshots of stack traces and memory
details, and to force a garbage collection.

Features
With its application and JVM metrics, HPjmeter helps close the loop between developers and
operations staff.
HPjmeter has two modes of operation: you can use it to monitor live applications, and you can
analyze data collected from applications that have been run using profiling or garbage collection
options.
Specifically, HPjmeter provides these monitoring capabilities:

• Dynamic display of heap size and live objects in the heap

• Dynamic display of garbage collection events and percentage time spent in garbage collection

• Memory leak detection alerts with leak rate

• Java Method HotSpots, which represent CPU usage per method

• Thread views displaying thread states over time

• Object allocation percentage by method and by object type

• Method compilation count in the JVM dynamic compiler

• Number of classes loaded by the JVM over time

• Thrown exception statistics

• Thread deadlock detection

• Visibility into standard MBean attributes, operations, and notifications (JSR 174) within the
Java Virtual Machine, with the ability to trigger operations from HPjmeter and enable or
disable notifications.
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• Visibility into user-defined MBeans, with the ability to modify attributes and trigger operations
in real time, then monitor the resulting application behavior.

• Multi-application, multi-node monitoring from a single console
HPjmeter provides these profiling capabilities:
• Graphic display of profiling data

• Heuristics on inlining, thrown exceptions, and memory leaks

• Interactive call graph with call count, or with CPU or clock time, if available

• Per thread, per thread group, or per process display

• Allocated and residual objects with object reference graph

• Comparison capability for performance improvement tracking
HPjmeter provides these metrics for garbage collection (GC) analysis:
• Details and graphical display of object creation rate, changes in cumulative memory allocation

and in heap usage as related to GC events and types, and duration of GC events in the
recorded time period.

• Detailed summaries of GC activity and system resource allocation, along with other system
and JVM runtime and version data.

HPjmeter also provides these notification functions:
• Set notification thresholds for abnormal thread termination, excessive compilation, expected

out-of-memory error, and memory leak rates.
• Set notification thresholds for levels of heap usage, process CPU, and system CPU.

• Enable or disable notifications.

• Change notification thresholds in real time to efficiently monitor targeted events

Concepts
HPjmeter contains these major components:

• The console – the primary control window where monitoring sessions are initiated and controlled
and where data files are opened and listed for access. The console presents data in viewing
windows that contain controls and functions specific to the data type and the activity of the
user.

• The monitoring agent – represents HPjmeter on each managed node. The agent has two
subcomponents:

◦ The JVM agent: Each running JVM has an associated JVM agent that collects data and
sends it to a node agent, which sends it to the console.

◦ The HPjmeter node agent: Each managed node has a node agent that communicates
between the console and JVM agents.

JVM Agent
The JVM agent uses standard Java profiling interfaces (JVMTI and JVMPI) and a standard monitoring
and management interface (JSR174) to collect data from a running application and to provide
metrics to help detect and fix problems in that deployed application.
The JVM agent shares a process with a running JVM and forwards data through the node agent
to a console. Multiple consoles can connect to each of the multiple node agents on a managed
node. However, only one console and node agent can maintain an active session with a specific
JVM agent at any given time.
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Node Agent
Node agents manage communication between JVM agents and consoles. The preferred way of
using node agents is to start the node agent as a daemon as root on each managed node.
Related Topics

• Managing Node Agents On HP-UX (page 47)

Concepts 23



2 Completing Installation of HPjmeter

NOTE: This chapter assumes that you have installed the HPjmeter components on the appropriate
server(s) and are ready to configure the agents. For information on initial installation, see HPjmeter
Release Notes and Installation Guide.

Platform Support and System Requirements
Although the agents and console can execute on the same system, this document assumes they are
installed on separate systems—the recommended configuration.

Agent Requirements
These are the requirements for systems running JVM agents and node agents.

Table 1 Agent Requirements

HP-UX on HP 9000 PA-RISC serversOperating system and
architecture 11.11 (11i v1),

11.23 (11i v2),
11.31 (11i v3)
HP-UX on Itanium®-based HP Integrity servers
11.23 (11i v2),
11.31 (11i v3)

Java • HP 1.4.2.02 or later 1.4.x, 5.x and 6.x versions on PA 2.0 for HP-UX (HP 9000
PA-RISC) 11.11 (11i v1) and 11.23 (11i v2), 11.31 (11i v3)

• HP 1.4.2.02 or later 1.4.x , 5.x , 6.x, and 7.x versions on HP-UX (HP Integrity)
11.23 (11i v2), 11.31 (11i v3)

HPjconfig can help you determine which Java patches are recommended or required
for best operation of the HPjmeter agent on HP-UX. See

Patches and updates

http://h20392.www2.hp.com/portal/swdepot/displayProductInfo.do?productNumber=HPJCONFIG
.

The agent is designed to be lightweight and low overhead, and does not require any
additional processing power or memory beyond that required by the application
being monitored.

Processor and memory

10 MBDisk space

Zero Preparation Data Collection:
If you are running the HP JDK/JRE 5.0.04 or later, you can send a signal to the running JVM to
start and stop an eprof profiling data collection period with zero preparation and no interruption
of your application. See Profiling with Zero Preparation (page 74).
If you are running the HP JDK/JRE 5.0.14 (or later) or the 6.0.02 version (or later), you can send
a signal to the running JVM to start and stop a verbose GC data collection period with zero
preparation and no interruption of your application. See Collecting GC Data with Zero Preparation
(page 99).

Console Requirements
These are the requirements for systems running the console.
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Table 2 Console Requirements

The console is a pure Java application, so it should execute on any platform that
supports Java.

Operating system and
architecture

Java 6.x or 7.x versions.Java

HPjconfig can help you determine which Java patches are recommended or required
for best operation of the HPjmeter console on HP-UX. See

Patches and updates

http://h20392.www2.hp.com/portal/swdepot/displayProductInfo.do?productNumber=HPJCONFIG
.

Processor and memory • Minimum 500 MHz processor is recommended.
• Minimum 512 MB of memory on Microsoft Windows and 1 GB of memory on

UNIX systems is required.

10 MBDisk space

Completing the installation
After installation, the HPjmeter console is available as a standalone tool or through Java Web Start
from a server of your choice, such as the HP Systems Insight Manager central management server.
To complete installation, you need to configure the HPjmeter JVM agent by modifying the command
line for each application for which you want to monitor or collect data. Then you need to start the
HPjmeter node agent. The following sections will help you complete the installation.

• Platform Support and System Requirements (page 24)
• File Locations (page 25)
• Configuring your Application to Use HPjmeter Command Line Options (page 25)
• Working with Firewalls (page 32)
• For additional information on agents: Managing Node Agents (page 47)

File Locations
The default installation paths by operating system are as follow:
• On HP-UX and Linux: /opt/hpjmeter

• On Microsoft® Windows: C:\Program Files\HPjmeter

Attaching to the JVM Agent of a Running Application
For applications running with Java 6.0.03 or later, HPjmeter 4.3.00.00 can automatically identify
the JVMs running on the server and display them symbolically in the console for attachment and
monitoring. This includes JVMs for which no HPjmeter switches were used in the java command
that started the applications. With few exceptions (discussed elsewhere in this guide), HPjmeter
monitoring functionality is the same whether the JVM agent is loaded from the console (through
dynamic attachment) or from the command line when starting the application.

Configuring your Application to Use HPjmeter Command Line Options
For most supported versions of Java, it is still necessary to start the application using HPjmeter
options on the java command and to modify two environment variables. Or, you may want to
use command line options to control the bytecode instrumentation.

Preparing to run Java
For most installations, linkage to the appropriate libraries is completed automatically as part of
the installation process. Go to step 2 if you have a standard installation of the Java Runtime
Environment.
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To Take Advantage of Dynamic Attach:
Check that JM_JAVA_HOME in $JMETER_HOME/config/hpjmeter.conf is set to a Java 6
(6.0.03 or later) or a Java 7 directory to be able to later dynamically attach to a running JVM
from the HPjmeter console without first setting HPjmeter options on the command line.
When HPjmeter is installed on a system that has Java 6 or 7 installed in the usual location, the
installation procedure will automatically store the JDK location in hpjmeter.conf configuration
file. If the Java 6.x or 7.x JDK is installed in a non-standard location, or Java 6.x or 7.x is installed
after HPjmeter is installed, then it is necessary to update the hpjmeter.conf file manually. The
typical contents of the Java 6 or 7 files are JM_JAVA_HOME=/opt/java6 or
JM_JAVA_HOME=/opt/java7 respectively.

1. The HPjmeter installation process will configure JDKs that are installed in the standard location.
Some systems have JDKs installed in nonstandard locations, and some applications run with
an embedded Java Runtime Environment. In these situations, it is necessary to explicitly indicate
the location of HPjmeter libraries.
Assuming that JMETER_HOME represents your installation directory, modify the shared library
path in your environment as follows:

• On HP-UX running on HP Precision Architecture systems, add
$JMETER_HOME/lib/$ARCH to SHLIB_PATH where $ARCH is PA_RISC2.0 or
PA_RISC2.0W.

• On HP-UX running on Itanium-based systems with Java 5.x or later, add
$JMETER_HOME/lib/$ARCH to LD_LIBRARY_PATH where $ARCH is IA64N or
IA64W.

• On HP-UX running on Itanium-based systems, for JDK 1.4.x versions, use the SHLIB_PATH
environment variable to specify the shared library path.

2. On HP-UX and running Java 1.4.x, specify the Xbootclasspath in your java command:
$ java -Xbootclasspath/a:$JMETER_HOME/lib/agent.jar
$ ...

On Java 5.0 and later, -Xbootclasspath is optional.

3. Specify the HPjmeter switch in your java command:
On Java 5.0 and later:
$ java -agentlib:jmeter[=options] ...

On Java 1.4.x :
$ java -Xrunjmeter[:options] -Xbootclasspath/a:$JMETER_HOME/lib/agent.jar ...

NOTE: If you use the 64-bit version of the JVM (using the -d64 option), then you will need
to use the 64-bit version of the JVM agent. For example, type
$ java -d64 HelloWorld

when SHLIB_PATH is $JMETER_HOME/lib/$ARCH and
where $ARCH equals PA_RISC2.0W or IA64W.

See JVM Agent Options (page 27) for the list of available options and their descriptions.

Example Usage

• Using -agentlib on Java 5.x to run the JVM agent:
$ /opt/java1.5/bin/java -Xms256m -Xmx512m -agentlib:jmeter myapp

• Setting -Xbootclasspath and using -Xrunjmeter on Java 1.4 to run the JVM agent:
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$ /opt/java1.4/bin/java -Xms256m -Xmx512m
   -Xbootclasspath/a:/opt/hpjmeter/lib/agent.jar -Xrunjmeter myapp  

NOTE:
With the addition of JVMTI in JDK 5.0, you should use the -agentlib switch to take
advantage of improvements in JDK 5.0 and reduce the impact of data sampling on application
performance. While -Xrunjmeter can still be used to specify the JVM agent with Java 5
versions, the impact on application performance is significantly greater than when using
-agentlib.
Starting with Java 5.0, -agentlib is the standard way to specify the JVM agent. Therefore,
this document will refer primarily to -agentlib.

• Using an alternate HPjmeter library to work with applications that are run with the –V2 option
on PA systems:
$ /opt/java1.5/bin/java -V2 –agentlib:jmeter_v2 myapp

JVM Agent Options
This section provides the list of options for changing the JVM agent behavior and determining the
Java version running on the system.

Showing Version Information
To show the version information, use
-agentlib:jmeter=version

OR
-Xrunjmeter:version

Selecting Other JVM Agent Options
Add other options using this syntax
-agentlib:jmeter[[=version]|[=option[[,option]]...]]
OR
-Xrunjmeter[:[version]|[option[[,option]]...]]
where option may be any of these:
appserver_port=port

Associates a port number with a JVM process when it is displayed in the console. This port
number is unrelated to the port number used by the node agent, and so it is also unrelated to
the optional port number that can be specified in the console when attaching to a managed
node.
• It does not affect any communication, and is only part of the user interface. The

appserver_port= usually corresponds to the port to which the application server listens.
• Example usage: -agentlib:jmeter=appserver_port=7001

group_private

Specifies that the JVM will be visible only to node agents run with the same group-id; that is,
run by the user belonging to the same group, as the one who runs the JVM. This limitation does
not apply to node agents run as root (the installation default). This is the default behavior on
HP-UX systems.
• You can specify only one of the options owner_private, group_private or public.

• Example usage:  -agentlib:jmeter=group_private
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include=filter1[:filter2]...,  exclude=filter1[:filter2]...
Creates a colon-separated list of classes to specify which classes or packages are instrumented.
Method-level filtering is not supported.
• If a class is not instrumented, the JVM agent metrics that use bytecode instrumentation

(BCI) do not provide any output related to the class methods. To see the list of filters in

effect while the data was collected, including default agent filters, click the icon when
you see it in the console.

• Class filtering minimizes the overhead and focuses attention on user-produced code.

• By default, the JVM agent instruments bytecode of all loaded classes to implement some
of the metrics, except those classes that belong to one of these:

◦ Application servers, for performance reasons.

◦ HPjmeter management tools, in order to focus on user-created code.

◦ A set of implementation-dependent classes that HPjmeter cannot instrument. These
cannot be overridden.

• Some metrics display results for all classes regardless of filters, because class filters apply
only to those metrics that use bytecode instrumentation.

NOTE: JVM agent filters are distinct from console monitoring filters. For more information,
see Setting Monitoring Session Preferences (page 117).
JVM agent filters are configured when you start the JVM, and cannot be dynamically
changed.
Console filters are configured when you open a session with a JVM agent, and can be
changed from session to session. With HPjmeter 4.0 and later, these filters can also be
changed during a session.
If the JVM agent has filtered out a class, the console will be unable to see metrics from
that class even if you try to remove the console filter for the class.

• HPjmeter always excludes these packages:

com.hp.jmeter.jvmagent.
com.hp.jmeter.share.jmx.
com.hp.jmeter.asm.

com.ibm.misc.
com.ibm.jvm.
com.informix.jdbc.IfxDriver

$Proxy

• The default filters also exclude the following packages. However, you can use the include
option to override the default behavior:

com.sun. java. javax. sun.
sunw.io. sunw.util.

COM.rsa.com.jrockit. COM.jrockit.
jrockit.

org.omg.org.ietf.org.apache.

com.hp.ov.org.xml.org.w3c.

weblogic. com.bea. com.beasys.p0. p1.i2.

org.hsql.org.enhydra.com.ibm. com.tivoli.
org.jboss org.jbossmq.

com.netscape.server.http.com.iplanet.EDU.oswego.

oracle.com.orionserver.com.evermind.
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• The default filters always include the following packages. They cannot be overriden with
an exclude option:

org.apache.jsp.
org.apache.jasper.

weblogic.jdbc.informix4.
weblogic.jdbc.mssqlserver4.

sun.jdbc.odbc.

weblogic.jdbc.oci.
weblogic.jdbc.rowset.
com.bea.p13n. com.bea.netuix.

com.bea.medrec.oracle.evermind.sql.oracle.jdbc. oracle.sql.

com.sun.ebank.com.sun.j2ee.blueprints.com.ibm.samples.
com.ibm.websphere.samples

• You can change the default behavior by using the include option. For example:
-agentlib:jmeter=include=com.ibm.ws,exclude=com.ibm.ws.io

This effect is similar to the previous example, except that the classes belonging to the
com.ibm.ws.io package, and its sub-packages if any, will be excluded from the
instrumentation. Other classes belonging to the com.ibm.ws package or its sub-packages
other than io will be instrumented. Classes belonging to sub-packages other than ws of
the com.ibm package will be still excluded by the default rule.

• In general, you can specify multiple package or class names with the include or exclude
option. The behavior with respect to any loaded class will be as defined by the most
specific rule (filter) that applies to the fully qualified class name.

• An include filter rule will override an exclude filter rule when the same package name is
provided on both options, even if one of the options is an implicit default. For example:
-agentlib:jmeter=exclude=sun.jdbc.odbc:other-package-names

In this example, the sun.jdbc.odbc package is not excluded because the implicit default
include of this package overrides the explicit exclude.

logging=FINEST|FINER|FINE|CONFIG|INFO|WARNING|SEVERE|OFF

Sets a log level for the JVM agent, which allows you to collect varying amounts of information
about the node agent and JVM agent. Available log levels in order of impact on performance
are:
FINEST (Most impact on performance)
FINER
FINE
CONFIG
INFO
WARNING (Default setting)
SEVERE (Least impact on performance)
OFF (Turn off logging)

monitor_batch[:file=filename]

Enables all metrics and sends the collected data to a file. The default name for the file is
javapid.hpjmeter. Use the optional monitor_batch:file=your_file_name to
override the default.
• Once data has been collected and saved to a file on the managed node, you can view

the file from the console using the Open File button or using drag and drop. You may need
to copy the file to a file system visible from the console. For more information, see Saving
Monitoring Metrics Information (page 48).

• Example usage:

To use default file name:◦
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-agentlib:jmeter=monitor_batch

◦ To specify a file name:
-agentlib:jmeter=monitor_batch:file=mysaveddata.hpjmeter

noalloc

Reduces dormant overhead by skipping bytecode instrumentation that applies to object allocation
metrics: Allocated Object Statistics by Class and Allocating Method Statistics. The noalloc
option makes those metrics unavailable.
Example usage: -agentlib:jmeter=noalloc

nohotspots

Reduces dormant overhead by skipping the bytecode instrumentation that supports Java Method
HotSpots. Any console connecting to an application initially started with this agent flag does
not enable Java Method HotSpots, and this metric is not listed in the Session Preferences dialog.
Example usage: -agentlib:jmeter=nohotspots

noexception

Reduces dormant overhead by skipping bytecode instrumentation that applies to the Thrown
Exception metrics. Any console connecting to an application initially started with this attribute
does not enable Thrown Exception metrics, and these metrics are not listed in the Session
Preferences dialog.
Example usage: -agentlib:jmeter=noexception

nomemleak

Reduces dormant overhead by skipping bytecode instrumentation that applies to memory leak
location events for Java collection classes. When you specify this option, the Java Collection
Leak Locations alert is unavailable in the console for the lifetime of this application.
Example usage: -agentlib:jmeter=nomemleak

noarrayleak

Reduces dormant overhead by skipping bytecode instrumentation that applies to array leak
location events. When you specify this option, the Array Leak Locations alert is unavailable in
the console for the lifetime of this application.
Example usage: -agentlib:jmeter=noarrayleak

noclassload

Reduces overhead by turning off the collection of classloading data in the Loaded Classes
metric.
Example usage: -agentlib:jmeter=noclassload

nogc

Reduces overhead by turning off the collection of heap size and garbage collection data in
the Heap Monitor and Garbage Collections metric.
Example usage: -agentlib:jmeter=nogc

nothrownstack

Reduces overhead by turning off the collection of stack traces for exceptions in the Thrown
Exceptions metric and the Abnormal Thread Termination alert. The exceptions are still collected,
but they do not have a full stack trace.
Example usage: -agentlib:jmeter=nothrownstack

nocompilation

Reduces overhead by turning off the collection of compilation statistics in the Method Compilation
Count and Method Compilation Frequency metrics, and the Excessive Compilation alert.
Example usage: -agentlib:jmeter=nocompilation
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nothreads

Reduces overhead by turning off the collection of data that support the Thread Histogram and
Lock Contention metric.
Example usage: -agentlib:jmeter=nothreads

nolockcon

Reduces overhead by turning off the collection of data that supports the Lock Contention metric.
Example usage: -agentlib:jmeter=nolockcon

nosocket

Reduces overhead by skipping the bytecode instrumentation that supports Incoming Sockets
Connection Frequency, Outgoing Sockets Connection Frequency, Network Input Stream and
Network Output Stream.
Example usage: -agentlib:jmeter=nosocket

nojmx

Reduces overhead by turning off the collection of JMX data.
Example usage: -agentlib:jmeter=nojmx

noliveheap

Reduces overhead by turning off the support for the Current Live Heap Objects metric.
Example usage: -agentlib:jmeter=noliveheap

noeprof

Reduces overhead by turning off the support for collecting Extended Profiling data from the
HPjmeter console.
Example usage: -agentlib:jmeter=noeprof

owner_private

Specifies that the JVM is visible only to the node agents run with the same effective user ID;
that is, run by the same user as the one who runs the JVM. This limitation does not apply to
node agents run as root (the installation default).
• You can specify only one of the options owner_private, group_private, or public.

• Example usage: -agentlib:jmeter=owner_private
public

Specifies that the JVM is visible to all node agents run on the same host as the JVM.
• You can specify only one of the options owner_private, group_private, or public.

• Example usage: -agentlib:jmeter=public
verbose[:file=filename]

Prints information about the bytecode instrumentation rules in effect, such as include or
exclude settings, and about the individual instrumentation decisions made for all loaded
classes. By default, the information is printed on stdout. You can override this by specifying
a file name, for example verbose:file=bci.txt.
Example usage: -agentlib:jmeter=verbose

version

Displays the JVM agent version and quits immediately without running any Java applications
at all. You cannot use this option with any other options.
Example usage: -agentlib:jmeter=version

JVM Options Usage Examples
Here are some examples of JVM agent option usage:
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$ -agentlib:jmeter=noalloc,appserver_port=7001,public,include=weblogic:com.bea
$ -agentlib:jmeter=nohotspots,owner_private,verbose:file=bcifilters.txt
$ -agentlib:jmeter=version 
$ -agentlib:jmeter

Security Awareness

Securing Communication Between the HPjmeter Node Agent and the Console

IMPORTANT: The data stream between the HPjmeter console and agents is not protected from
tampering by a network attacker. You can help ensure that the data you view in HPjmeter visualizers
is an accurate reflection of your application's operation and that data confidentiality is protected
where needed.

Ensuring the Integrity of HPjmeter Console/Node Agent Data Transfer
For key applications in production, you may want increase your confidence that the data has not
been tampered with en route between the agents and console before you take action based on
HPjmeter metrics. Where you deem it necessary, confirm that the HPjmeter data looks reasonable
according to the usual behavior of your application. You can also pursue using secure socket layer
(SSL) tunneling to protect the integrity of data packets and to enhance the reliability of the data
reaching the HPjmeter console.

Want to Know More About Secure Socket Layer Tunneling?:
HP-UX IPSec and HP-UX Secure Shell are two HP products that provide secure socket layer tunneling.
To learn more:
• HP-UX IPSec technical documentation (www.hp.com/go/hpux-security-docs)

• HP-UX Secure Shell overview and download
(http://h20293.www2.hp.com/portal/swdepot/displayProductInfo.do?productNumber=T1471AA)

• HP-UX Secure Shell technical documentation (http://www.hp.com/go/hpux-security-docs)
See also Connecting to the HPjmeter Node Agent (page 222).

Protecting Data Confidentiality During HPjmeter Console/Node Agent Communication
Data sent to the console is not encrypted by HPjmeter. If you are concerned about confidentiality
of this data, you can protect confidentiality by using SSL tunneling to encrypt the header and data
portion of each packet during transfer.

Working with Firewalls

NOTE: The console first attempts to use a port between 9505 and 9515 when arranging a port
for its server socket. If it is unable to successfully use a port from this range, it will use an ephemeral
port number.

The node agent has an open socket. Any HPjmeter console on any machine on the network (that
is not blocked by a firewall) can communicate with this node agent. If you want to have a console
contact a node agent through a firewall, you must provide a tunneling port so that the console can
contact the node agent.

IMPORTANT: If you choose to open a port through a firewall to enable communication between
a node agent and a console, secure the tunneling port using HP-UX Secure Shell or HP-UX IPSec.

Configuring User Access
The node agent must be started by either the same user or group as the running JVM (recommended)
or root to establish contact.
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IMPORTANT: Setting access for owner or group should not be considered a security solution
because node agent to JVM communications are not secured by default—see below.

Securing Communication Between the JVM and the HPjmeter Node Agent

IMPORTANT: The data stream between the JVM and the node agent is not protected from
tampering by a user logged into the system running the JVM. For key applications in production,
you may want to increase your confidence that the data has not been tampered with en route
between the JVM and agent before you take action based on HPjmeter metrics.

Where you deem it necessary, either secure the communication mechanism between the JVM and
node agent (HP-UX 11i v2 or later only), or confirm that the HPjmeter data looks reasonable
according to the usual behavior of your application by independently validating its output.
To secure the communication mechanism between the JVM and node agent on HP-UX 11i v2 or
later operating systems, set the umask of the JVM process to 77 (no access except for the owner)
by executing the command
% umask 77

before running the JVM.
Related Topics

• Managing Node Agents On HP-UX (page 47)
• Node Agent Access Restrictions (page 48)
• Connecting to the HPjmeter Node Agent (page 222)
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3 Getting Started
Are You Monitoring an Application or Analyzing Collected Data?

HPjmeter helps you to monitor a live run of your application. You can also view saved data captured
using HPjmeter during a live session, by using profiling or garbage collection options when you
start your application, or if you are running HP JDK/JRE 5.0.04 (or higher), by starting and stopping
profiling data collection from the command line.
Choose the get started information appropriate for your activity:
• Using HPjmeter to Monitor Applications (page 34)
• Using HPjmeter to Analyze Profiling Data (page 39)
• Using HPjmeter to Analyze Garbage Collection Data (page 41)
• Profiling with Zero Preparation (page 74)

Need a jumpstart?:
To aid in starting your use of HPjmeter, the console can display a beginning console guide
containing hints for getting started. The guide provides hints according to data set selected in the
console main pane.
To enable or disable the console guide, click Edit→ Window Preferences and toggle to the desired
option.

Using HPjmeter to Monitor Applications
The following sections summarize how to use HPjmeter to monitor applications. Detailed descriptions
of the behavior of HPjmeter are linked to from each section.

Configure and Start Your Application
1. Set the command line of your Java application to use the JVM agent and any desired agent

options.
2. Start your application with the JVM agent.
For details, see:
• Configuring your Application to Use HPjmeter Command Line Options (page 25)
• JVM Agent Options (page 27)

Confirm that the Node Agent is Running
With a standard installation, the node agent should be running on the systems where it was installed.
For details about the node agent, see:
• Managing Node Agents On HP-UX (page 47)

Start the Console
Start the console from a local installation on your client workstation.
For starting instructions by platform, see Starting the Console.

Connect to the Node Agent from the Console
Procedure 1 Connection to Server (Default Mode)
To connect to a node agent:
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1. Choose Connect from the File menu or click Connect to server [ ]

2. In the Connect to Server dialog box, type the complete host name (server.domain.com)
on which a Java application and a corresponding node agent are running.

3. Optionally, in the Optional Port box, specify the same port number that was used when the
node agent was started.

4. Click Connect.
After a few moments, the running JVM for each application identified should appear in the
console main window pane marked with one of the following symbols:

• — A JVM that has already loaded an HPjmeter JVM agent

• — A JVM that has not yet loaded an HPjmeter JVM agent

5. Repeat the previous steps if you want to connect to several node agents on several servers at
once.

Procedure 2 Secured Connection to Server
To connect to a node agent via a SecureShell (SSH) tunnel:
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1. Choose Connect from the File Menu or click Connect to server [ ]

2. In the Connect to Server dialog box, type the complete host name (server.domain.com)
of the system that is the designated host for the SSH tunnel (the SSH delegate machine).

3. Optionally, in the Optional Port box, specify a port number through which information can
pass from the SSH delegate to the node agent.

4. Check the box labeled Use SSH Options.
The Connect to Server dialog expands to reveal required SSH attributes.

5. Type the IP address External IP) of the SSH delegate.
6. Type the port number (External Port) on the SSH delegate through which information can pass

from the SSH delegate machine to the console.
7. Type the port number (Internal Port) listened to on the console side that can accept information

from the SSH delegate machine.
8. Click Connect.

After a few moments, the running JVM for each application identified should appear in the
console main window pane marked with one of the following symbols: or .
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9. Repeat the previous steps if you want to connect to several node agents.

Set Session Preferences
1. Double-click on the JVM icon in the data pane for the application that you want to monitor.

This opens the Session Preferences dialog box.

NOTE:

When the Optional Port Box Is Not Used
The console automatically attempts to use a port on the remote system between 9505 and
9515 when arranging a port for its server socket. If it is unable to successfully use a port from
this range, it will use an ephemeral port number.

2. By clicking the tabs in this dialog, you can see the default settings for metrics, filters, and
alerts. Enable or disable the settings as desired.

Interdependencies Exist Among Some Metrics and Between Some Metrics and Alerts:
Some metrics are obtained together and do not display independently from one another.
When this occurs, checking one metric may activate others, as shown in the following image.
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Some alerts require collection of specific metrics such that even if a metric is de-selected, it
may be activated by selection of a related alert.

3. Once all selections are made, click OK. The preferences window will close and the new Open
Session will be visible, marked by this icon:

Though it is possible to begin viewing application activity immediately in the monitoring
visualizers, you may want to wait for a short period of time before viewing some of the metrics.
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The length of time needed to collect sufficient data depends on the application size, the load
imposed on the application, and on the selected preferences. Typically, a wait of 5 to 30
minutes provides sufficient data to begin seeing significant clues to the application behavior
and performance. A longer collection time gives you greater accuracy in the results. For details,
see: Setting Monitoring Session Preferences (page 117) .

Changing Session Preferences During a Session
With HPjmeter 4.0 and later, it is possible to change session preferences during a session.
1. Double-click the “Open Session” line in the console for the session that you want to change.

The Session Preferences window opens.
2. Alternately, selecting the “Open Session” line on the console enables the Session Preferences

icon on the console tool bar. Click the icon to open the Session Preferences window.

View Monitoring Metrics During Your Open Session
1. Click on the open session or time slice to highlight the data that you would like to view.
2. Use the Monitor menu on the console main window to select the metrics that you want to see.

Mousing over each category in the cascading menu will reveal the relevant metrics for that
category.

3. Click a metric to open a metric visualizer displaying the chosen data.
For details on individual metrics and how to interpret the data display, see:
• Using Monitoring Displays (page 135)
• Monitoring Applications (page 46)
See also:
• Saving Monitoring Metrics Information (page 48)
• Using Visualizer Functions (page 134)

Using HPjmeter to Analyze Profiling Data
The following steps summarize how to use HPjmeter to view profiling information from your
applications.
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NOTE: If you are running the HP JDK/JRE 5.0.04 or later, you can send a signal to the running
JVM to start and stop a profiling data collection period with zero preparation and no interruption
of your application. See Profiling with Zero Preparation (page 74). If you are running the HP
JDK/JRE 7.0.04 or later, you can also use the HPjmeter console to start and stop a profiling data
collection period with no interruption of your application. See Profiling from HPjmeter with Zero
Preparation (page 74)

1. Configure your application.
Change the command line of your Java application to collect the desired type of data: -Xeprof
to collect execution profiling information, -agentlib:hprof to generate heap dump at program
exit, or -XX:+HeapDump to enable generation of heap dumps using the SIGQUIT signal.
There are additional heap dump options. For more details, see the Java™ Troubleshooting
Guide for HP-UX Systems at http://www.hp.com/go/hpux-java-docs.

2. Run the application to create a data file.
3. Start the console from a local installation on your client workstation.
4. Click File→Open File to browse for and open the data file, or drag and drop the file onto the

console.
5. For all profiling data types, a viewer window opens and displays a set of tabs containing

summary and graphical metric data. You will also see the Metrics and Estimate menus
containing additional metric display choices, and a control menu for changing thread scope.
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6. Click among the tabs to view available metrics.
Use the Metrics or Estimate menus to select additional metrics to view. Each metric that you
select opens in a new tab. Mousing over each category in the cascading menu will reveal the
relevant metrics for that category.

For details on individual metrics and how to interpret the data display, see:
• Collecting Profile Data (page 72)
• –Xeprof and –agentlib:hprof Profiling Options and Their Corresponding Metrics (page 79)
• Profiling Applications (page 69)
• Using Profile Displays (page 160)
• Using Visualizer Functions (page 134)

Using HPjmeter to Analyze Garbage Collection Data
The following steps summarize how to use HPjmeter to view garbage collection information from
your applications.

NOTE: If you are running the HP JDK/JRE 5.0.14 or 6.0.02 version, you can send a signal to
the running JVM to start and stop a verbose GC data collection period with zero preparation and
no interruption of your application. See Collecting GC Data with Zero Preparation (page 99).
If you are running the HP JDK/JRE 7.0.04 or later, you can also use the HPjmeter console to start
and stop a profiling data collection period with no interruption of your application. See Profiling
from HPjmeter with Zero Preparation (page 74)

1. Configure your application.
Change the command line of your Java application to use -Xverbosegc or -Xloggc options
to capture garbage collection data.

2. Run the application to create a data file.
3. Start the console from a local installation on your client workstation.
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4. Click File→Open File to browse for and open the data file, or drag and drop the file onto the
console.

5. A GC viewer window opens and displays a set of tabs containing summary and graphical
metric data.

6. Click among the tabs to view available metrics.
For details on individual metrics and how to interpret the data display, see:
• Analyzing Garbage Collection Data (page 94)
• -Xverbosegc and -Xloggc Options and Their Corresponding Metrics (page 101)
• Using Specialized Garbage Collection Displays (page 181)
• Using Visualizer Functions (page 134)

Monitoring Demonstration Instructions
HPjmeter includes two sample applications that you can run to see live examples of a “memory
leak” and a thread deadlock situation. You will be able to use the visualizers to examine data
during the demonstration session.
Here are the general steps for running the sample applications.
1. Start the console.
2. Start the node agent if it is not running as a daemon.
3. Start the sample application from the command line:

$ cd $JMETER_HOME/demo 
$ export LD_LIBRARY_PATH=$JMETER_HOME/lib/$ARCH
$ java -agentlib:jmeter -jar ML1.jar

As a convenience, HPjmeter includes a script that sets up the library path and bootclasspath
using a JVM found at installation time. To use this script, type:
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$ cd $JMETER_HOME/demo 
$ ../bin/run_simple_jvmagent -jar sample_program

Use the file name of the specific sample you want to run in place of sample_program.

4. In the console main window, click Connect and type in the host name of the machine that runs
the sample application. If you specified a port number when starting the node agent, use the
same port number. Otherwise, leave the port number box empty.

5. An icon representing the host appears in the main window. After a few moments, the console
also shows the sample application as a child node of the host.

6. Double-click the application node to open a monitoring session with the application.
The dialog box for setting session preferences will open.

7. Click OK to accept the default settings for metrics, filters and alerts.
The console main window now displays the open session.

Memory Leak Applications
There are two sample applications ML1 and Pi, that demonstrate how memory leak alerts work in
HPjmeter. ML1 demonstrates how Java Collection Leak Locations alerts work, and Pi demonstrates
how how Array Leak Locations alerts work.
The ML1 example uses a simple Java program that allocates some objects, and uses a
java.util.Vector object to retain references to some of the objects, thus exhibiting the behavior
of a memory-leaking application.
This application is configured to leak memory at the rate of about 10 MB per hour. The demo
application is available from the HPjmeter installation directory:
Source: $JMETER_HOME/demo/ML1.java
Binary: $JMETER_HOME/demo/ML1.jar
Use —jar ML1.jar with the run_simple_jvmagent script to start the sample.
When measuring the sample applications, allow considerable time for the heap to mature and
stabilize, and for the JVM agent to collect memory leak data. Eventually, you will see two alerts:
• Expected Out Of Memory Error Alert (page 128) with the leaking rate.
• Java Collection Leak Locations Alert (page 129) with the leak location.
When using the default garbage collectors and heap size for Java HotSpot Virtual Machine 1.4.2,
the detection of a memory leak for this demonstration program occurs after about 20 minutes. This
time can be substantially longer when using a different JVM or non-standard garbage collector or
heap settings.
In real situations, the detection time depends on the maximum heap size, the size of the leak, the
application running time, and the application and load characteristics. Typically, the detection will
occur in about one hour.
Here is a Java Collection Leak Locations alert for the sample program:

Here is the heap display for the sample program:
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Figure 1 Heap Display Showing Possible Memory Leak Behavior

See also Heap Usage Alert (page 129).
The Pi sample program uses a simple Java program that allocates some arrays, thereby exhibiting
the behavior of a memory-leaking application. The demo application is available from the HPjmeter
installation directory:
Source: $JMETER_HOME/demo/Pi.java
Binary: $JMETER_HOME/demo/Pi.jar

Use -jar Pi.jar with the run_simple_jvmagent script to start the sample. When measuring
the sample application, allow considerable time for the heap to mature and stabilize, and for the
JVM agent to collect memory leak data. Eventually, you will see two alerts:
• Expected Out Of Memory Error Alert (page 110) with the leaking rate.
• Array Leak Locations Alert (page 112) with the leak location.

When the default garbage collectors and heap size for Java HotSpot Virtual Machine 1.5.0.07
are used, the detection of a memory leak for this demonstration program occurs after about 90
minutes. This time can be substantially longer when using a different JVM or nonstandard garbage
collector or heap settings.
In real situations, the detection time depends on the maximum heap size, the size of the leak, the
application running time, and the application and load characteristics. Typically, the detection will
occur in about two hours.
Here is an Array Leak alert for the sample program:

Thread Deadlock Sample
This sample application demonstrates how HPjmeter detects deadlocked threads.
The example creates pairs of threads every 30 seconds, stopping at 50 threads, which synchronize
work using shared locks. Occasionally, the program reverses the order in which locks are taken,
eventually causing a deadlock, which generates a Thread Deadlock Alert (page 133).
The demo application is available from the HPjmeter installation directory:
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Source: $JMETER_HOME/demo/DL1.java
Binary: $JMETER_HOME/demo/DL1.jar
Use —jar DL1.jar with the run_simple_jvmagent script to start the sample.
Use the Thread Histogram display to see the thread activity. Deadlocked threads show a solid red
bar.

Figure 2 Thread Deadlock Example Display
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4 Monitoring Applications
In addition to using HPjmeter when you notice a problem, you can also use it to prevent problems.
For example:
• You can use HPjmeter to check the efficiency of your applications, even if you don't notice a

problem.
To make it easier to detect problems, you should periodically review key metrics for your
application to establish a baseline profile.
To save metrics information to a file that you can review later, see Saving Monitoring Metrics
Information (page 48).

• You can check your application after making code or configuration changes to see how
performance might have been affected.

NOTE: You cannot use HPjmeter to monitor Java applets in a production environment.

Controlling Data Collection and Display
HPjmeter provides two methods to control how information is collected and displayed.
JVM agent filters. The include and exclude options to the JVM agent allow you to filter metrics
by class name.
JVM agent filters are configured when you start the JVM, and cannot be dynamically changed.
Console filters are configured when you open a session with a JVM agent, and can be changed
from session to session. With HPjmeter 4.0 and later, these filters can also be changed during a
session.

NOTE: In metrics displays, you can see the list of filters in effect while the data was collected,

including default agent filters, by clicking the icon.

Related Topics

• Setting filters with JVM Agent Options (page 27)
• Setting filters by Setting Monitoring Session Preferences (page 117)

Setting Data Collection Preferences
HPjmeter allows you to control how metrics are collected to give you control over the amount of
detail and possible performance impact on your application.
When you open a session between the console and JVM agent, the Session Preferences window
lets you select from the available metrics, filters, and alerts.
When you open a session to monitor your applications, you can:

• Specify which metrics to collect.
• Enable alerts to give notifications when specific conditions occur.
• Specify filters to include or exclude specific classes.
Related Topics

• Controlling Data Collection and Display (page 46)
• Performance Overhead on Running Applications (page 212)
• Specifying Metrics to Collect for Monitoring (page 118)
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Managing Node Agents
Each managed node requires an HPjmeter node agent that manages communication between the
console and JVM agents.
Once the Session Preferences window closes, and after waiting for a few moments, you should
see the running JVM agents listed below the connected server host name. If no JVM appears, check
that a node agent is running on that server. If no node agent is running, the console cannot show
the JVM agents.
On HP-UX, you can run the node agent as a daemon or service for automatic, continuous operation,
or as a manual process when you do not need continuous operation.

Managing Node Agents On HP-UX

Running Node Agent as a Daemon
When you install HPjmeter on HP-UX systems, you can start the node agent as a daemon for
continuous automatic operation.

NOTE: Though you can run the node agent continuously, the node agent is not a high availability
application.

As a daemon, the node agent can use an alternate port number. To specify a different port number,
edit the /sbin/init.d/HPjmeter_NodeAgent file, add the -port option, and manually start
the node agent.
To start or stop the node agent daemon on HP-UX PA and IA:
$ /sbin/init.d/HPjmeter_NodeAgent start|stop

To change default options, such as port number, edit the contents of the file.

Verifying HP-UX Daemon is Running
When the node agent is running as a daemon on a HP-UX system, use these steps to verify that
the node agent is running:
1. You must be logged in with root permissions.
2. Check that these files exist:

• /sbin/init.d/HPjmeter_NodeAgent

• /sbin/rc3.d/S999HPjmeter_NodeAgent

3. Use the ps command, or its equivalent on your system:
$ ps -ef | grep node

The result should show:
$ JMETER_HOME/bin/nodeagent -daemon 

where
JMETER_HOME=/opt/hpjmeter 

The –daemon flag indicates that the node agent is running as a daemon.

To start or stop the node agent daemon manually:
$ /sbin/init.d/HPjmeter_NodeAgent start|stop

Starting Node Agents Manually
If you cannot use the node agent daemon or you need to set up access restrictions, you can start
a node agent manually. For information about access restrictions, see Working with Firewalls
(page 32).
A node agent must be running before the console can connect to a managed node to discover
your applications and open monitoring sessions.

Managing Node Agents 47



Start the node agent from the command line by typing:
$ JMETER_HOME/bin/nodeagent

where $JMETER_HOME has the default value of
JMETER_HOME=/opt/hpjmeter 

You can run the node agent as a background process. By default, the node agent listens for console
connections on port 9505, but you can designate an alternate port number using this option:
-port port_number

Related Topics

• Working with Firewalls (page 32)
• Running Node Agent as a Daemon (page 47)

Stopping Node Agents
To stop a manually started node agent, abort the process.

Node Agent Access Restrictions
To make the JVM agent visible to the corresponding node agent, start a node agent with the same
group ID or user ID of each JVM process whose JVM agent uses the group_private (default)
or owner_private options. Node agents started as root will see all JVM agents regardless of
the ownership ID used on the JVM agent.

Running Multiple Node Agents
To run multiple node agents on the same managed node, each node agent must listen on a different
port to control visibility to JVMs. Use the node agent port option to specify a port number. Each
user or group must remember the port on which their node agent is running to connect to it.
To provide more secure access, run multiple node agents and use the owner_private or
group_private option for the JVM agent. For more information, refer to Node Agent Access
Restrictions (page 48).

Saving Monitoring Metrics Information
HPjmeter offers two methods to save monitoring metrics information to a file.

• If you know in advance that you want to capture information for an entire application session,
you can run the JVM agent monitor_batch option when you start the application. See JVM
agent option monitor_batch[:file=filename].
When you save information using the monitor_batch option, the information is captured
from the start of the application session in a file on the managed node. To stop capturing
information, stop your application. For more information, see
monitor_batch[:file=filename].

• If you want to capture information from the start of the console session to the current time,
click File→Save as to name the saved data file. For details, see Saving Data from the Console
(page 49)

Each of these methods saves metrics information that you can later load into the console using the
Open File button or menu option., or dragging and dropping the file onto the console.
You can use these data files to capture information from live sessions to review later or to send to
a development team to show the state of your application.
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NOTE: Saved data files can be quite large. If you expect to keep the files or you plan to transfer
the files, compress the files for speedier transfer.
Compressing the files also reduces the chances that the file could be corrupted during a transfer.
You can compress various profile data files; for example: .vgc, .hprof (ascii text and binary
format), .eprof, and .hpjmeter. The preferred compression format is gzip. HPjmeter 4.1 and
higher can read gzip compressed files, without having to expand them.

Saving Data from the Console
When you save information using the Save as button from the console, the information from the
start of the console session is saved in a file on the system running the console.
In addition, you can save information from any cached session available on the console.
To save information as a console snapshot:
1. Go to the console main window.
2. Select a live or cached session node from the data tree.
3. Click File→Save as from the main window tool bar.

This opens the file chooser that allows you to specify where to save the file.
4. In the file chooser, select the directory in which you want to save the snapshot file.
5. Specify the snapshot file name.

The file chooser automatically appends the extension .hpjmeter to your file name.
To prevent adding the file name extension, use double quotes to surround the file name.

6. Click Save.
HPjmeter writes the session information to the file.

NOTE: When you close the console, HPjmeter checks for session data that has not yet been
saved. You are given an opportunity to save collected data, but you can choose not to do so.
If you typically do not save monitoring session data, you can turn this checking function off by
selecting Edit→Window Preferences and unchecking Confirm save when closing the main window.

Naming Monitoring Data Files
When you save monitoring data, HPjmeter appends the suffix .hpjmeter at the end of the file
name by default. You may want to follow this convention when naming data files saved during a
monitoring session, but it is not required.

Diagnosing Errors When Monitoring Running Applications
Issues or symptoms you might notice and how to identify problems and remedy them.

Identifying Unexpected CPU Usage by Method
To identify methods with unexpected CPU usage, use the Java Method HotSpots display.
This metric may require a relatively long time to stabilize, and is tuned for large, multi-CPU systems.
To determine if the CPU usage is unexpected, you need to know and understand how the application
works.
If this metric shows a large percentage of CPU time spent in just a few methods listed at the top,
it indicates that a performance problem may exist or there is room for improvement.
Typically, when the top entry is represented by a single-digit percentage, you should not see
application CPU performance issues unless the entry describes an obscure method that you did
not expect to see.
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Related Topics

• Java Method HotSpots (page 136)
• Process CPU Usage Alert (page 131)
• System CPU Usage Alert (page 132)

Viewing the Application Load
Use the Heap Monitor display.
This metric shows how busy the application is. It checks to see whether it is doing lots of allocations,
which typically corresponds to the load level, or whether it is idle.
When you select a coarse granularity of the view (1 to 24 hours), and assuming that there is no
memory leak, you will notice the overall change of behavior in heap size and garbage collection
pattern. This setting can help you understand the correlation between the application load and the
pressure on the heap.
If it seems a significant amount of time is spent in garbage collection, (gray in selected areas of
the display), it means that the heap was not adequately sized — it was too small for the load on
the application at that time. This behavior may also mean that the load was too high for the given
hardware and software configuration.
Related Topics

• Heap Monitor (page 140)
• Percentage of Time Spent in Garbage Collection (page 143)
• Heap Usage Alert (page 129)

Checking for Long Garbage Collection Pauses
Use the Heap Monitor display and select the shortest time interval.
Most garbage collections take several seconds at most to execute. Very large heaps, however,
may take up to several minutes.
Although the display does not show numerical values for the garbage collection duration, you can
look for extra wide garbage collection bars, which correspond to garbage collection pauses. They
will likely cause transient service-level objective (SLO) violations.
If intermittent, very long garbage collections are a potential problem in a given environment, you
can select appropriate garbage collection algorithms with a JVM option. Refer to your JVM
documentation.
Related Topics

• Heap Monitor (page 140)
• GC Duration (page 142) and GC Duration Alert (page 128)
• Garbage Collections (page 141)
• Heap Usage Alert (page 129)
• Data Collection with -Xverbosegc (page 94)
• Basic Garbage Collection Concepts (page 103)

Checking for Application Paging Problems
Use the Heap Monitor display, selecting a short time interval.
If multiple consecutive garbage collections take extraordinary time to run, this may indicate an
excessive paging problem, called thrashing, where the physical memory available to the application
is too small for the specified maximum size.
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You can verify this using a system tool like HP GlancePlus. The possible remedies for thrashing:

• Decrease the maximum heap size, which corresponds to a decrease of the maximum load
supported by the application.

• Eliminate other load on the system.

• Install more physical memory.
Related Topics

• Heap Monitor (page 140)
• Garbage Collections (page 141)
• Heap Usage Alert (page 129)

Identifying Excessive Calls to System.gc()
Use the Heap Monitor display.
When a high level of detail is selected (1 to 20 minutes), this metric can help detect if calls to
System.gc() are creating a performance problem. When your application calls this method,
you see that the heap size does not go to the local maximum before a garbage collection happens.
However, from time to time, the JVM may automatically invoke garbage collection in such
circumstance, too.
A rule of thumb is that if over half of all garbage collections seem to happen when the heap is not
full, then it may mean explicit calls to System.gc() are occurring. Remove explicit calls from
your application, either by modifying the code or by using an appropriate JVM option. These calls
rarely improve the overall performance of the application.
Related Topics

• Heap Monitor (page 140)
• Garbage Collections (page 141)
• Heap Usage Alert (page 129)
• Using Specialized Garbage Collection Displays (page 181)

Reviewing the Percentage of Time Spent in Garbage Collection
The percentage of time your application spends in garbage collection can help you identify potential
problems. Use the % Time Spent in Garbage Collection display to view this information. For details,
see Percentage of Time Spent in Garbage Collection (page 143).
In this example, you see a fairly normal application behavior.

• A low flat graph
• A low average value, represented by the red line
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Figure 3 Example Metric: Percentage of Time Spent in Garbage CollectionWhen Application Behavior
is Normal

This next example shows an application with a potential memory leak.

• A rising trend in the percentage of time spent in garbage collection.

Figure 4 Example Metric: Percentage of Time Spent in Garbage Collection When Application Shows
Potential Memory Leak

Related Topics

• How Memory Leak Detection Works (page 214)
• Expected Out Of Memory Error Alert (page 128)
• Java Collection Leak Locations Alert (page 129)
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• Array Leak Locations Alert (page 130)
• Class Loaders (page 173)

Checking for Proper Heap Sizing
Efficiencies in program performance can be obtained by allocating the optimal amount of memory
for the heap according to the needs of the program and the operation of the JVM garbage collection
routine. Checking activity in the heap and comparing to garbage collection frequency and duration
can help you determine optimal heap size needed for best performance from your application.
See the following sections for metrics that give insight into these aspects of the system:
• Current Live Heap Objects (page 147)
• Heap Monitor (page 140)
• Garbage Collections (page 141)
• Heap Usage Alert (page 129)
For detailed GC analysis, run your application with -Xverbosegc and use the HPjmeter GC
viewer to analyze GC activity in the heap. For additional details on memory usage, run your
application with -agentlib:hprof.

Confirming Java Memory Leaks
HPjmeter can automatically detect Java memory leaks, alerting you about the issue before the
application crashes.
After running for some time, Java applications can terminate with an out-of-memory error, even if
they initially had an adequate amount of heap space. The direct cause of this error is the inability
of the garbage collector to reclaim enough heap memory to continue.
The root cause of this problem is that some objects, due to the design or to coding errors, remain
live. Such objects, called lingering objects, tend to accumulate over time, clogging the heap and
causing multiple performance problems, and eventually leading to the application crash. Although
the nature of this phenomenon is different than memory leaks in C/C++, Java lingering objects
are also commonly called memory leaks.
A more subtle problem that can cause an out-of-memory error occurs when the Permanent Generation
area of memory becomes full of loaded classes. Running -agentlib:hprof can provide class
loading data that can help to reveal whether this problem is occurring.
Related Topics

• Expected Out Of Memory Error Alert (page 128)
• Garbage Collections (page 141)
• Current Live Heap Objects (page 147)
• How Memory Leak Detection Works (page 214)
• Java Collection Leak Locations Alert (page 129)
• Array Leak Locations Alert (page 130)
• Loaded Classes (page 158)
• Class Loaders (page 173)

Determining the Severity of a Memory Leak
When HPjmeter automatically reports memory leaks, use the Garbage Collections and Heap Monitor
displays to help you visualize object retention. Object retention may indicate Java memory leak
problems.
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Selecting large view ports, one hour or longer, allows you to easily see the trend in the heap size
after garbage collection and its increase rate, if any. You can visually assess the danger associated
with the memory leak, and estimate, based on the knowledge of the total heap size, when the
application would run out of memory, whether it is a matter of minutes, hours, or days.
The Heap Monitor and Garbage Collections data help you determine if an observed application
termination could have been caused by running out of heap space.
The Heap Monitor gives the idea about the overall heap limit, while the Garbage Collections
display shows the size of heap after each garbage collection.
If the heap size shown by Garbage Collections converges toward the heap limit, the application
will, or has, run out of memory.
Related Topics

• Expected Out Of Memory Error Alert (page 128)
• Garbage Collections (page 141)
• Heap Monitor (page 140)
• Current Live Heap Objects (page 147)
• How Memory Leak Detection Works (page 214)
• Heap Usage Alert (page 129)
• JMX Memory Tab (page 59)

Identifying Excessive Object Allocation
Use the Allocated Object Statistics by Class display.
This metric shows the most frequently allocated object types.
Verify your understanding of the application memory use pattern with this metric. Resolving this
problem requires knowledge of the application.
Related Topics

• Allocated Object Statistics by Class (page 145)

Identifying the Site of Excessive Object Allocation
Use the Allocating Method Statistics display.
This metric shows the methods that allocate the most objects. This metric is useful when you decide
to decrease heap pressure by modifying the application code.
Related Topics

• Allocating Method Statistics (page 146)

Identifying Abnormal Thread Termination
Look for the Abnormal Thread Termination Alert, which allows you to see a list of the uncaught
exceptions.
You can then use the Thread Histogram to investigate possible problems.
Terminated threads appear as a discontinued row. HPjmeter is unable to tell if the thread was
prematurely terminated or just completed normally. This is a judgment call, but in many cases the
analysis does not require extensive application knowledge.
If just one thread from a group of similar threads (by name, creation time and characteristics)
terminates, it is very likely that it was stopped.
A thread terminating abnormally does not necessarily bring the application down, but can frequently
cause the application to be unresponsive.
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Related Topics

• Abnormal Thread Termination Alert (page 126)
• Thread Histogram (page 152)

Identifying Multiple Short-lived Threads
Use the Thread Histogram.
Threads are relatively costly to create and dispose; usually a more efficient solution is through
thread pooling.
Related Topics

• Thread Histogram (page 152)
• Identifying Abnormal Thread Termination (page 54)

Identifying Excessive Lock Contention
Use the Thread Histogram.
There is no simple answer to how much lock contention is excessive. A multi-threaded application
normally exhibits some lock contention. With the Thread Histogram display, you can identify the
threads that clash over the same lock by visually comparing the pattern for the lock contention (the
red area) across several threads.
In situations when a small number of threads are involved in contention, you need to compare a
red area from one thread to the red and orange area in another thread. This may help identify
the involved locks, but it requires understanding the threading of the given application.
Some applications, such as WebLogic from BEA, use basic-level synchronization for multiple threads
reading from a single socket. This typically appears as very high lock contention for the involved
threads. If there are N threads using this pattern, the average lock contention for them will be
(N-1)/N*100%. Even though this kind of lock contention seems to be harmless, it unnecessarily
stresses the underlying JVM and the operating system kernel, and usually does not bring a positive
net result. There is a WebLogic option that can fix this. See the release notes for your version of
WebLogic for details.
You may attempt to decrease the level of lock contention by decreasing the number of involved
threads. If this does not help, or if it decreases the application throughput, you should deploy the
application as a cluster. At the same time, large servers, for example 8-way, can be re-partitioned
as a group of smaller virtual servers.
If the lock contention appears in your application, rather than a third-party application, you may
be able to change your code to use different algorithms or to use different data grouping.
Related Topics

• Lock Contention (page 153)
• Thread Deadlock Alert (page 133)
• Thread Histogram (page 152)

Identifying Deadlocked Threads
HPjmeter allows you to enable an alert that identifies deadlocked threads. You can then use the
Thread Histogram to get more specific information.
Deadlocked threads represent a multi-threaded program error.
Thread deadlock is the most common cause of application unresponsiveness. Even if the application
is still responding, expect SLO violations.
Restart the application that experienced the deadlock, and fix the application code to avoid future
deadlocks.
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Related Topics

• Thread Deadlock Alert (page 133)
• Thread Histogram (page 152)

Identifying Excessive Thread Creation
Use the Thread Histogram to identify excessive thread creation.
The Thread Histogram shows the number of threads existing in the observed period of time. By
selecting the smallest time interval, one minute, you can see an estimate of the number of
simultaneously active threads. Most operating systems have a limited capacity for the number of
threads a single process may create. Exceeding this capacity may cause a crash. Although HPjmeter
cannot indicate whether or not this will happen, the intensity of the new thread creation may suggest
deeper analysis is needed in this area.
Adjusting kernel parameters may increase the threads per process limit.
Sometimes an application may exhibit threads leak, when the number of dynamically created
threads is unconstrained and grows all the time. Tuning kernel parameters is unlikely to help in
this situation.
Related Topics

• Thread Histogram (page 152)

Identifying Excessive Method Compilation
HPjmeter allows you to enable an alert that identifies excessive method compilations. You can then
use the Method Compilation Count display to view the specific method or methods that caused the
alert.
Symptoms of excessive method compilation include poor application response because the JVM
is spending time re-compiling methods.
The Method Compilation Count display shows the methods that have been compiled, sorted by
number of compilations.

Figure 5 Example Metric: Method Compilation Count

Excessive method compilation is rare, especially with newer releases of JVM. Sometimes, due to
a defect in the JVM, a particular method can get repeatedly compiled, and de-optimized. This
means that the execution of this method oscillates between interpreter and compiled code. However,
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due to the stress on the JVM, such phenomena are typically much more costly than just running
this method exclusively in interpreted mode.
Repeated compilation problems may result in SLO violations and will affect some or all transactions.
Read the JVM Release Notes to learn how to disable compilation of selected methods for the HP
Java HotSpot Virtual Machine.
Related Topics

• Excessive Compilation Alert (page 128)
• Method Compilation Count (page 156)
• Method Compilation Frequency (page 157)

Identifying Too Many Classes Loaded
Use the Loaded Classes display.
This display can be used to determine if the pool of classes loaded into memory stabilizes over
time to a constant value, which is normal.
In some JVMs, like HotSpot, loaded classes are located in a dedicated memory area, called the
Permanent Generation, which is typically much smaller that the whole heap. If the application
repeatedly loads new classes, either from external sources, or by generating them on the fly, this
area overfills and the application abnormally terminates. This will correspond with the value of
this metric constantly growing up to the point of failure.
If you find that the application terminates because the number of loaded classes is too large for
the area of memory dedicated to this purpose, you can increase the heap area for the class storage
by using a JVM option. However, if changing the dedicated memory size will not help the situation
because the number of the loaded classes is unconstrained, this is an application design issue that
needs to be solved.

NOTE: An overflow of the area dedicated to class storage can cause the application to terminate,
sometimes with an OutOfMemoryError message, even if there is plenty of space available on
the heap. Consult your JVM documentation on how to increase the area dedicated for class storage,
if necessary.

Related Topics

• Loaded Classes (page 158)
• Class Loaders (page 173)
• Expected Out Of Memory Error Alert (page 128)

Using the JMX Viewer
The JMX viewer provides access to data collected from the operation of JMX servers inside the
Java Virtual Machine for Java 1.5.x versions.
The viewer also provides you with the ability to interject in some operations of the JVM and to
manipulate the operation and attributes of MBeans that you have defined. Using HPjmeter monitoring
displays, you can observe the effect of changing the characteristics of MBeans that you have
loaded into the JMX server of the virtual machine.
Opening the JMX viewer
On opening a session with an application running on Java 1.5.x, a data node displays in the
main console to represent current data collected from the JVM.

Using the JMX Viewer 57



Figure 6 Main Console Showing an Expanded JMX Server Node in an Open Session

To access this summary data, double-click on the summary JMX server node. The summary JMX
Viewer opens. For information on this part of the JMX Viewer, see Understanding the JMX Summary
View (page 58).
To manipulate some JVM and MBean functions on this server, expand the summary node and
double-click the entry labeled Modify JMX MBean data. The server JMX Viewer opens. For
information on this part of the JMX Viewer, see Changing Mbean Values and Monitoring the Result
(page 63)

NOTE: This functionality is available only during an open session. No record of the actions taken
within the JMX viewer are saved. To preserve a record of changes occurring in the application
run due to manipulation of the JMX server and MBeans, save the monitoring session data for later
review. Use the monitoring metric visualizers to view the saved data.

See also
• View Monitoring Metrics During Your Open Session (page 39)
• Tapping in to Standard Management of the Java Virtual Machine (page 215)

Understanding the JMX Summary View
The JMX viewer opens in the Summary view with five tabs displayed:

• JMX Summary Tab (page 58)
• JMX Memory Tab (page 59)
• JMX Threads Tab (page 61)
• JMX Runtime Tab (page 63)
• JMX Notifications Tab (page 63)

JMX Summary Tab
The Summary tab shows a collection of data about the operating system and hardware, allocated
memory, current heap usage, and class loading status. Values are updated throughout the duration
of the open session.
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Figure 7 Appearance of the Summary JMX Viewer When First Opened

JMX Memory Tab
Fluctuations in memory usage in heap and non-heap areas are graphically displayed and
periodically updated for the duration of the open session. Mouse over the features of the graph to
learn what spaces are represented, as well as to learn what each of the markers designates.
The following image demonstrates some of the features available on this tab.
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Figure 8 JMX Viewer with Summary Memory Tab Selected

Select a region of interest
Click the color bar in the graph to select the memory space of interest. The bar will become outlined
in blue and the Region Details will update in the text area.
Consult the Region Details for updated information on memory usage in that region, total count of
garbage collections, and cumulative duration of GC events.
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Set a usage threshold
Where usage threshold can be set, a “0” (zero) appears in the Usage Threshold box. To set a
threshold, replace the current value with a desired, valid value in the box, and press Enter. To see
what values are valid for a region, mouse over the Usage Threshold box.
On pressing Enter, a red marker will appear on the region usage bar to mark the point at which
the threshold is reached. The bar color turns red when the threshold is reached and a notification
is generated.
Start verbose GC

At any point, you can click the verbose GC check box to start collection of verbose GC data by
the JVM. The JVM usually writes this information to stdout. Uncheck the box to stop logging
verbose GC data.
Perform a garbage collection

At any point, you can click the Perform GC button to force a System.gc garbage collection on
the heap.
Related Topics

• Basic Garbage Collection Concepts (page 103)
• Using Monitoring Displays (page 135)
• Using Profile Displays (page 160)

JMX Threads Tab
HPjmeter locates and tracks the live threads processing during the application run. This image
shows available functions on the Threads tab.
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Figure 9 JMX Viewer with Summary Threads Tab Open

See the list of live threads
Pull the slider in the data pane to the right to reveal the current list of live threads.
See details for a selected thread

Click a thread name in the left pane. Details on thread activity and current state appear in the right
pane.
Apply a filter

This filtering text box is useful when the thread list is long. It allows you to reduce the list size
according to the starting letters of the thread name. To apply a filter, start typing the first few
distinguishing letters of the thread names that you are interested in. The list will immediately be
trimmed to entries starting with those letters. Deleting text from the filter box returns the list to its
original state.
Detect thread deadlock

At any point, you can check the box for “Detect Deadlock” to start monitoring specifically for thread
deadlock conditions. When a deadlock condition is encountered for a particular thread, the text
of the thread name turns red. Uncheck the box to stop watching for this condition.
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Related Topic

• Using Monitoring Displays (page 135)

JMX Runtime Tab
The Runtime tab summarizes important characteristics of the runtime environment, including data
on the JVM version and uptime, options used to start the monitoring agent, and some aspects of
the hardware and operating system such as memory assignment, swap space, and operating
system type and version.

JMX Notifications Tab
Notifications triggered by changes that you make using the JMX viewer appear on the Notifications
tab. They are available for viewing for the duration of the open session or until you clear them
from the screen using the Clear All button.
See also The MBean Notifications Tab (page 67)

Changing Mbean Values and Monitoring the Result
Use the JMX server view to select the MBeans that you want to look at in detail. The following
image shows the default view on opening the JMX server view. An explanation follows the image.

Figure 10 Default View When Server JMX Viewer is Opened

JMX MBean list filter
Click this button to see a list of the filters that you can apply to the MBean drop-down menu items
at .

Using the JMX Viewer 63



JMX server drop-down menu
The server from which this JMX viewer was launched is shown in the “JMX Servers” drop-down
menu.
JMX MBean drop-down menu

This drop-down menu lists the viewable MBeans for which data can be displayed in the viewer.
This list can get quite long when viewing data for application servers. To reduce the list length in
the drop-down menu, click the MBean filter button at .
JMX MBean tab navigation

Select an MBean, and the data for that bean is displayed in the four tabs appearing immediately
below the drop-down menus. Click among the tabs to looks at various aspects of the selected
MBean. Four tabs are available in the JMX server view: Attributes (page 64), Operations (page 66),
Notifications (page 67), and Information (page 67).
JMX MBean Details Viewer

In the Detail Viewer, you can drill down into the MBean data for details or to force an operation.

Using the Functions in the JMX Server View
The following discussion touches on the basic functions in this area of the JMX viewer.

The MBean Filter
Click the MBean filter button to select a subset of MBeans to populate the MBean drop-down
menu.
A small window opens that gives you the following options for sorting the MBeans:

• by domain (for example, java.lang, com.bea)
• by name (for example, ClassLoadingImpl, MBeanServerDelegate)
• by type (for example,GarbageCollector, MemoryPool)
Select the filter type that you want, and click the Use Filter button.
Use the MBean drop-down menu to see the resulting list and to select an MBean to view.

The MBean Attribute Tab
The Attributes tab lists the contents of the selected MBean. In general, two actions are possible at
this level: drill down to see values of an attribute and change the value of an attribute. The following
image shows an example. An explanation follows the image.
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Figure 11 MBean Attributes Tab Open for Display

List of name/value pairs found in the selected MBean
The names are listed with their value. Values may be dynamically updating; you may open them
to reveal further details as in , or you may edit them as in .
Clickable value

Names or values appearing in boldface type can be opened to display details in the Detail Viewer
area. Double-click the boldface text to open a tab in the Detail Viewer as in . The tab remains
open until you click the closure box on the tab or until you close the viewer.
Editable value

Values appearing in blue type can be changed. Click the blue text to open a text box. Type the
change, and press Enter to immediately apply the change. To view the effect of the change, choose
an appropriate monitoring metric.
Detail Viewer tab

Opens when boldface values are double-clicked. Tabs appearing in this area provide additional
data or operations that you can modify and immediately apply. The detail tab remains available
until you click the closure box on the tab or until you close the viewer.
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The MBean Operations Tab
Not all MBeans have operations associated with them. This tab is grayed out when the selected
MBean has no operation associated with it. The next figure shows an open Operations tab with
details about a particular MBean. An explanation follows the image.

Figure 12 MBean Operations Tab Open for Display

Selected Operation Name
The names are listed with their return type and number of arguments. By double-clicking a boldface
name, the return type is highlighted and a tab opens in the Detail Viewer containing the operation
and one or more editable text boxes. See and .
Operational detail tab

The detail tab remains available until you click the closure box on the tab or until you close the
viewer.
Editable text box

Values appearing in text box can be changed. Type the change, and press the Operation_Name
button to immediately apply the operational change. In this example, the operational button name
is getThreadCpuTime . To view the effect of the change, choose an appropriate monitoring metric.
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The MBean Notifications Tab
Not all MBeans have notifications associated with them. This tab is grayed out when this information
is not present. The next figure shows an open Notifications tab with details about the selected
MBean. An explanation follows the image.

Figure 13 MBean Notifications Tab Open for Display

Enable or disable notification
Click the check box to enable or disable the notification.
Notification detail tab

When the conditions for the notification are triggered, messages resulting from the event appear
here. The detail tab remains available until you click the closure box on the tab or until you close
the viewer.

The MBean Information Tab
The next figure shows an open Information tab with additional related information about the
selected MBean. An explanation follows the image.
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Figure 14 MBean Information Tab Open for Display

View classification information
Name/Value pairs are given that provide relational information for the selected MBean.
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5 Profiling Applications
HPjmeter allows you to process profile data from Java virtual machines.
Separating the profile data collection step from the analysis step has the following advantages:

• The data analysis can be done at a different time and on a different platform than was used
to run the application. For example, it can be done on a desktop system or on a laptop.

• A non-interactive profiling agent will often impose less overhead than an interactive one.

• The profile data files obtained naturally facilitate comparison of different runs or creation of
a history of performance improvements.

The -Xeprof profiling option, available for the HP-UX HotSpot™ VM, was specifically designed to
produce profile data files for HPjmeter. This option works well to capture performance data for
viewing, and now can be accessed during a program run, as well as when starting an application.
-Xeprof focuses primarily on performance problems that characterize large server applications.
Its relatively low overhead allows you to collect performance data such as the delay caused by
lock contention, actual CPU time used by Java methods, and actual profiler overhead.

Using the -Xeprof switch on HP-UX 11.31:
For best results when using the -Xeprof switch on HP-UX 11.31 on Integrity systems, you should
run Java 1.5.0.14 or later, or 6.0.02 or later or 7.0.00 or later, because the thread timing data
generated by earlier releases of Java can be inaccurate on 11.31.
How to tell when the thread timing data is off: Because Java can generate an eprof data file with
no errors or other indication of a problem in this situation, you may not know the file is inaccurate
until you try to open it with HPjmeter. Then, HPjmeter will either refuse to load the file, or it will
load the file, but display unusual results.
If HPjmeter refuses to load the file, it will display an error message such as
Number format error at line NNN. Cannot continue.

If HPjmeter does load the file, you will see unexpected and inaccurate results in the metric displays.
The unexpected results can be seen most easily by examining the Threads Histogram. If you see
many threads spending all their time in an unexpected state, such as "Unknown" or "Lock
Contention", then you are experiencing the problem with inaccurate data. Update your Java
installation to one of the versions mentioned above to correct the problem.

Although many features of HPjmeter are available only when -Xeprof is used to capture the
profile data, useful profile data can be obtained from almost any JVM. No special compilation or
preprocessing of the application code is needed, and you do not need to have access to the source
code to get the profiling data for a Java program.
This guide also presents information on running the JVM with -agentlib:hprof , which also
provides numerous statistics, some of which are especially useful for detailed profiling of memory
usage).

Profiling Overview
Profiling an application means investigating its runtime performance by collecting metrics during
its execution. One of the most popular metrics is method call count - this is the number of times
each function (method) of the program was called during a run. Another useful metric is method
clock time - the actual time spent in each of the methods of the program. You can also measure
the CPU (central processing unit) time, which directly reflects the work done on behalf of the method
by any of the computer's processors. This does not take into account the I/O, sleep, context switch,
or wait time.
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Generally, a metric is a mapping that associates numerical values with program static or dynamic
elements such as functions, variables, classes, objects, types, or threads. The numerical values may
represent various resources used by the program.
For in-depth analysis of program performance, it is useful to analyze a call graph. Call graphs
capture the “call” relationships between the methods. The nodes of the call graph represent the
program methods, while the directed arcs represent calls made from one method to another. In a
call graph, the call counts or the timing data are collected for the arcs.

Tracing
Tracing is one of two methods discussed here for collecting profile data. Java virtual machines use
tracing with reduction. Here is how it works: the profile data is collected whenever the application
makes a function call. The calling method and the called method (sometimes called “callee”) names
are recorded along with the time spent in the call. The data is accumulated (this is “reduction”) so
that consecutive calls from the same caller to the same callee increase the recorded time value.
The number of calls is also recorded.
Tracing requires frequent reading of the current time (or measuring other resources consumed by
the program), and can introduce large overhead. It produces accurate call counts and the call
graph, but the timing data can be substantially influenced by the additional overhead.

Sampling
In sampling, the program runs at its own pace, but from time to time the profiler checks the
application state more closely by temporarily interrupting the program's progress and determining
which method is executing. The sampling interval is the elapsed time between two consecutive
status checks. Sampling uses “wall clock time” as the basis for the sampling interval, but only
collects data for the CPU-scheduled threads. The methods that consume more CPU time will be
detected more frequently. With a large number of samples, the CPU times for each function are
estimated quite well.
Sampling is a complementary technique to tracing. It is characterized by relatively low overhead,
produces fairly accurate timing data (at least for long-running applications), but cannot produce
call counts. Also, the call graph is only partial. Usually a number of less significant arcs and nodes
will be missing.
See also Data Sampling Considerations.

Tuning Performance
The application tuning process consists of three major steps:

• Run the application and generate profile data.

• Analyze the profile data and identify any performance bottlenecks.

• Modify the application to eliminate the problem.
In most cases you should check if the performance problem has been eliminated by running the
application again and comparing the new profile data with the previous data. In fact, the whole
process should be iterated until reasonable performance expectations are met.
To be able to compare the profile data meaningfully, you need to run the application using the
same input data or load (which is called a benchmark) and in the same environment. See also
Preparing a Benchmark (page 71).
Remember the 80-20 rule: in most cases 80% of the application resources are used by only 20%
of the program code. Tune those parts of the code that will have a large impact on performance.
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There are two important rules to remember when modifying programs to improve performance.
These might seem obvious, but in practice they are often forgotten.
• Don't put performance above correctness.

When you modify the code, and especially when you change some of the algorithms, always
take care to preserve program correctness. After you change the code, you'll want to test its
performance. Do not forget to test its correctness. You don't have to perform thorough testing
after each minor change, but it is certainly a good idea to do this after you're done with the
tuning.

• Measure your progress.
Try to keep track of the performance improvements you make. Some of the code changes,
although small, can cause great improvements. On the other hand, extensive changes that
seemed very promising may yield only minor improvements, or improvements that are offset
by a degradation in another part of the application. Remember that good performance is only
one of the factors determining software quality. Some changes (for example, inlining) may
not be worth it if they compromise code readability or flexibility.

Preparing a Benchmark
To test the performance of your application, you need to run it on some input data. Preparing good
data for performance testing can be a difficult task. For many server-type applications this may
involve setting up several machines, and creating an “artificial” load. Constructing the benchmark
itself is probably the single most time-consuming step in application tuning, but when done correctly,
it can be worth the effort.
Generally, you want the benchmark to resemble as much as possible the real load that the
application will face when finally deployed.
There are several mistakes that are often made at this stage. To avoid the most common ones,
remember the following:
• Make the benchmark repeatable; this is key to the systematic approach to performance tuning.

• Do not create unrealistic situations that could speed up or slow down your application
considerably. For example:

◦ Do not direct all the traffic to just a few records in the database, which could cause
exceptionally good performance because of caching, or exceptionally bad performance
because of lock contention.

◦ Do not run all clients from one machine. This might not exercise your application properly
because of the performance bottleneck on the client side.

◦ Do not use too much invalid data; it may never get to the components of the application
that do the real work.

◦ Do not use a different environment (like the JVM, or options) for the performance testing
than the one to be used for the real deployment.

• Size your benchmark appropriately:

If the benchmark runs only briefly, the profile data will contain too much “startup noise”
from the effects caused by class loading, dynamic libraries loading, bytecode compilation

◦
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and optimization, and the application initializations (database connections, threads, and
data structures).

◦ If the benchmark runs for too long, it will be very time consuming to repeat the run, and
you'll be tempted to make several changes to your application between the consecutive
profiling runs, which is not recommended.

• As your application grows in terms of performance, you may need to scale up your benchmark
as well.

See also
For information on how to compare data files, see Comparing Profiling Data Files (page 85) and
Scaling Comparison Data (page 86).

Collecting Profile Data
To take full advantage of HPjmeter functionality, you can gather profiling data using -Xeprof for
performance tuning and -agentlib:hprof for memory tuning when you run your application.

NOTE: If you are running the HP JDK/JRE 5.0.04 or later, you can send a signal to the running
JVM to start and stop a profiling data collection period with zero preparation and no interruption
of your application. See Profiling with Zero Preparation (page 74).
If you are running the HP JDK/JRE 7.0.04 or later, you can also use the HPjmeter console to start
and stop a profiling data collection period with no interruption of your application. See Profiling
from HPjmeter with Zero Preparation (page 74)

Profiling with -Xeprof
To profile an application, use the following command:
    $ java -Xeprof:options ApplicationClassName

To profile an applet, use the following command:
   $ appletviewer -J-Xeprof:options URL

where options is a list of key[=value] arguments separated by commas.
You can also stop the JVM (kill pid) or control the profiling time using the time_on or
time_slice options. See the descriptions in the list of options.
The following options are especially useful in most cases:

• For CPU time, clock time, and lock contention metrics with minimal intrusion, use -Xeprof

• For exact call count information and non-array object creation profiling, use
-Xeprof:inlining=disable

To see the complete list of available options, use java -Xeprof:help
-Xeprof always collects call graph data with inclusive method times (clock and CPU), method
call count, and lock contention metrics. This option uses tracing with reduction and collects the
data separately for each thread.
To see the availability of HPjmeter metrics from -Xeprof data collection, see –Xeprof and
–agentlib:hprof Profiling Options and Their Corresponding Metrics (page 79).
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Table 3 Supported -Xeprof options

Specifies the time in seconds between the application start and the time when
the profile data collection will start. If no time_on option is present, the data
collection begins at the VM initialization.

time_on=integer

Specifies which signal will cause profiling to begin (profile data collection).time_on=sigusr1|sigusr2

• Be aware that the application or the VM may already be using the sigusr
signals for their own purposes.

• It is possible to specify a signal and a timeout at the same time by using
both forms of the time_on option in one command.

• Only one of the two signals can be declared to use as the signal to start
profiling.

• During the application's run, the specified signal can be delivered to the
Java process multiple times.

Specifies the time in seconds between the profiling start and the time when
profiling will be terminated.

time_slice=integer

• When the profiling is terminated, the profile data is written to a file. The
application will continue running.

• If time_slice is not specified, or if the application terminates before the
specified time elapses, but the profiling has started, the profile data will be
written out after the termination of the application.

Specifies which signal will cause profiling termination and the profile data
output.

time_slice=sigusr1|sigusr2

• The signals for profiling start and profiling termination can be the same. It
is possible to specify a signal and a timeout at the same time by using both
forms of the time_slice option in one command.— termination of profiling
occurs when the first qualifying event takes place. The application will
continue running.

• Only one of the two signals can be declared to use as the signal to terminate
profiling.

• During the application's run, the signal to terminate profiling can be delivered
to the Java process multiple times. However, profiling will only be terminated
and a result file generated if profiling is active when the termination signal
is delivered.

The profile data will be written to the named file.
• If time_on=sig... has not been specified, the default is

filename.eprof

If a signal has been specified to start profiling, several data files can be
created, with names filename_t.eprof, wheret is the time in seconds
between the application start and the profiling start.

file=filename

The compiler in the HotSpot VM optimizes Java applications by inlining
frequently called methods. Execution of an inlined method is not reported as a

inlining=disable|enable

“call” because the actual call has been eliminated. Instead, the time spent in
an inlined method is attributed to its “caller” The consequences of inlining for
profiling can be characterized as follows:
• The obtained profile data does not reflect faithfully all the calls within the

Java code as written by the programmer, but rather as it is actually executed
by the VM. For most performance analysis cases, this is a desired feature.

• As the calls within the Java application are eliminated, the corresponding
calls to the profiler are eliminated too, resulting in lower profiling overhead.

• The count of created objects cannot be reliably estimated from the call graph
in the presence of inlining, because the calls to the constructors may have
been inlined.
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Table 3 Supported -Xeprof options (continued)

The default value for this option is enable. Another way to disable inlining is
to collect the profile data while running the VM in interpreted mode (-Xint).

Enable/disable the profiling intrusion estimation.ie=yes|no

ie=yes, the default value, specifies that the profiler estimates the profiling
intrusion and writes the estimated values to the profile data file. HPjmeter uses
this data to compensate for intrusion, which means that the estimated intrusion
is subtracted from the CPU times before they are presented to the user. Disabling
intrusion estimation slightly reduces the size of the data files, but will also disable
the intrusion compensation feature. This option has no impact on the actual
profiling overhead.

Profiling with Zero Preparation
Zero preparation profiling is a feature of the HP JDK/JRE 5.0.04. It is started from the command
line by sending a signal to the JVM to start eprof. Engaging zero preparation profiling may have
a short term impact on application performance as the JVM adjusts to the demands of performing
dynamic measurements.
To collect profiling data without interrupting your application, do the following from the command
line:
1. Confirm that a HP JDK/JRE 5.0.04 or later is running the application that you want to profile,

and that no -Xeprof option has been specified.
2. Find the process ID of the running Java application.
3. Start the profiling interval: send a signal to the JVM by typing:

kill -USR2 pid

You will see the following message:
eprof: starting profiling

Let the profiling collection generated by the JVM continue for the length of time that you think
will be meaningful.

4. Stop the profiling interval by sending the same signal to the JVM:
kill -USR2 pid

You will see the following message:
eprof: terminating profiling

writing profile data to ./filename.eprof

You can now open the saved file in the HPjmeter console and view the collected metrics.

NOTE: For the signal to be captured by the JVM, you must either be logged in as root, or you
must be the user who started the JVM.

Related Topics

• Zero Preparation Profiling (page 221)

Profiling from HPjmeter with Zero Preparation
Enhanced zero preparation profiling is a feature of HP JDK/JRE 7.0.04. Profiling can now be
started from the HPjmeter console while performing real-time monitoring of a running Java
application. To collect profiling data from the HPjmeter console without interrupting your application,
do the following:
1. Open a real time monitoring session with the JVM. See “Using HPjmeter to Monitor

Applications” (page 34).
2. Click the extended profiling button
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to open the Remote Operations window.
3. Press the Configure button to set up your required configuration, if needed.
4. Press the Profile button to start profiling
5. When the profiling time period has ended, one of the following tasks are performed based

on your configuration:
• If the appropriate configuration options are set, HPjmeter will automatically transfer the

profiling data file from the remote server to the local machine, and open the data file.
The file remains available on the local system, so the user can reopen it later, if required.
The user can also configure the directory to store the files.

• If the configuration options are not set to transfer the file, it will be available on the remote
server. The HPjmeter UI will display the filename on the remote system.

Configuring Remote Operations window
You can use the Configure window to modify the HPjmeter options related to zero preparation
extended profiling that is initiated from the HPjmeter console. Starting HPjmeter 4.3, the console
can start the collection of profiling data for the Java application running on a remote HP-UX server.
You can also use the Configure window to configure the behavior of HPjmeter in this scenario.
HPjmeter can also transfer the eprof file from the HP-UX system to the local system using the sftp
protocol.
The following image shows some of the features available on this window.

The General section in the first half of the window is used to configure the sftp connection.
Set Username and Hostname

Specify the user name and host name that will be used to log in to the HP-UX system. You must
have an open session with an HP-UX host to use the remote extended profiling support, and you
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must also ensure that the host name specified here must match the name of the host used in the
open session.
Use known_hosts file

Click the checkbox if the specified known_hosts file should be used to connect to the remote
host.
Use public key identity

Click the checkbox if the specified public key file should be used for logging in to the remote host.
If a public key is not used or a password is required, you will be prompted when the sftp connection
is opened.
Specify the directory

Set the directory on the local machine that will hold the eprof files when they are transferred.
Specify the port

Set the port used for the connection, usually 22.
The General section in the first half of the window is used to configure the sftp connection.
Set profiling duration

The slider control is used to set the duration of the profiling run. You can choose a value between
1 and 20 minutes for the profiling session. The JVM will automatically enable the profiler, collect
the data, and disable the profilier. Because the profiling operation can affect the runtime
performance of the Java application, HPjmeter sets an upper limit on the amount of time allowed
for profiling. To collect profiling data for a longer period of time, you must use the server side
zero-preparation mode or the –Xeprof command line option.
Related Topics

• Profiling with Zero Preparation (page 74).
• Profiling with -Xeprof (page 72)
Specify the eprof files transfer

Click the checkbox if HPjmeter should copy the file over from the HP-UX system after profiling has
finished.

Specify to open the transferred files
If the file has been copied to the local system, click the checkbox to indicate whether HPjmeter
should open it.

Profiling with -agentlib:hprof
Java 2 introduced a profiling interface, called JVMPI (Java Virtual Machine Profiler Interface). This
interface came with a sample profiling agent, called hprof.
The Java 5.0 release introduced an improved profiling interface, called JVMTI (Java Virtual Machine
Tool Interface), which replaces JVMPI. The hprof agent is also available with JVMTI.
This agent creates profile data files that can be interpreted after the program terminates. However,
note that the format of the files may be still evolving. Most Java versions based on JavaSoft
implementations are compatible. Currently HPjmeter can read text and binary files.
To run your application with profiling, use the following command:
    $ java ... -agentlib:hprof[=options] ApplicationClassName

To profile an applet, use the following command:
    $ appletviewer ... -J-agentlib:hprof[=options] URL
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The following options are useful:

• For performance profiling:
cpu=samples,thread=y,depth=10,cutoff=0,format=a

• If you must have method call counts for performance profiling:
cpu=times,thread=y,cutoff=0,format=a

• For analyzing object allocations:
heap=sites,cpu=samples,thread=y,cutoff=0,format=a

• For solving memory retention problems ("memory leaks"):
heap=all,thread=y,cutoff=0,format=a,doe=n

Then use kill -QUIT pid (on UNIX ) to get the heap dump.

NOTE: Beginning with HPjmeter version 3.1, you can view binary hprof files (format=b) in
HPjmeter visualizers.

To see the complete list of available options, use
java ... -agentlib:hprof=help

To see the availability of HPjmeter metrics from hprof data collection, see –Xeprof and
–agentlib:hprof Profiling Options and Their Corresponding Metrics (page 79). For additional
information on collecting heap dump data, see the Java™ Troubleshooting Guide for HP-UX Systems
at http://www.hp.com/go/hpux-java-docs.

NOTE:
With the addition of JVMTI in JDK 5.0, the -agentlib switch is the preferred way to activate
tools such as hprof. With -agentlib, you can take advantage of improvements in JDK 5.0 and
reduce the impact of data sampling on application performance. While -Xrunhprof can still be
used to specify the JVM agent with Java 5 versions, the impact on application performance is
significantly greater than when using -agentlib.
You will still need to use -Xrunhprof to specify the hprof agent for earlier supported versions of
Java (1.4.x).

Here are the supported -agentlib:hprof options that affect the collection of profile data:

Table 4 Supported -agentlib:hprof options

The heap dump shows all objects remaining in memory at the time of
the dump. The allocation sites show where the objects were created

heap=dump|sites|all

during the execution of the program. Heap analysis can be used to
locate memory leaks, and the allocation sites can be used to minimize
the memory usage.
To solve memory retention problems, the best practice is to use the QUIT
signal rather than the application shutdown to obtain the heap dump.
When the application shuts down, some references go out of scope and
the retention problem may get eliminated just before the heap is dumped.
Send the signal at the moment that you suspect the application is holding
references to no longer needed objects. Add the doe=n hprof option
to turn off the heap dump from application shutdown.
To keep the heap dump size down, try to send the signal just after a full
garbage collection (use -verbose:gc to be notified about the garbage
collections).
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Table 4 Supported -agentlib:hprof options (continued)

Remember that a heap dump contains all objects, not just live objects

cpu=samples uses sampling as the collecting technique, while
cpu=times uses tracing with reduction.

cpu=samples|times

• Typically, the times collected by cpu=samples|times are CPU
virtual times. However, HP-UX 11i versions use real CPU times rather
than CPU virtual times unless sampling is used.

• Some implementations of cpu=times report clock time. HPjmeter tries
to figure out what times actually have been collected, but sometimes
does not do it right.

• cpu=samples and cpu=times output exclusive times.

• Collecting heap data can be very intrusive, so we recommend that
you measure the method times and heap usage at different times.
However, it may make sense to specify heap=sites and
cpu=samples|times for the same run when you want to locate
the allocation sites in the call graph.

Controls whether the stack traces collected during program execution
will be associated with an individual thread.

thread=y|n

• By default, no thread identification information is stored (thread=n).

• We suggest that you always specify thread=y.

• With the thread identification in the profile file, HPjmeter can calculate
the thread profile data for the entire application.

Controls the depth of the stack trace for each stack trace taken.depth=size

• Increasing this value will make the profile data file larger, but it
enables HPjmeter to better estimate inclusive method times and
generate more complete call graphs.

• If you measure application performance by sampling, the default
value of 4 is too small for most applications; use values between 6
and 12.

This is the cut-off value for printing the list of methods with their exclusive
times or object allocation sites.

cutoff=value

• Decreasing this value will make the profile data file slightly larger,
but it enables HPjmeter to produce more complete call graphs or
heap metrics.

• Use a value of 0 for all applications.

HPjmeter displays both ASCII and binary format of the profile file.

NOTE: Note that hprof does not list method arguments. In effect, all
overloaded methods are represented as just one method.

format=a ,format=b

Naming Profile Data Files
Table 5 shows the default file types HPjmeter uses when saving profile data files. You may want
to follow this convention when naming profile data files, but it is not required.

Table 5 Default File Name Suffixes for Profile Data

File Name SuffixProfiling Option

.eprof-Xeprof

.hprof.txt-agentlib:hprof

For other file suffixes recognized by HPjmeter, see Naming Monitoring Data Files (page 49)
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Profiling with jmap
Java 6.0 on HP-UX introduced a new tool, jmap, in the JDK. (Note that Sun Microsystems added
jmap in Java 5, but it did not ship with HP-UX until Java 6.) The jmap tool can generate a Java
heap dump file for later analysis by HPjmeter. To generate a heap dump, use a command like the
following:
jmap –dump:format=b,file=heapdump.hprof <pid>

You can now open the heapdump.hprof file in the HPjmeter console. You can obtain the pid
for a Java application using the jps command.

–Xeprof and –agentlib:hprof Profiling Options and Their Corresponding
Metrics

Table 6 lists the metrics or features available with each of the two profiling options used for collecting
data. An * (asterisk) after a metric means it is a combination of one or more measures. N/A (not
applicable) means the option is irrelevant to the particular feature.

Table 6 Available Metrics or Features from -Xeprof and -agentlib:hprof Data

-agentlib:hprof-XeprofFeature

heap=sitesheap=dumpcpu=timescpu=samples

N/AN/AYes2NoYesMethod Call Count (page 163)

N/AN/AYes 1Yes 1YesExclusive Method Times (CPU)
(page 164)

N/AN/ANoNoYesExclusive Method Clock Times
(page 164)

N/AN/AYes 2NoYesCall Graph Tree with Call
Count (page 165)

N/AN/ANoNoYesCall Graph Tree with Clock
Time (page 165)

N/AN/AYes 1,2Yes 1,2YesCall Graph Tree with CPU
(page 165)

N/AN/AYes 1,2Yes 1,2YesInclusive Method CPU Times
(page 165)

N/AN/ANoNoYesInclusive Method Clock Times
(page 165)

Yes 3Yes 3Yes 3Yes 3YesThreads/Groups Histogram

YesNoYes 2N/AYes 2,4Objects Created by Method
(page 168)

YesNoYes 2N/AYes 2,4Created Objects (Count)
(page 168)

YesNoN/AN/ANoCreated Objects (Bytes)
(page 168)

NoYesN/AN/ANoLive Objects (Count)
(page 169)

NoYesN/AN/ANoLive Objects (Bytes) (page 169)

NoYesN/AN/ANoLive Array Sizes (page 169)

NoYesNoNoNoUnfinalized Objects
(page 169)
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Table 6 Available Metrics or Features from -Xeprof and -agentlib:hprof Data (continued)

-agentlib:hprof-XeprofFeature

heap=sitesheap=dumpcpu=timescpu=samples

NoYesN/AN/ANoReference Graph Tree
(page 169)

NoYesN/AN/ANoReference Sub-Trees by Size
(page 170)

NoYesNoNoNoClass Loaders (page 173)

YesYesN/AN/ANoResidual Objects (Count)
(page 175)

YesYesN/AN/ANoResidual Objects (Bytes)
(page 175)

N/AN/ANoNoYesContested Lock Claims by
Method (page 178)

N/AN/ANoNoYesAll Lock Claims by Method
(page 178)

N/AN/ANoNoYesLock Delay - Method Exclusive
(page 178)

N/AN/ANoNoYesLock Delay - Call Graph Tree
(page 178)

N/AN/ANoNoYesLock Delay - Method Inclusive
(page 178)

N/AN/AYes 1,2NoYesAverage Exclusive Method
CPU Times* (page 166)

N/AN/ANoNoYesAverage Exclusive Method
Clock Times* (page 166)

N/AN/AYes 1,2NoYesAverage Inclusive Method
CPU Times* (page 166)

N/AN/ANoNoYesAverage Inclusive Method
Clock Times* (page 166)

N/AN/ANoNoYesStarvation by Method*
(page 166)

N/AN/ANoNoYesStarvation Ratio* (page 167)

N/AN/AYesNoYesMethods with Loops*
(page 167)2

N/AN/ANoNoYesLock Contention Ratio by
Method* (page 179)

N/AN/ANoNoYesAverage Exclusive Method
Lock Delay* (page 179)

N/AN/ANoNoYesExclusive Method Lock Delay
/ Clock Time* (page 179)

N/AN/ANoNoYesAverage Inclusive Method
Lock Delay* (page 179)

N/AN/ANoNoYesInclusive Method Lock Delay
/ Clock Time* (page 179)

N/AN/AYes 1Yes 1YesExclusive Class CPU Times*
(page 167)
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Table 6 Available Metrics or Features from -Xeprof and -agentlib:hprof Data (continued)

-agentlib:hprof-XeprofFeature

heap=sitesheap=dumpcpu=timescpu=samples

N/AN/ANoNoYesExclusive Class Clock Times*
(page 168)

N/AN/ANoNoYesExclusive Class Lock Delay*
(page 179)

N/AN/AYesNoYesInline Candidates (page 180)
heuristics

N/AN/AYesNoYesExceptions Thrown (page 180)
heuristics

NoYesN/AN/ANoMemory Leaks (page 180)
heuristics

YesYesYesN/AYes 4Allocation sites for objects

Yes 3N/AYes 3Yes 3YesPer-thread or per-thread-group
view

N/AN/ANoNoYesProfiling intrusion
compensation

1 Virtual CPU times, unless on HP-UX; some platforms report clock times
2 Metric values estimated only
3 Requires thread=y (no color-coding or start/stop times available for threads)
4 Requires inlining=disable or running the VM in interpreted mode

See also:
• Profiling with -Xeprof (page 72)
• Profiling with -agentlib:hprof (page 76)

Approaches to Analyzing Performance Data
The metrics you choose to view depend on your application domain, your code, the demands for
the application, and the operating environment. Look at all of the available ones, and analyze at
least a few of the topmost entries.
Whenever possible, the console visualizers present all metrics sorted in decreasing order of resources
used. This places the largest resource users at the top of the screen. Evaluate them knowing your
application and its characteristics. Use your intuition. If you find anything that you cannot explain,
take the time to investigate and find the cause. A high level of resource consumption may be
legitimate, but it can also be an indication of a performance bottleneck.

Looking at the Data from the Bottom Up
One approach to performance analysis is the bottom-up technique. It can be used even if you are
not very familiar with the application. Look at the following metrics, if available:

• Method Call Count
• Exclusive Method CPU Time
• Exclusive Method Clock Time
If you find a method, or a few methods that consume much time, they can become a target for
your performance tuning. Similarly, if a method is called excessively many times, check to see if
you can reduce the number of calls.
This will often require investigating the invocation context for the method in question. Mark the
method , and find it later in the corresponding call graph. (See Using Call Graph Trees (page 89)).
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Looking at the Data from the Top Down
An alternative, top-down approach to profile data analysis is to start from the call graph based
on Clock or CPU time and continue expanding the topmost nodes until you find a method or multiple
methods that implement high-level operations characteristic for your application (that is, are
responsible for transaction processing). By expanding this node you can see how this high-level
operation splits its work among the methods it calls. If your intuition tells you that the numbers do
not look appropriate or correct, continue expanding the nodes that consume too much time to find
the reason for the anomaly.

Looking for Inefficiencies in Memory Usage
Large applications put a lot of stress on all components of the computing system. One strategy for
understanding the behavior of your application is to look at how well the application is working
within the boundaries set for heap size and the selected garbage collection type in use by the
JVM. Adjusting heap size and garbage collection type can improve memory usage and work
efficiency when adjusted to the demands of a particular application. For a view of memory usage
and object metrics, see Profile Memory and/or Heap Activity (page 168). See Analyzing Garbage
Collection Data (page 94) to obtain a detailed view of the impact of GC activity on the system.
Operating system performance, third-party software performance, the bandwidth of the I/O
subsystem, and so on, all affect application performance. Analyzing these factors is beyond the
scope of this tool, but it should always remain on your agenda.

Considerations in Interpreting the Data
What information can be gleaned from various metrics depends on how the values are calculated.
Use this section to understand the meaning of the performance measures used by HPjmeter.

Inclusive Versus Exclusive Time
Exclusive time is the accumulated total time used by a method, but not including the time used by
the methods that were called from it.
Inclusive time is the accumulated total time used by all invocations of the method and all methods
that were called from it directly or indirectly. Inclusive times are useful if you want to see the cost
of a particular task performed by the application, and you can associate this task with a single
method.
However, for recursive methods, the inclusive times may not correspond well to your intuition.
When a given method calls itself directly or indirectly, the time spent in the topmost invocation of
the method is accumulated (for the purpose of inclusive times) for all active invocations of this
method. The inclusive times depend not only on the amount of work done by the method, but also
on the depth of recursion, and thus have limited value. The exclusive times for recursive methods
do not exhibit this anomaly.
Most profilers collect either the inclusive time or the exclusive time, but not both. Exclusive times
can be easily calculated from the inclusive times and the call graph information. However, converting
the times in the opposite direction usually cannot be done with 100% certainty. When a console
visualizer displays inclusive times calculated from the exclusive times, it appends “(data estimated)”
to the metric title.

Time Units
Generally, all times are expressed in some abstract time unit. The actual time units in the metrics
depend on the profiler agent used to generate the profile data and are beyond control of HPjmeter.
However, the actual time units are rarely needed to locate performance bottlenecks. Furthermore,
even though in most cases the execution times are measured by the profiler agent in milliseconds,
the profiler's intrusion can distort these times so much that the direct correspondence between the
measured time and the actual application speed (when run without profiling) is lost.
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CPU Versus Clock Time
The clock time is the time as measured by an external independent clock, sometimes also called
wall clock. Clock time includes the time that passes for any state that a thread may be in. That is,
clock time includes the time the thread spends in sleeping, waiting, performing an I/O operation,
waiting for garbage collection to complete, being preempted by the operating system, and in
processing.
CPU time accounts for the time spent by any of the CPUs (processors) on executing a thread. Other
thread states are not counted in CPU time.
A so-called virtual CPU time, usually collected by sampling, is similar to CPU time, but includes
time elapsed while the thread was ready to run, but was not actually scheduled to run by a CPU,
for example, while the thread was preempted. Depending on the platform, virtual CPU time can
also include the time spent in I/O operations.
If the profile data file contains the information about the profiling overhead, HPjmeter adjusts the
measured CPU times by subtracting the time spent by the profiler. Thus, reported times match more
closely those actually used by the Java application.
To inform you about the increased accuracy, a console visualizer will show “times in milliseconds,
adjusted for profiling intrusion)” next to the metric label if the adjustment took place.

Locating Summary Information for Saved Data Sets
Summary data is displayed on the first tab that you encounter when you open a profiling data set
for viewing. This information includes when the application data was collected and for how long,
and a few application conditions present during the collection time.
Related Topics

• Viewing Profiling or GC Data in HPjmeter (page 160)
• Understanding the Summary Presentation of GC Data (page 105)

Adjusting Scope
The console can display metrics for the whole application, for a single thread, or for a single thread
group, provided the profile data has been appropriately collected. These three sectors of analysis
are called scopes.
To change the current scope, do the following.
1. If you do not have a profiling viewer open, double-click on a data representation in the main

console pane.
This opens a profiling viewer. You can see the Scope menu in the menu bar of the viewer.
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2. Click the Scope menu name to see the scope options. By default, Process scope is selected.
3. Note that if you mark an item in a profiling viewer and then switch scope, the “find immediate”

action is automatically executed. If you want to disable this default action before switching
scope, uncheck the Automatic find immediately menu item.

4. Select the scope that you want. The scope change is immediately applied to the data displayed
in the visualizers appearing in the open viewer.

5. View available metrics by clicking the tabs or by selecting new items from the Metrics or
Estimate menus.
The following image shows a metric for which “Thread” scope has been set. The slider allows
you to expand and contract the two views (method call count and associated threads).
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Comparing Profiling Data Files
It can be useful to compare session data in order to understand the effect of differences in activity
at different times of day, week, or month. Comparisons can be especially useful when running
performance testing benchmarks. (See Preparing a Benchmark (page 71).)
To compare data files, do the following:
1. From the main console, open two data files of the same type that you want to compare.
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A viewer will open for each data representation (see Using HPjmeter to Analyze Profiling Data
(page 39) for an example profiling viewer).

2. Click on one of the viewers to make it active.
3. Two ways exist to create a combined set of comparable data:

• In one viewer, click File→Compare , or
• click the Compare button .
The Compare window opens, and you can now see the other file to compare your first file
against.

4. Click the file name that you want to compare against.

5. When the file is highlighted, click the Compare button.
A new profile viewer opens that presents the selected data sets in comparison to one another.

NOTE: For alternate access when you have multiple viewers open, click the button to bring the
console to the top. The console lists all open sessions and data sets. For data sets, click the data
representation to bring the already open viewer to the top.
If the viewer has been closed, but the data representation is still listed in the console, double-clicking
the data representation opens a new viewer.

Scaling Comparison Data
At times it is not possible to run performance testing benchmarks under identical conditions. For
example, the load may be slightly different, or the measurement duration may differ, or you may
want to compare the same activity at different times of the day or week. To compensate for these
differences, you can scale one set of data to more closely match the other set.
Scale and Scale Special are available from the Edit menu on the profiling viewer when comparing
two profiling data files. Use these scale options when the data files that you are comparing are
unequal in some way.
For example, imagine a scenario where you are able to generate a constant load on your systems,
but one profile represents 10 minutes of application activity and the other only 5 minutes. You can
use Edit →Scale Special to set and apply a factor of 2 to the shorter time period, which normalizes
the 5–minute data set to 10 minutes for easier presentation and interpretation.
Or, suppose that you want to look at activity for a particular application during peak business
hours and compare it to a relatively quiet period at night. You know that the number of transactions
will differ, so how do you compare the amount of work done for each transaction?
Open a profiling viewer with the peak time data. Open another viewer with the night data. In the
peak time viewer, click File→Compare to open a profiling viewer with the comparison data.
In the comparison viewer, select Metrics→Code/CPU→Method Call Count. Click to select a known
method that represents a unit of work or a transaction. Then click Edit →Scale from the menu bar.
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HPjmeter automatically recalculates the call count for each method in the peak data with the result
that each value is normalized to the ratio of the call counts for the selected method.
HPjmeter then sorts the data. By viewing the information that appears in the newly sorted list, you
can compare differences in activity between the two data files. If you want to see how this works
in detail, select View→Show Formula to display the calculations that HPjmeter uses.

Reading Profiling Histograms
There are two kinds of histograms available:
• Threads Histogram. A presentation of all threads created by the application.

The horizontal bars represent the lifetime of the threads, with respect to the lifetime of the
whole application.

• Thread Groups Histogram. A presentation of all thread groups created by the application.
The horizontal bars represent the lifetime of the thread groups, with respect to the lifetime of
the whole application. The lifetime of the thread group is defined as the time span between
the creation of the first thread belonging to the group and the death of the last thread belonging
to the group.

Not all profile data files contain information about the times when the threads are created and
terminated. If such information is unavailable, the metric header will contain “times not to scale)”
meaning that only the order of the threads creation and termination events are shown.
If the profile data contains adequate information, the bars are displayed using colors describing
thread states; otherwise the bars are gray. There are a few coloring schemas used by HPjmeter,
depending on the profiling option and platform used. You can double click on the thread (or thread
group) bar to pop up the thread spectrum.
The next section presents a detailed description of the reported thread states.

Key to Thread States Reported by
-Xeprof

The image in the next figure presents a sample thread spectrum. A thread spectrum is obtained
when you double-click the thread name in a threads histogram.

Figure 15 Pie Chart Showing Percent Time Spent in Various States for a Given Thread

The values are shown as the percentage of the total thread lifetime (i.e., the clock time elapsed
between the thread creation and the thread completion).
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Table 7 Key to Default Color Representation of Thread States in Histograms

Lock Contention. Time wasted trying to acquire a Java lock while it was acquired by another thread.
More precisely, it is the summary time measured from the moment the thread requests a Java lock
until the lock is actually granted.

CPU. Time spent running on any of the computer's processors. This includes Java code, the native
code (if any), and the time spent in the virtual machine by this thread. If there's no Profiler Overhead
state listed in the legend, the CPU time consumed by the profiler is also included.

Profile Overhead. Estimated time used by the profiler to collect the profile data. In most cases, the
profiler overhead is proportional to the CPU time spent in Java, but also depends on the frequency
of Java method calls. This state will not be shown if the profile data file does not contain the profiler
overhead data.

I/O. Time spent while executing a synchronous input or output operation called directly from Java
code, using one of the standard library classes. This includes all types of I/O, in particular the network
(socket) operations.

Sleeping. Time spent while the thread was suspended by the java.lang.Thread.sleep method.

Waiting. Time spent while the thread was suspended by the  java.lang.Object.wait method.

Native Idle. Non-CPU-consuming time spent while the thread was in a non-Java code (i.e., using
JNI). The thread could be sleeping, running a non-Java I/O operation, waiting for a child process
or being suspended by the OS for a similar reason. HPjmeter is not able to identify the exact state
of the thread in such circumstances, since the native code remains unprofiled, and the amount of
time spent in this state is always estimated.

Garbage Collection. Time spent while the thread was suspended by the virtual machine because
the (non-concurrent) garbage collector needed to run. If there are many running threads, and the
garbage collection pauses are short, this time may be larger than the actual time spent in the garbage
collector. This is because all threads must be suspended before the garbage collection may start.

Unknown. The thread state could not be determined. If the lifetime of the thread was extremely short,
HPjmeter may not be able to show any other states but Unknown.

Starvation. The time wasted while the thread was theoretically able to run (was in the “runnable”
state), but actually did not run. The reasons for starvation can be within the Java VM or within the
operating system. Most typical situations resulting in starvation are listed below:
• A traditional, non-concurrent garbage collector was running (only if the specific Garbage Collection

state is not listed) at that time.
• There were more threads ready to run (within all applications present in the system) than the

number of available CPUs.
• The operating system (for example, virtual memory) overhead or failure to schedule the threads

“fairly”
• Virtual machine operations, such as class loading, or method de-optimization.

See also: Change Color Selection for Histogram Display (page 210)
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Interpreting the Histogram Presentation
You can assess the scalability of the application from the spectrum of a typical “working” thread
from your application.

• A large amount of lock contention (red) indicates that scalability will be a problem. You need
to change the inter-thread communication mechanism to reduce the lock contention.

• A large amount of waiting (green) may indicate that the load on the application can be
increased. This is because in a typical server application the threads use the Java wait method
to wait for the data to process.

• A large amount of starvation (white) indicates that the ratio of the active threads to the number
of CPUs is too large. You can probably decrease the number of threads without negatively
affecting the performance or throughput.

TIP: To best view the relative amount of starvation for a particular thread, highlight the thread
by clicking on it once, or double-click to reveal the thread pie chart for that thread. Starvation
is represented by the “empty” slice of the pie.

NOTE: Be careful when analyzing the spectrum of a thread group. A thread group may contain
several threads with completely different roles within the application. Mixing them up and analyzing
just the summary may make little sense. User-defined thread groups that contain only carefully
selected threads (usually sharing the same code) are well suited for spectrum analysis.

See also Thread Histogram (page 152)

Using Call Graph Trees
The call graph trees are used to represent metrics based on graphs. There are four metrics based
on the method call graph (showing CPU Time, Clock Time, Call Count, and Lock Delay), and two
based on object references (Reference Graph and Reference Sub-Trees by Size).
You can expand or collapse any non-leaf node by clicking on the small square on the left side of
each node.
A consequence of representing a graph in the tree form is that the same graph node can be
displayed many times within the tree (showing different paths in the graph). Special color coding
of the nodes helps you to navigate the tree. Five colors are used:

Table 8 Key to Color Coding of Call Graph Nodes

Leaf. Leaf nodes, written in black, represent methods that did not call any other methods or
objects that do not keep any references to other objects. Leaf nodes cannot be expanded or
collapsed.

Expanded. After expansion the node will be shown using gray.

Expanded Elsewhere. A tree node that is already expanded elsewhere in the tree will be
shown in red.
It is possible to expand this node if you want to do so. The information shown will be identical
to that already displayed where the node is expanded. You may find that expanding the
same graph node in more than one place makes the tree less manageable.

Visited. A node that you have expanded and then collapsed is called a visited node. It is
shown in a different color (purple) to remind you that you have already looked at the contents
of this node.

Regular. All other non-leaf nodes that have not been visited are presented in blue.

See the figure below for examples.
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Interpreting Call Graph Data
In the trees that are based on the call graph, the nodes represent methods and the arcs represent
cumulative calls from the preceding node.

• For CPU and Clock trees, the numerical values represent the time used by the arc. That is, the
numerical values represent the inclusive time used by all invocations represented by the arc.
The numbers in parentheses indicate what percentage of the total inclusive time used by the
method was caused by the calls from the preceding node. By default, the arcs with numerical
values less than 50 are not shown.

• For a Call Count tree, the numerical values represent the number of calls made to the method
from the preceding node (the caller). The percentage numbers represent the ratio of calls from
the caller to the number of all calls to this method from all callers. It may be non-intuitive to
traverse this graph if you get used to the call graphs representing time. This is because below
a low number of calls—for example, 1—a very large number of further calls can be hidden.

In cases when there is more than one caller of a method, the number of other callers is also given.

Example of Node Color Display
It is best to explain the meaning of the numbers in a tree in an example. Here's a snippet from a
Call Graph Tree with times:

Figure 16 Multiple Nodes Exposed in Call Graph Tree Display Showing Visitation Color Coding

In the picture above, you can see that run was the only caller of sleepPerTab. The inclusive
time for all calls to sleepPerTab was 6,883,833 time units. Lower down, you can see that
sleepPerTab used 2,966 time units on calls to setValue , which represents 97% of the total
inclusive time used by this method. The remaining 3% of time used by setValue was caused by
calls from the remaining callers (three other callers in this case).
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NOTE: Inclusive times include the time spent in called methods. Therefore, for recursive calls, the
same time is accumulated many times, depending on the depth of the recursion. When this happens,
a recursive method may show an inclusive time that is greater than the inclusive time shown for its
parent method.

TIP: To see the list of all callers of a given method, double-click on the method name.

The line showing repaint is marked in red. This is because a node showing this method is already
expanded elsewhere in the tree. Note that all recursive calls will appear in red (unless you expand
the red node), but not all red nodes indicate a recursive call!

Options for Manipulating the Call Tree Display
You have several options for adjusting the display to better reveal the data that you want to see.

Tree Pruning
For the trees showing time, arcs with values of less than 50 are not shown by default to avoid
cluttering the display with arcs that are not essential for locating performance bottleneck. However,
because the time units are generally abstract, and because your application may have run
exceptionally long (or briefly), this threshold (cut-off value) can be modified. Use Tree→Prune to
change the cut-off value.
You'll have a choice of changing the value just for the current tree, or changing the default. The
latter will be valid for all windows, but will not affect the trees that are already displayed.
Another form of pruning is available for the Object Reference Graph. To keep the size of the
displayed data manageable, references can be only partially represented on the screen. The
pruning mechanism controls the maximum number of references from each object that will be
shown.

Auto-Expanding the Call Tree
Quite often the tree nodes that you would like to work with are deep in the tree. To see them, you
need to expand the entire call chain leading from the root to the nodes of interest. To assist in this
task, and to help locate the nodes that are good candidates for analysis in the top-down approach,
use the Tree→Auto Expand function that automatically expands the tree and selects the nodes that
seem to correspond to complex high-level operations.
Naturally, the tool's choice may be incorrect. In any case, your analysis should not end at the
nodes selected for you by HPjmeter.

Using Sub-Trees
Excessive expansion of the tree makes the display hard to navigate. It also slows down scrolling.
You can get rid of the usually uninteresting, higher layers of the tree by selecting one or more
nodes and then executing Tree→Set As Root(s). This will replace the current roots of the displayed
tree with the selected nodes. You can repeat this command more than once, if necessary.
To restore the original tree, use Tree→Restore Roots.
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Searching the Trees
The search functions work in trees basically the same way they work for other metrics, but there
are a few special considerations for searching call graph trees.

• Occasionally, not all nodes found in a search will be accessible (visible). You'll be notified
about such situations in the status bar at the bottom of the window. A node will be inaccessible:

◦ if no path exists from the root to the node using only arcs with values above the current
cut-off value (see Tree Pruning (page 91)), or

◦ if no path exists from the root to the node at all. This can happen when you change the
roots of the tree (see Using Sub-Trees (page 91)).

• After a search, all found accessible nodes can be made visible by expanding the tree to show
the nodes. Occasionally, if the search yielded many results, this creates a tree that is too large
to be conveniently navigated, even if you use the Find Next Selected command.
You may then want to use Tree→Collapse All to fold down the tree alternately with Find Next
Selected. This will expand the tree to show only the current node, rather than all selected
nodes.

• The trees showing different metrics may expand differently, even if the same node is
found.

◦

◦ For trees with time, the tree expands along the path from the root that shows the maximum
time (more precisely, the path that maximizes the minimum arc time existing in the path).

◦ The tree with call counts expands showing the callers that made the most calls to the
found node and, recursively, its selected caller.

◦ Finally, the object reference tree expands showing the shortest path from the root to the
found node.

Using Heuristics to Locate Possible Hot Spots
HPjmeter uses heuristic algorithms to help you locate some of the application's hot spots. Remember
that these are only hints - nothing can replace your in-depth analysis of the application.
You can locate the heuristic displays in the Estimate menu. They include: Inline Candidates,
Exceptions Thrown, and Memory Leaks.
Candidates for inlining are those methods that were called many times and seem to have relatively
short and simple code. HPjmeter cannot see the source or object code for the methods, so it makes
a guess. It is up to you to check if the inlining makes sense and will actually improve the
performance.
The profile data does not contain any information about the thrown exceptions. However, HPjmeter
assumes than whenever an exception object was created, the application did so with the intention
of throwing this exception.
Although the profile data does not contain information about created exception objects either,
HPjmeter looks for invocations of methods that look like exception initializers. It is up to you to
check if the found methods really create exception objects, and that the created exception objects
are actually thrown.
The term “memory leaks” is not technically correct, for Java has automatic memory management.
By this term we mean the objects that are held unintentionally in memory because other objects
keep references to them. This is usually caused by careless programming.
A heuristic approach to detecting “memory leaks” is difficult, because it is next to impossible to
guess a programmer's intentions. HPjmeter tries to locate objects with the following property: the
object is kept “alive” by a single reference, and removing this reference would entail freeing (i.e.,
garbage-collecting) a substantial amount of bytes. The list of such objects is presented along with
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the number of bytes that would be reclaimed. It is up to you to check if the presented objects are
still needed by the application, and how the critical references should be removed.
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6 Analyzing Garbage Collection Data
HPjmeter allows you to process garbage collection (GC) data from Java virtual machines.
Separating the GC data collection step from the analysis step has the following advantages:

• The data analysis can be done at a different time and on a different platform than was used
to run the application. For example, it can be done on a desktop system or on a laptop.

• A non-interactive agent will often impose less overhead than an interactive one.

• The data files obtained naturally facilitate comparison of different runs or creation of a history
of performance improvements.

For detailed analysis of the efficiency of garbage collection, it is useful to take a close look at
garbage collection patterns. A study of patterns of garbage collection can help you determine
whether or not the best GC type and heap size are being applied appropriately during the
application run. You can also use detailed GC data to uncover problems in the application
programming.
With the collection of verbose GC data, HPjmeter is able to present extensive details about the
memory usage and garbage collection (GC) exhibited when an application is running. Details are
presented in a data summary and in graphic visualizers that can be adjusted to focus on particular
aspects of the data.

Obtaining Garbage Collection Data
The -Xverbosegc option, available for the HP-UX HotSpot™ VM, was specifically designed to
produce ASCII garbage collection data files for in-depth analysis using HPjmeter.
-Xloggc can be useful for quick comparison of garbage collection behavior across different
platforms.
The GC viewer automatically opens when you open an Xverbosegc or Xloggc file from the HPjmeter
console.

Data Collection with -Xverbosegc
-Xverbosegc produces detailed information about the performance of individual garbage
collector types for the entire Java application.
To run your application with an option to capture the garbage collection information, use the
following command:
$ java ... -Xverbosegc[0|1][:file=[stdout|stderr|filename[,[n][h][d][u][t]]]]

The following table lists examples of supported -Xverbosegc options for capturing garbage
collection data. This table provides information for Java 1.5.0.04. Other versions may differ from
this. HPjmeter correctly presents and labels collected data based on the Java version running with
the application. To see the complete list of available options for the Java version you are running,
use
$ java ... -Xverbosegc:help 

To see the availability of HPjmeter metrics from -Xverbosegc data collection, see -Xverbosegc
and -Xloggc Options and Their Corresponding Metrics (page 101).

Table 9 Supported -Xverbosegc options for Java 1.5.0.04

0|1 0 prints after every old generation garbage collection or after a full GC.
1 prints after every garbage collection (default).

:file=[stdout|stderr|filename] stderr (default) directs output to standard error stream.
stdout directs output to standard output stream.
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Table 9 Supported -Xverbosegc options for Java 1.5.0.04 (continued)

filename writes output to the specified file.

[n][h][d][u][t] n prevents appending the pid to the log filename.
h appends the hostname to the log file name.
u appends the username to the log file name.
d appends the date to the log file name.
t appends the time to the log file name.

At every selected garbage collection, the following 20 fields are printed. These values hold true
for Java 1.5.0.04. Other versions may differ. To see the complete list of available fields for the
Java version you are running, use
java ... -Xverbosegc:help

Table 10 Fields Captured in GC Log Data When Using -Xverbosegc print options

Type of garbage collection.
1 = scavenge (of new generation only)

%1

2 = old generation GC or full GC
3 = complete background, concurrent mark and sweep (CMS) GC
4 = incomplete background, concurrent mark and sweep GC
5 = Evacuation Pause in G1
6 = Complete G1 Concurrent Mark Cycle
7 = Incomplete G1 Concurrent Mark Cycle
11 = Ongoing CMS GC
12 = Ongoing G1 Concurrent Mark Cycle

This value varies depending on the value of %1.%2

• When %1 is equal to 1, %2 indicates whether or not a parallel scavenge occurred. Possible values are:

0: non-parallel scavenge◦
◦ n(>0): parallel scavenge with n number of parallel GC threads

• When %1 is equal to 2, %2 indicates that an old generation GC or full GC has occurred. Reasons for the GC
are given as:

◦ 1: Allocation failure, followed by a failed scavenge, leading to a full GC

◦ 2: Call to System.gc made

◦ 3: Tenured generation is full

◦ 4: Permanent generation is full

◦ 5: Scavenge followed by a train collection

◦ 6: Concurrent-Mark-Sweep (CMS) generation is full

◦ 7: Old generation expanded on last scavenge

◦ 8: Old generation too full to scavenge

◦ 9: FullGCAlot

◦ 10: Allocation profiler triggered

◦ 11: JVMTI-forced garbage collection

◦ 12: Adaptive size policy
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Table 10 Fields Captured in GC Log Data When Using -Xverbosegc print options (continued)

◦ 13: Last ditch collection

◦ 14: GC Locker-Initiated GC

◦ 15: Heap Dump Triggered GC (HP implementation)

◦ 16: Heap Dump Triggered GC

◦ 17: Heap Inspection Initiated GC

• When %1 is equal to 3, %2 indicates that a complete background, concurrent mark and sweep GC has
occurred. Reasons for the GC are given as:

◦ 1: Occupancy > initiating occupancy

◦ 2: Expanded recently

◦ 3: Incremental collection will fail

◦ 4: Linear allocation will fail

◦ 5: Anticipated promotion

◦ 6: Incremental CMS garbage collection

• When %1 is equal to 4, %2 indicates that an incomplete background, concurrent mark and sweep GC has
occurred as a result of exiting after yielding to foreground GC. The form for this data set is given as n.m
where n is the GC reason as follows:

◦ 1: Occupancy > initiating occupancy

◦ 2: Expanded recently

◦ 3: Incremental collection will fail

◦ 4: Linear allocation will fail

◦ 5: Anticipated promotion

◦ 6: Incremental CMS garbage collection

and m indicates the background CMS state when yielding, as follows:

◦ 0: Resetting

◦ 1: Idling

◦ 2: Initial marking

◦ 3: Marking

◦ 4: Final marking

◦ 5: Pre-cleaning

◦ 6: Sweeping

◦ 7: Resizing

◦ 8 Abortable pre-cleaning
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Table 10 Fields Captured in GC Log Data When Using -Xverbosegc print options (continued)

• When %1 is equal to 5, %2 the G1 sub-type and whether there was a G1 initial mark. The form for this data
set is given as n.m where n indicates young or mixed GC, as follows:

◦ 0: young GC

◦ 1: mixed GC

and m indicates whether it contains initial-mark, as follows:

◦ 0: no initial-mark

◦ 1: contains initial-mark

◦
• When %1 is equal to 6%2 indicates that a complete background G1 concurrent mark cycle has occurred.

Reasons for the GC are given as:

◦ 1: Occupancy > InitiatingHeapOccupancy

◦ 2: GCLocker and option GCLockerInvokesConcurrentis true

◦ 3: Explicit gc and option ExplicitGCInvokesConcurrent is true

◦ 4: G1 humongous allocation caused concurrent mark cycle

◦ When %1 is equal to 7, %2 indicates that an incomplete background, garbage first concurrent mark cycle
has occurred. The form for this data set is given as n.m where n is the GC reason as follows:
– 1: Occupancy > InitiatingHeapOccupancy

– 2: GCLocker and option GCLockerInvokesConcurrent is true

– 3: Explicit gc and ExplicitGCInvokesConcurrent is true

– 4: G1 humongous allocation caused concurrent mark cycle

and m indicates the background G1 state when yielding, as follows:

◦ 0: Idling

◦ 1: RootScanning

◦ 2: Marking

◦ 3: Remarking

◦ 4: Cleanup

◦
• When %1 is equal to 11, %2 indicates the stop-the-world phase of CMS GC, as follows:

◦ 2: Initial marking (first stop-the-world phase)

◦ 4: Final marking (second stop–the-world phase)

• When %1 is equal to 12, %2 indicates the stop-the-world phase of G1 GC, as follows:

◦ 3: Remarking (first stop-the-world phase)

◦ 4: Cleanup (second stop–the-world phase)

Program time at the beginning of the collection, in seconds%3

Garbage collection invocation. Counts of background CMS garbage collections and other garbage collections
are maintained separately

%4

Size of the object allocation request that forced the GC, in bytes%5
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Table 10 Fields Captured in GC Log Data When Using -Xverbosegc print options (continued)

Tenuring threshold - memory allocation that determines how long newborn objects remain in the new generation.%6

Eden sub-space within the new generation, in bytes.These spaces are reported:%7,
%8,
%9

• Before (Occupied before garbage collection)
• After (Occupied after garbage collection)
• Capacity (Current capacity )

Survivor sub-space within the new generation, in bytes. These spaces are reported:%10,
%11,
%12

• Before

• After

• Capacity

Old generation, in bytes. These spaces are reported:%13,
%14,
%15

• Before

• After

• Capacity

Permanent generation, in bytes. These spaces are reported for storage of reflective objects:%16,
%17,
%18

• Before

• After

• Capacity

Total stop-the-world duration, in seconds.%19

Total time used in collection, in seconds.%20

Collecting Allocation Site Statistics for Viewing in HPjmeter
Use one of the following commands to capture allocation site statistics in a file for display in the
HPjmeter garbage collection viewer:
• Using -XX:+PrintAllocStatistics option to enable the Allocation Statistics function

by entering the following:
$ java ... -XX:+PrintAllocStatistics -Xverbosegc[0|1][:file=[filename[,[n][h][d][u][t]]]]

• Sending a signal to the JVM to capture allocation site statistics data at that time:
$ kill -PROF pid

OR
$ kill -21 pid

Data from the opened file is visible in the Allocation Site Statistics (page 185) visualizers. The GC
viewer automatically opens when you open an Xverbosegc file in the HPjmeter console.

Collecting Glance Data for Viewing in HPjmeter
If you have the HP GlancePlus product installed on your HP-UX system, you can run GlancePlus in
adviser mode using the script at /opt/hpjmeter/bin/javaGlanceAdviser.ksh. This script
has three command-line parameters: the pid of the Java process for which you want to collect data,
the name of the output file to receive the data, and the sampling interval, in seconds. Only the first
parameter is required, the second and third are optional. Here is a sample command line to capture
Glance data in a file for display in the HPjmeter garbage collection viewer:
$ /opt/hpjmeter/bin/javaGlanceAdviser.ksh 1234 ga.out.1234

This command collects information about process 1234 using the default sampling interval, and
writes the results to the file ga.out.1234. You can then open this file in the HPjmeter console to
view the data graphically. If you also collected GC information using the -Xverbosegc option,
you can append the Glance data to the GC log file and then use HPjmeter to read the combined
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file. Collecting both the Glance data and the GC data at the same time is very useful because you
can view all the data together in one HPjmeter console.
Data from the opened file is visible in the Glance Data (page 194) visualizer, accessible from the
Glance Adviser tab on the GC visualizer. Glance system call data is obtained from the
PROC_SYSCALL loop in Glance Plus, and is visible in the Glance System Call Data (page 198)
visualizer, accessible from the Glance System Call tab on the GC visualizer.

Collecting GC Data with Zero Preparation
Zero preparation GC data collection is a feature in the HP JDK/JRE 5.0.14 and later, 6.0.02 and
later and 7.0.00 and later. It is started from the command line by sending a signal to the JVM to
start GC data collection.
To collect GC data without interrupting an already running application, do the following from the
command line:
1. Confirm that HP JDK/JRE 5.0.14 or later, or 6.0.02 or later or 7.0.00 or later is running the

application that you want to analyze, and that no -Xverbosegc or -Xloggc option has
already been specified.

2. Locate the process ID of the running Java application.
3. Start the profiling interval. Send a signal to the JVM by typing:

kill -PROF pid or kill -21 pid
The GC data will be written to a file named java_pid.vgc in the current directory of the
JVM process.
Let the collection generated by the JVM continue for the length of time that you think will be
meaningful.

4. Stop the data collection interval by sending the same signal to the JVM:
kill -PROF pid

You can now open the saved file in the HPjmeter console and view the collected metrics.

Time periods where no data is collected are shown in a light purple in all the GC graphic visualizers.
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Figure 17 Appearance of GC Data Collected in Intervals During a Session

NOTE: For the signal to be captured by the JVM, you must either be logged in as root, or you
must be the user who started the JVM.

Related Topics

• Using Specialized Garbage Collection Displays (page 181)

Data Collection with -Xloggc
-Xloggc directs a smaller set of data to a file than what is available with -Xverbosegc.
For every garbage collection, the following six fields are printed to the log file:
• Cumulative time since data collection began (in seconds)
• Garbage collection type
• Heap in use before the GC event
• Heap in use after the GC event
• Current maximum heap size
• Duration of the GC event
To capture basic -Xloggc data, use the following command:
   $ java ... -Xloggc:filename

More data are available if you start the JVM with the -XX:+PrintGCDetails or
-XX:+PrintHeapAtGC options. For example, you can type:
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$ java ... -XX:+PrintGCDetails -Xloggc:filename

Use these additional options to obtain more data on GC activity in the eden space, the survivor
space, the old generation, and the permanent generation.

NOTE:

Using -XX:+PrintGCDetails and -XX:+PrintHeapAtGC Together

Some JVMs improperly mix the output from these two options, resulting in a data file that cannot
be parsed properly by HPjmeter. We recommend using only one of the two options.
When using the G1 collector, HPjmeter 4.3 only supports the output from –XX:+UseG1GC, HPjmeter
does not support the combinations “–XX:+UseG1GC –XX:+PrintGCDetails” or
“-XX:+UseG1GC –XX:+PrintHeapAtGC”.

To see the availability in HPjmeter of metrics derived from -Xloggc data, see -Xverbosegc and
-Xloggc Options and Their Corresponding Metrics (page 101).

Naming GC Data Files
The following table shows the file name formats used by default when naming files containing
garbage collection data. You may want to follow this convention when naming GC data files, but
it is not required.

Table 11 Default File Name Suffixes for GC Data

File Name SuffixOption

.vgc-Xverbosegc

.vgc-Xloggc

-Xverbosegc and -Xloggc Options and Their Corresponding Metrics
The following metrics or features are available depending on the option used to collect data.

Table 12 Available Metrics from -Xverbosegc and -Xloggc Garbage Collection Data

-Xloggc-XverbosegcMetric

NoYesAllocation Site Statistics (page 185)†

YesYesHeap Usage After GC (page 181)

YesYesDuration (Stop the World) (page 182)

YesYesCumulative Allocation (page 183)

YesYesCreation Rate (page 184)

YesYesCumulative GC duration*

YesYesHeap usage before GC*

YesYesHeap capacity*

YesYesReclaimed bytes*

NoYesPromoted bytes*

YesYesPercentage of Time in GC*

† Requires the additional option -XX:+PrintAllocStatistics. See Collecting Allocation
Site Statistics for Viewing in HPjmeter (page 98) for an example of command syntax.
* You can create a graphical view of these metrics using the User-Defined X-Y Axes
visualizer (page 191). Other raw metrics are also available for graphing from this visualizer.
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See also:
• Data Collection with -Xverbosegc (page 94)
• Data Collection with -Xloggc (page 100)

Locating Summary Information for Saved Data Sets
Summary data is displayed on the first tab that you encounter when you open a GC data set for
viewing.
For -Xverbosegc data, an extensive summary is given for garbage collection findings, as well
as for the state of the system.
Related Topics

• Understanding the Summary Presentation of GC Data (page 105)

Comparing Garbage Collection Data Files
It can be useful to compare session data in order to understand the effect of differences in activity
at different times of day, week, or month. Comparisons can be especially useful when running
performance testing benchmarks. (See Preparing a Benchmark (page 71).)
To compare garbage collection data files, do the following:
1. From the main console, open two or more data files of the same type that you want to compare.

A viewer will open for each data representation (see Using HPjmeter to Analyze Garbage
Collection Data (page 41) for an example garbage collection viewer).

2. Click on one of the viewers to make it active.
3. Two ways exist to create a combined set of comparable data:

• In one viewer, click File→Compare , or
• click the Compare button .
The Compare window opens, and you can now see the other possible files to compare your
first file against.
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4. Click the file name that you want to compare against; or, if choosing more than one file, hold
the Ctrl key while selecting each desired file.

5. When the files are highlighted, click the Compare button.
A new viewer opens that presents the selected data sets in comparison to one another.

NOTE: For alternate access when you have multiple viewers open, click the button to bring the
console to the top. The console lists all open sessions and data sets. For data sets, click the data
representation to bring the already open viewer to the top.
If the viewer has been closed, but the data representation is still listed in the console, double-clicking
the data representation opens a new viewer.

Basic Garbage Collection Concepts
A basic principle behind the design of the garbage collector is that objects tend to be either
short-lived or else persist for the lifetime of an application run. By separating persistent objects
from short-lived objects and moving them to designated spaces, the garbage collector can free
memory for use by the application (improving efficiency of memory use), and avoid examining
every object each time a collection is done (reduce garbage collection overhead).
Through a system of identification and classification, an object ages each time it survives a garbage
collection event. After surviving a certain number of garbage collection events, the object is
considered old — at which point, it is moved from the young to the old area of the heap.
A scavenge is a garbage collection event where only short-lived, unused objects are collected from
the young heap area. Typically, scavenges are significantly faster than a full garbage collection,
which involves examining all objects in the entire heap.

Key to Garbage Collection Types Recognized by HPjmeter
HPjmeter reports numerous types of garbage collection. You may see references in HPjmeter to
GC types in data summaries or visualizers, so it helps to become familiar with them.

Table 13 Common Garbage Collection Types Recognized by HPjmeter

A garbage collection performed in the old area of the heap as a
background thread that does its work with few pauses in the application
run.

Concurrent Mark-Sweep (CMS)

Only objects from the young generation are collected using a
multi-threaded garbage collector.

Parallel Scavenge

Objects from the young generation only are collected using a single
thread.

Scavenge

Collection in the young generation occurs when a CMS operation is set
to collect in the old generation. The pauses for the young generation

Scavenge during CMS
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Table 13 Common Garbage Collection Types Recognized by HPjmeter (continued)

collection and the old generation collection occur independently and
cannot overlap.

Occurs when a background thread is performing a garbage collection
in the old area, but is interrupted when the JVM determines that a full
GC is needed.

Incomplete Concurrent Mark-Sweep

The G1 collector is a server-style garbage collector, targeted for
multi-processor machines with large memories.

Garbage First (G1)

Evacuation Pause means the evacuation pause doesn’t include initial
mark, it chooses a collection set of regions, and evacuates the regions
by copying all their live objects to other locations in the heap.

G1 Evacuation Pause

Initial mark and evacuation pause means the evacuation pause includes
an initial mark; the collector will do an evacuation pause first, then there
will be a G1 concurrent mark cycle.

G1 Initial Mark and Evacuation Pause

This occurs when a G1 background thread is performing garbage
collection, but is interrupted when the JVM determines that a full GC is
needed.

Incomplete Garbage First

Necessary when the old area is expanded on the most recent scavenge.
Typically, this happens when -Xms and -Xmx are not the same.

Old Expanded Full GC

Full GC necessary because the space reserved for metadata is full.Perm Full

Full GC necessary because intermediate space assigned to collection
using the train algorithm is full.

Train Full

Full GC performed when the garbage collector determines that space for
old objects is insufficient to support a successful scavenge. This
determination is reached without analyzing the heap.

Old Too Full

Full GC performed when the garbage collector determines that space for
old objects is insufficient to support a successful scavenge. This
determination is reached by analyzing the heap.

Old Full

The application calls method System.gc() to force a full garbage
collection.

System.gc

A full GC is performed as a result of a signal sent to the JVM to collect
a heap dump.

Heap Dump Triggered GC

A garbage collection is performed as a result of invoking the
ForceGarbageCollection function of JVMTI.

JVMTI force GC

A full garbage collection of unknown type and cause.Other Full GC

Mark the first pause during a concurrent collection cycle. Called the initial
mark, this identifies the initial set of live objects directly reachable from
the application code.

CMS First STW

Mark the second pause during a concurrent collection cycle. Called the
re-mark, this finalizes marking by revisiting any objects that were modified
during the concurrent marking phase.

CMS Second STW

Mark the first pause during a garbage first collection cycle. Called the
re-mark, this finalizes marking by revisiting any objects that were modified
during the concurrent marking phase.

G1 Remark

Mark the second pause during a garbage first collection cycle. Called
the clean-up. The heap regions are sorted for collection priority according

G1 Cleanup

to a cost algorithm. As a result, the regions that will yield the highest
numbers of reclaimed objects, at the smallest cost in terms of time, will
be collected first.

See also Data Collection with -Xverbosegc (page 94).
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For an explanation of Java memory terminology, see the Sun Developer Network publication
Memory Management in the Java HotSpot™ Virtual Machine
(http://java.sun.com/j2se/reference/whitepapers/memorymanagement_whitepaper.pdf)

Understanding the Summary Presentation of GC Data
To view the summary presentation of GC data, double-click on the data representation in the main
panel. A window will open to display the data.
The following image shows a summary of .vgc data collected using the -Xverbosegc option
and displayed under the Summary tab. Important aspects of the summary data are defined below
the image.

Figure 18 Summary Panel Showing Garbage Collection Statistics

Heap Capacity
Initial, final, and peak sizes allocated for various organizational spaces in the heap.
Peak Usage of Capacity
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The highest percentage of actual use by the application of the heap at its final capacity
configuration. A rule of thumb for optimal utilization would be to have the eden space at 100%
with the survivor and old spaces showing some reserve capacity, depending on the application.
GC Activity Summary

In this example, a comparison of scavenges and full garbage collection of the old and permanent
generations, showing number of GC occurrences, duration, and memory usage for each GC type
displayed.
Duration of the Measurement

The approximate, elapsed, wall clock time for the entire data collection.
Measurement Enabled and Measurement Disabled

“Measurement enabled” refers to the total time during which zero preparation GC data collection
has been activated during the session thus far. “Measurement disabled” refers to the total time
during which no data was collected (zero preparation GC data collection is not in use). These
values are visible on this tab when zero preparation GC data collection is used during a monitoring
session. They are not present when collecting GC data using the -Xverbosegc or -Xloggc
options on the command line.
Total Bytes Allocated

The total amount of space created for new objects over the lifetime of the application. This number
represents the total amount of memory the program would have consumed had no garbage
collection been performed. It is an abstract measure of the total work done by the application.
Number of GC Events

The number of times the garbage collector was invoked during the program run.
Average Ideal Allocation Rate

What the average memory allocation rate for new Java objects would have been had no garbage
collection been necessary. It is a theoretical limit of a program's performance if GC time were
driven to zero.
Residual Bytes

Heap usage when the program ends.
Time spent in GC

The total amount of wall clock time spent in garbage collection during the program run.
Percentage of Time in GC

The percentage of the total amount of wall clock time spent in garbage collection during the
program run. This value displays in red when 5% or more of clock time is spent in garbage
collection. When this value shows red, the amount of garbage collection activity should be
scrutinized.
Percentage of Time in Full GC

The percentage of the total amount of wall clock time spent doing a full GC during the program
run. This value displays in red when 5% or more of clock time is spent in a full garbage collection.
When this value shows red, the amount of garbage collection activity should be scrutinized. See
also “Comparison of Percentages” color bars.
Average Allocation Rate

The actual average memory allocation rate for new Java objects. See also Average Ideal Allocation
Rate.
Precise Data

For rounded values given in MB or GB, mouse over the value to see the measure in precise bytes.
Process is Swapping
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Indicates whether or not process swapping is occurring during the measured period. To determine
the amount of swap memory occupied when processes are being swapped, click the System Details
tab, and locate the swap data in the System and Memory Details section.
Comparison of Percentages

The color bars compare the percentage of time spent in Full GC or in System.gc calls as a
percentage of total time spent doing garbage collection. However, if the total time spent in
System.gc calls is greater than half the total time spent in Full GC, System.gc percentages will
display instead of Full GC percentages.

Understanding the System Details Captured with GC Data
To view the system details for GC data, select the System Details tab. If the value in a table cell
is too long, double click the data and a pop-up window will open to display the data.
The following image shows system details collected using the -Xverbosegc option and displayed
under the System Details tab.
The data on this tab is a summary of operating system attributes and the JVM options in effect at
the time the data collection began. It can be useful to refer to this information when determining
adjustments to make in the size of the heap and/or the memory spaces.
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Figure 19 Summary Panel Showing System Details for a Period of Xverbosegc Data Collection

NOTE: The Number of Localities, Heap Pointer Mode, and UseNUMA fields only display if JDK/JRE
6.0.08 or later is being used.

As with any field whose value is too long for its column width, if the JVM Arguments value shown
at the bottom of the panel is extensive and runs beyond its column, you can mouse over the value
to display a yellow pop-up box that shows all the JVM arguments. When you mouse away from
it, the yellow box disappears. However, if you double click the JVM arguments value, a pop-up
box displays and remains until you close it:
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Figure 20 System Details Tab with JVM Arguments Pop-up Box

Related Topics

• Using Specialized Garbage Collection Displays (page 181)

• Basic Garbage Collection Concepts (page 103)

• Tool Bar Buttons for Manipulating Garbage Collection Data (page 202)

• Changing Time Interval in GC Data Visualizers (page 206)

Basic Garbage Collection Concepts 109



7 Using the Console
The console main window displays when you start HPjmeter.

Starting the Console
You can run the HPjmeter console on HP-UX, Linux, and Microsoft Windows systems.

Starting the Console On HP-UX
There are two ways to start the console on HP-UX.

• From the command line, type
/opt/hpjmeter/bin/hpjmeter

The console will be ready to display performance data. Connect to a JVM agent for real-time
data, or read a profile data file using the main window tool bar as described in the product
documentation.

• From an instance of HP Systems Insight Manager, select the systems that are running
applications that you want to monitor or profile.
Then from the HP Systems Insight Manager menu bar, click Tools →Java Management
→HPjmeter Console.

Starting the Console On Linux
To start HPjmeter, type from the command line:
/opt/hpjmeter/bin/hpjmeter

The console will be ready to display performance data. Connect to a JVM agent for real-time data,
or read a profile data file using the main window tool bar as described in the product
documentation.

Starting the Console On Microsoft Windows
Assuming that you used the defaults suggested by the installation wizard, you can do one of the
following to launch the console.
• Double-click the short-cut icon for HPjmeter on your desktop.

• From the Start menu, select Program Files →HPjmeter →Console .

Using the Main Window Functions
The console, which is the main control area, contains a data pane, a tool bar, and menus. The
console is where monitoring is initiated and controlled and where data files of all types can be
opened for display in visualizers (standalone or within a tabbed viewer). See Using Visualizer
Functions (page 134) for the descriptions of how visualizers behave and the options they provide
for manipulating the data view.
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Figure 21 The Main Console Window

Data Representation
The console main window pane displays session information in a tree format.

Figure 22 Main Pane with Several File Types Loaded and an Open Session

When monitoring a running application, double-click on a JVM entry to open a session. You
can display multiple node agents and sessions in the data tree.
When analyzing collected data, Open a saved file, or click on the representation that appears

in the console pane (in this case a cached monitoring session). You can load multiple data sets
into the console for easy access.
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When viewing activity in the JMX server, double-click on the Summary to see the data collection
options used for this session, or while monitoring, change management bean attributes and observe
resulting changes in the data.
To quickly access alert visualizers or the Alert Controller, double-click on the alert entries in the

tree.
Status messages appear briefly in this area.
To view console memory usage, mouse over the bar to see current percentage use of memory

allocated to the console.

Icons and Their Meaning
Icons and descriptions that appear in the console main window represent:

• Node Agent
• JVM Agent
• Open and Cached Sessions
• Time Slice Entries

Node Agent
A node agent is a top-level entry in the data tree. It represents a connection to a node agent on a
managed node.

Table 14 Node Agent Connection Status Icons

The node agent is connected to a server and is running.

The node agent is connected and running through a Secure Shell (SSH) tunnel.

A JMX server is detected and HPjmeter is collecting data from it.

The connection is waiting for a response from the node agent. If this state exists for a long time,
verify that you specified the correct node name and port number.

The connection with the node agent is broken or cannot be established. Make sure that the node
agent is running on the specified host and double-click on the node agent to re-establish the
connection.

The connection with the node agent is broken or cannot be established. Make sure that the node
agent is running on the specified host and double-click on the node agent to re-establish the
connection.

JVM Agent
Java Virtual Machine (JVM) entries represent JVM agent-monitored JVMs on the host represented
by the corresponding node agent. The entry displays the corresponding process ID, the application
name, and its running time. The application is not monitored by HPjmeter. To open a monitoring
session with the application, double-click on the JVM entry.

Table 15 JVM Agent Connection Icons

A running JVM is identified, and has loaded the HPjmeter JVM agent; ready to open session
connection.

A running JVM is identified, but has not yet loaded the HPjmeter JVM agent; ready to connect
dynamically and open session.
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Table 15 JVM Agent Connection Icons (continued)

The JVM agent is not ready to open a session. Another console has already opened a session with
it, the JVM agent is running in batch mode, or the JVM agent is incompatible.

The JVM agent is unresponsive, that is, the node agent lost contact with it. The JVM might be down,
or it might be overloaded. Verify that the JVM is running and wait until it becomes responsive again
before opening a monitoring session with it.

Open and Cached Sessions
Session entries represent applications monitored by HPjmeter on the system. Many sessions can
exist for each node agent. Session entries display the system name and the port number of the
node agent connection if the connection is nonstandard.
An entry displays a process ID for the connection, the name of the application being run and state
information for the connection.
An entry marked Cached Application Data is a cached session. The data in a cached session
is available for analysis, but it is no longer connected to a running JVM and is no longer collecting
additional data. A cached session is created when a JVM in session terminates on its own, or
when you close an active session.

Table 16 Session State Icons

The session is running and working correctly, or the session is closed but the data for the session is
available for analysis.

The session is malfunctioning. Close the session and try to reopen it.

The session is unresponsive, that is, the node agent lost contact with it. The JVM might be down, or
it might be overloaded.

Time Slice Entries
Time slice entries represent the life span of the current monitoring session for an application. You
can view data throughout the life span of a time slice.

Table 17 Time Slice Icons

This entry displays the life span of the time slice. Click to activate the Monitor metric visualizers.

Alert entries represent current alerts. Double-click to open the visualizer that displays the data that
triggered the alert. (To see the alert history, check the alert log file accessible from the Alert Controller.)

You cannot store more than one time slice in the hierarchy below a JVM session. Closed sessions
accumulate at the bottom of the data tree.

Saving Data

Table 18 Saved Data Icon

The data represented has been saved from a previous run of the application or from a monitoring
session. Metric and alert information are available, but interactions that require connection to the
live node agent are not.

A saved data file will appear as the top-level entry in the data tree.
Data from monitoring a session is saved by clicking an open session, which activates the Save as
option on the File menu and the Save to Snapshot File button.
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Data from a session is saved by using the appropriate options on the command line when you
start your application.

• Collecting Profile Data (page 72)
• Setting Data Collection Preferences (page 46)
• Saving Monitoring Metrics Information (page 48)

Console Tool Bar Buttons
Open File Select a previously saved monitor batch file, a snapshot file,

or a profile data file to view.
After opening a saved file, you can review data using the
menu metrics appropriate for the data file type.

Connect to Server Launches the Connect To Server dialog so that you can
specify the name of the host and optional port of the target
that you want to monitor. You must specify a port number
if the node agent was started on a nonstandard port. See
Connect to the Node Agent from the Console (page 34) for
an example of the Connect to Server dialog box. You can
also refer to Connecting to the HPjmeter Node Agent
(page 222).

Save to Snapshot File Allows you to save monitoring data from a live or cached
session to a snapshot file. You can then analyze the session
data later or send the data file to others for further analysis.

Open Session Preferences Launches the Session Preferences window so that you can
change settings at the beginning of, or during (requires Java
6), a monitoring session. To activate the Session Preferences
icon, first select an Open Session counter row in the console
data tree.

Open Alert Controller Launches the Alert Controller so that you can change
thresholds and time sustained for available alert settings.
You can also set options for e-mail notification when alerts
occur. To activate the Alert Controller icon, first select an
Alerts counter row or click a specific alert listed in the
console data tree.

Close Closes a selected monitoring session, deletes a connection
with a selected node agent, or removes a selected saved
data file entry from the data tree.

Generate extended profiling
(-Xeprof) data file

Launches the Remote Operations window for a live session
with a JVM. You can use the Remote Operations window
to generate extended profiling data from a JVM.
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Console Menu Choices
The console menu bar contains these choices:

• File -- Contains selections corresponding to the buttons in the tool bar, plus Exit the HPjmeter
application.

• Edit -- Contains these commands:

Look and Feel Preferences
Graphical user interface look-and-feel selections

◦

◦ Window Preferences
Remember Last Input File Directory on Exit
Click the menu item to toggle whether HPjmeter remembers the directory of the last
input file upon exit/restart of the console window. With this menu item enabled,

–

when you restart the console and do an Open File, it looks in the directory where it
looked the last time. With this menu item disabled, the console looks in the current
directory. This menu selection is enabled by default.

– Remember Main Window Location
Click the menu item to toggle whether HPjmeter places the console window in the
same location when you restart.

– Cascade Metric Windows
Click the menu item to have HPjmeter open new metric windows position so you can
see the windows beneath the newly opened window.

– Show Console Guide
The Console Guide is enabled by default and appears in a pane below the main
console data pane. Use this menu selection to hide or reveal the guide pane.

– Confirm Save When Closing the Main Window
On exiting, HPjmeter will check that all new data collections or sessions have been
saved. If they have not been saved, HPjmeter will provide an opportunity to save
cached data. This selection is on by default.

◦ Standard Preferences
Allows you to import, export, delete, or reset preference settings.

– Import Preferences from File
You can import HPjmeter_preferences.xml to populate the preference data
of a new installation by placing this file in your home directory and selecting this
choice.

– Export Preferences to File
You can save the contents of the backing store by exporting it to a file named
HPjmeter_preferences.xml in your home directory.

– Delete Preference Backing Store
Use this selection to delete the contents of the backing store. The backing store
automatically collects the settings that you choose each time you run HPjmeter.

– Reset Default Color Preferences
Resets all color changes made to visualizer displays back to the default settings.
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• Monitor — Contains these categorical submenus and their associated monitoring metrics:

JVM Summary◦
◦ Code/CPU

◦ Memory/Heap

◦ Threads/Locks

◦ JVM/System

• Help — Provides links to the HPjmeter User's Guide, getting started material, and demonstration
instructions.

The Monitor Menu
The Monitor menu provides a summary of JVM information plus four submenus that give access to
the lists of specific available metrics. When you select a time slice (live or from a saved file), the
appropriate metrics for the Monitor menu become active so you can display the session data in
standalone visualizers. For details about specific monitoring metrics, see Using Monitoring Displays
(page 135).
Menus for selecting general profile data metrics are accessible within the profiling data viewer.
See Using Profile Displays (page 160).

NOTE: Some metrics may appear grayed out when you select a menu category. These metrics
may have been disabled in the session preferences or by specifying a JVM agent option. To
re-enable these metrics, you may need to close the current session and start a new session, enabling
the desired metrics in the Session Preferences window; or restart the application with different JVM
options; or both.
See Setting Monitoring Session Preferences (page 117).

Console Guide
To aid in starting your use of HPjmeter, the console can display a beginning guide containing hints
for getting started. The guide provides hints appropriate to the object highlighted in the main
console pane.
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Figure 23 Console Guide Location and First Screen

To enable or disable the console guide, click Edit Window Preferences and toggle to the desired
option.

Status Bar
The Status Bar in the lower bottom and right corner of the console provides standard notifications
including:
• status and error messages
• warning icon when an alert is present
• memory use by the console (mousing over the horizontal bar reveals percent memory use of

total allocated MB)

Setting Monitoring Session Preferences
The Session Preferences dialog box allows you to:
• Specify which monitoring metrics to collect.

• Enable or disable specific alerts.

• Control filters you can use to specify the information to collect.
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Specifying Metrics to Collect for Monitoring
You can open the Session Preferences window at any time by double-clicking on an Open Session,
or single-clicking on it then clicking the Session Preferences toolbar button.
In pre-deployment or development, it is typical to enable all items. In deployment mode, when you
may be concerned about the impact on the application, you can enable a subset of the available
items. For more information about performance, see Performance Overhead on Running Applications
(page 212).
The Session Preferences window uses colors (green, yellow, orange) to associate a relative collection
cost (low, medium, high) for each capability. Reduce monitoring overhead by turning off metrics
that you don’t need for a monitoring session.

Figure 24 Metric Preferences Window

In the Session Preferences dialog box:
1. Click the Metrics tab.
2. Click the Enabled box to toggle the corresponding metric on or off.
3. Make sure the measurements that you want are enabled.
4. To modify filters or alerts, click the corresponding tab.
5. Click OK to save the changes.

CAUTION: TheThrown Exceptions with Stacktraces metric is unselected by default. Because
collecting stack traces can impair your application's performance, enable this metric only when
you need to get information about where most exceptions are thrown. For details, see Thrown
Exceptions with Stack Traces (page 138).
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To reset the selections to the original settings, click Restore Defaults.
Related Topics

• Setting Data Collection Preferences (page 46)
• Controlling Data Collection and Display (page 46)
• Specifying Filters for Monitoring (page 120)
• View Monitoring Metrics During Your Open Session (page 39)

Enabling Monitoring Alerts
If you turn off an alert in the Session Preferences dialog, it will not show in the alert controller
window and no data will be generated for it.

• To enable an alert:
When opening a session, check the appropriate box in the Alerts tab of the Session Preferences
window. If the box is checked when the session is opened, then the alert will be available in
the session.

• To disable an alert:
Uncheck the box to the right of each alert that you want to disable for the length of the session.

Update of Session Preferences allowed with HPjmeter 4.0 and later:
Open the Alert Controller and select Preferences to open the Session Preferences window.
See also Changing Session Preferences During a Session (page 39)

• To enable e-mail notification to the address of your choice when alerts are logged by HPjmeter:
Click Set Notification, and fill in the fields and desired options. At minimum, click the check
box to the left of Activate e-mail notification to enable e-mail notification for the duration of
this session. For information on using the e-mail notification editor, see Editing E-mail
Notification Attributes (page 125).

• To reset the selections to the original settings:
Click the Restore Defaults button.
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Figure 25 Enable or Disable Alerts Window

Related Topics

• Using the Alert Controller (page 123) to deactivate or reactivate enabled alerts

Specifying Filters for Monitoring
You can control the amount of information that HPjmeter provides during a live session by filtering
out classes using the Filters tab of the Session Preferences dialog box.
Filters may be inclusive or exclusive, but not both:
• Inclusive filters include only the specified classes in a filter set.

• Exclusive filters remove all classes that are listed in a filter set.
You can add new filters or edit existing filters as desired.

• To begin editing an existing filter, double-click the desired filter listed on the Filters tab.

• To add a new filter, click Add Filter Set.

• To reset the selections to the original settings, click the Restore Defaults button.
HPjmeter uses bytecode instrumentation to collect data. If a class is not instrumented, the JVM agent
metrics that use bytecode instrumentation do not provide any output related to the class methods.

To see the list of filters in effect while the data was collected, click the where it appears in
monitoring displays.

Editing Filters
To edit an existing filter:
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1. In the Session Preferences dialog box, click on the Filters tab.
2. Double-click the filter name in the list of filters on the Filters tab.

The Filter Set Editor opens.
3. Specify the list of packages for the filter in the Filter Set field. See Specifying Filters for

Monitoring (page 120) for details.

Adding Filters
To add a new filter:
1. In the Session Preferences dialog box, click on the Filters tab.
2. Click Add Filter Set.

The Filter Set Editor opens.
3. Type the name of the filter set in the Filter Name field.
4. Specify the list of packages for the filter in the Filter Set field. See Specifying Filters for

Monitoring (page 120) for details.

Specifying Filter Sets
Filter sets are comma-separated lists of packages, classes, or both. You can use wildcards or
periods at the end of the name only, but they are not necessary. For example, the following are
permitted:

• javax.swing.*

• com.foo.bar.

• mypackage.MyClass

Names such as *.util and com.*.util are not valid.
Related Topic

• See include/exclude options in JVM Agent Options (page 27)

Viewing Monitoring Data in HPjmeter
Once you have started the data collection by opening a session in the console pane, you are ready
to view monitoring metrics.
• Click the time slice that you want to view. This will activate the Monitor menu selections.

• Click the Monitor heading to see the list of monitoring categories. Mouse over each category
to see the available metrics.

NOTE: A grayed-out menu item indicates that data is not currently available for viewing.

• Click the metric that you want to view.
The data for that metric will open in a separate, standalone visualizer that can be moved to
any location on your monitor screen.

• Use the visualizer buttons and other functions to manipulate the data in the visualizer.
See also
• Using Visualizer Functions (page 134)
• Using Monitoring Displays (page 135)

Using Alerts
The console provides a way for you to enable and disable alerts for specific events when monitoring
an application. Enabled alerts can be deactivated and reactivated during the session as needed
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by using the Alert Controller. In addition, you can set thresholds in the Alert Controller to vary the
sensitivity of the console to enabled alert conditions, and you can edit e-mail notification attributes
submitted when you set session preferences.
When active alerts are triggered, a notification appears in the main pane of the console window,
and the alert type and threshold value are displayed on all relevant metric visualizers. To view
details about the application behavior that triggered the notification, double-click on the specific
alert that you want to see. A metric window associated with the alert will open, with the alert type
and its threshold value displayed at the bottom of the window. For example, if you enabled GC
Duration (Major) and GC Duration (Minor) alerts, and the alerts were triggered, the GC Duration
visualizer might look something like this:

Figure 26 Appearance of Alert Threshold in GC Duration Visualizer

If you disable the alert in the Alert Controller, that alert and its threshold value are removed from
all relevent visualizers. For example, disabling the GC Duration (Minor) alert will then remove it
from the GC Duration visualizer:

Figure 27 GC Duration (Minor) alert Removed from GC Duration Visualizer
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See “Responding to Alerts” (page 126) for information on specific alert notifications.
The console displays an alert while the alert condition exists, and stops displaying when the alert
condition no longer exists.
A displayed alert may also stop displaying when HPjmeter recalculates the alert based on real-time
information.
The console displays a warning icon in the lower right corner of the window showing the current
number of alerts detected.

Using the Alert Controller
To open the Alert Controller, double-click on an Alerts counter row in the data tree.

Figure 28 Appearance of Alert Notices in the Main Console Pane

In the Controller, you can see all alerts enabled for that session. Some are turned on by default;
others must be turned on in the Alert Controller.

NOTE: If you disabled specific alerts when you set your session preferences, information for
those alerts will not be available in the Alert Controller or the main console pane. To re-enable
those alerts, you must enable the alert in the session preferences for that session.
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Figure 29 Alert Controller Window

You can use the Alert Controller in these ways:
Deactivate or reactivate enabled alerts.
To deactivate or reactivate alerts once a session has started, use the check box next to the alert
name.
• When you deactivate an alert, the console stops reporting that alert to the console main pane.

Note that a record of the alert activity up to that point has been written into a log file for
reference.

• Remember that you can only deactivate or reactivate alerts that are enabled in Session
Preferences.

Open the Session Preferences window to enable/disable alerts.:
With HPjmeter 4.0 and later, you can click Preferences on the Alert Controller to open the Session
Preferences window. The window opens with the Alerts tab selected. There, you can change the
settings selected when the session started. For more information, see Setting Monitoring Session
Preferences (page 117).
When done changing Session Preferences, the Alert Controller will refresh with the new information.
Make any alterations needed in the Alert Controller for newly enabled alerts.

Set alert thresholds.
You can use default settings or set values for enabled alerts. For each alert enabled, you can select
a numerical threshold and a time constraint. The alert is triggered when the threshold is passed
for the duration of the allotted time.
For example, if you are setting values for the Heap Usage alert, and you choose ≥ 50 MB and a
time constraint of 60 seconds, the alert will trigger when the heap usage in the application exceeds
the 50 MB threshold for at least 60 seconds. A notification appears in the console main panel for
as long as the threshold is crossed, periodically updating to show the current value of the heap
usage.
New values for alerts are applied immediately when you select Apply.
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Viewing a Log of the Alert History
From the Alert Controller, select the Alert Log button to see a history of alerts noted during the
monitoring session.

Figure 30 Example Alert Log

Change the alert log capacity.
From the Alert Log window, click the “Select Log Capacity” icon to open the log capacity window.
Change the value as desired for number of lines to include in the log.

Editing E-mail Notification Attributes
From the Alert Controller, click Edit Notification to see the Alert Notification Editor and the settings
you entered for this monitoring session.

Figure 31 Example Alert Notification Editor

The following table explains available options.
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Table 19 E-mail Notification Fields and Options for Receiving Alerts

DescriptionExpected Attribute ValuesFields/Options

To locate the desired mail serverCorrectly constructed host name of a
valid SMTP server that allows connection
without authentication.

SMTP E-mail Server:

To provide an identifiable and
memorable address that distinguishes
HPjmeter alerts from other e-mail

HP provides a default HPjmeter address;
however, this field can be edited to enter
an alternative address

From:

To send e-mail alerts to intended
receiver(s)

Valid user or distribution list e-mail
address; one or more addresses can be

To:

entered; use a comma-separated list for
multiple addresses.

Off by default. Check mark indicates
e-mail notification is on.

Click box to turn on or offActivate e-mail notification

Off by default; operative only when
e-mail notification is activated.
When this setting is off, only the first
occurrence of an alert event will be sent

Click box to turn on or offSend all status changes
corresponding to an enabled alert

in e-mail. A check mark on this option
indicates that notification will be sent
every time an alert is activated during a
session.

The following table explains the button controls in the Alert Notification Editor.

Table 20 Alert Notification Editor Controls

DescriptionControls

Saves and applies changes to attributes and options for the duration of the monitoring session.Save

Tests that the e-mail function is working; sends a test e-mail to the To: address designated in the
editor.

Send Test

Cancels the editing of the alert notification settings; previous settings are still in effect.Cancel

Opens HPjmeter help to the beginning of this help topic.Help

Notification for a session ends when the monitoring session is closed.

Responding to Alerts
Alerts are automatically posted to the main console in the appropriate data tree, and if set, they
are also sent to an email address. To investigate the alert further, double-click on the individual
alert listed in the data tree in the main console window to open a window containing metric
information for that particular alert.
The following information is specific for each alert type.

Abnormal Thread Termination Alert
HPjmeter detects threads that terminate abnormally because of an uncaught exception.
By default, when HPjmeter detects that one thread (or more) terminated abnormally, the console
main window displays an Abnormal Thread Termination Alert.
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Double-clicking on the alert in the main window displays the uncaught exception window. The
window shows:
• Thread name
• Exception
• Source location where the exception was thrown

Figure 32 Abnormal Thread Termination Alert Visualizer

You can use this information to debug the cause of the exception. For example, each row in the
Abnormal Thread Termination window represents a thread in the Thread Histogram window.
You can open the Thread Histogram metric, and notice that when a thread terminates, the associated
bar in the Thread Histogram display is shorter than the others. Note that the thread histogram does
not distinguish between threads that terminate normally or abnormally.
Symptoms that an application might show if it has abnormally terminating threads include:

• Poor application response.
If worker threads terminate, then the application might continue to work, but at a reduced
speed.

• The entire application terminates.
Usually the application itself does not terminate as the result of one thread dying. However,
it is possible that the entire application might eventually terminate if it cannot handle the loss
of a thread.

See also:
• Identifying Abnormal Thread Termination (page 54)
• Thread Histogram (page 152)

Uncaught Exception Statistics
These statistics are derived from more than one metric.
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The Uncaught Exception Statistics display shows you:
• Thread name
• Type of Exception
• Time thrown, as the time from the start of the application
• Throw point as a subentry
The window shows events in a hierarchical tree.

• Select the View→Show Packages menu item to alternatively hide or show the Java package
names to shorten the lines in the display.

• Select the View→Show Stacktraces menu item to alternatively expand or collapse the thrown
stack traces of all the exception nodes, or click on a specific node to expand or collapse its
thrown stack trace only.

The results are cumulative over the life time of the session.
See also:

• Thread Histogram (page 152)
• Identifying Abnormal Thread Termination (page 54)

Excessive Compilation Alert
By default, HPjmeter detects when one method (or more) is repeatedly compiled.
Double-click on the Excessive Compilation alert to display the metrics for excessive method
compilation.
See also: Identifying Excessive Method Compilation (page 56) .

Expected Out Of Memory Error Alert
HPjmeter detects memory leaks automatically and reports an alert before a crash occurs. By default,
this alert activates when memory use increases by a rate of 10 MB/hr.
Double-click on the alert to open the Heap Monitor display.
The heuristic algorithms for alert triggers are tuned for server-oriented applications. The alerts are
based on heuristic algorithms and are not offered with 100 percent certainty. Fluctuations in the
application load may cause a transient increase in memory usage.
To confirm the leak, monitor the application for one hour or longer; then review the Garbage
Collections metrics.
See also:
• Garbage Collections (page 141)
• Confirming Java Memory Leaks (page 53)
• How Memory Leak Detection Works (page 214)
• Heap Monitor (page 140)

GC Duration Alert
Set this threshold when you suspect that the duration of garbage collections exceeds or is
significantly less than what is reasonable for the application heap size.
The Alert Controller displays this alert threshold differently depending on the Java version run with
the application.
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Table 21 GC Duration Alert Threshold by Java Version

Default Alert ThresholdMetric NameJava Version

> 2000 milliseconds (2 seconds)GC DurationHP 1.4.2.02 or later 1.4.x versions

> 30 secondsGC Duration (Major)HP 1.5.0.12 or 6.0.01 or later

> 2000 millisecondsGC Duration (Minor)HP 1.5.0.12 or 6.0.01 or later

Double-click on the alert to display the GC Duration visualizer.
See also:
• GC Duration (page 142)
• Heap Monitor (page 140)
• Viewing the Application Load (page 50)
• Checking for Long Garbage Collection Pauses (page 50)
• Current Live Heap Objects (page 147)

Heap Usage Alert
It can be useful to change the heap usage threshold in order to observe the heap structure at the
selected usage point.
You can also set this threshold to notify you when heap usage exceeds your maximum or minimum
expectations for the application.
By default, this alert is enabled in Session Preferences, but is turned off in the Alert Controller until
you turn it on. Once turned on, this alert activates when heap usage reaches the default value of
10 MB or more .
For example, if you expect that your application should never consume more than 100 MB of heap
for a target period of time, set the threshold fields for heap size and time sustained, and check
that the alert is enabled. If the set values are exceeded, an alert is generated and recorded in the
alert log. An alert notice is posted on the console.
Double-click on the alert to display the Heap Monitor. In this visualizer, you can see the memory
allocated to the heap compared to usage over time, and including indicators for garbage collection
events and their duration.
See also:
• Heap Monitor (page 140)
• Viewing the Application Load (page 50)
• Checking for Long Garbage Collection Pauses (page 50)
• Current Live Heap Objects (page 147)

Java Collection Leak Locations Alert
HPjmeter detects potential Java collection memory leaks and identifies the source-file line of the
leak. By default, this alert is activated when the leak is 10 MB/hour or more.
The console main window displays a Java Collection Leak Locations Alert when a Java collection
class memory leak is detected.
Double-clicking on the alert displays the Java Collection Leak Locations visualizer, which shows:

• Each detected Java collection leak object type
• The leak source location
• The leak duration
• The current size of the collection object
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Mouse over the location entry to see an explanatory tool tip.

Figure 33 Java Collection Leak Locations Visualizer

After some time, the alert icon may disappear if:

• HPjmeter determines that the previously reported leak object is not a leak.

• The leak-related collection object is removed by garbage collection.
HPjmeter removes the alert icon when it removes all the leak nodes and no new memory leak is
detected.

NOTE: This alert is not available when dynamically attaching to a running Java application.

See also:
• How Memory Leak Detection Works (page 214)
• Confirming Java Memory Leaks (page 53)
• Determining the Severity of a Memory Leak (page 53)
• Array Leak Locations Alert

Array Leak Locations Alert
HPjmeter detects potential array memory leaks and identifies the source-file line of the leak. By
default, this alert is activated when the leak is 10 MB/hour or more.
The console main window displays an Array Leak Locations Alert when an array memory leak is
detected.
Double-clicking on the alert displays the Array Leak Locations visualizer, which shows:

• Each detected array leak type
• The leak source location
• The leak duration
• The current size of the detected array
Mousing over an array leak alert pops up a yellow description box with explanatory text.

130 Using the Console



Figure 34 Array Leak Locations Visualizer

After some time, the alert icon may disappear if:

• HPjmeter determines that the previously reported leak object is not a leak.

• The leak-related array is removed by garbage collection.
HPjmeter removes the alert icon when it removes all the leak nodes and no new memory leak is
detected.

NOTE: This alert is not available when dynamically attaching to a running Java application.

See also:
• How Memory Leak Detection Works (page 214)
• Confirming Java Memory Leaks (page 53)
• Determining the Severity of a Memory Leak (page 53)
• Java Collection Leak Locations Alert (page 129)

Process CPU Usage Alert
Enable this alert to track target levels of process CPU usage. Significant variance from target levels
may indicate the presence of performance bottlenecks. Bottlenecks are caused by thread starvation
that occurs when the application is using all available CPU resources or when processes other
than your application are using the available CPU resources.
By default, this alert is enabled in Session Preferences, but is turned off in the Alert Controller until
you turn it on. Once turned on, this alert activates when process CPU usage reaches the set value.
The default value is 50 percent of 1 CPU.
Procedure 3 To Set the Process CPU Usage Alert
1. Connect to the server, and click the appropriate check box to enable the Process CPU Usage

Alert on the Alerts tab in the Set Preferences window.
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2. Once connected to the JVM, open the Alert Controller.
3. Scroll down if needed to see the Process CPU Usage Alert. Check this box also to turn this

alert on.
4. Set the usage threshold to reflect the expected consumption and designate a duration, if

desired.
5. Click Apply to activate checking for this threshold.
When the set threshold is met, an alert notice is posted on the console.
Double-click on the console alert to display the Percent CPU Utilization visualizer. In this visualizer,
you can see system and process CPU usage during the period of the monitoring session plotted
against the known resources of the server.
As an example, assume that you have a 4-CPU system, and you expect your Java application to
consume at least 1.5 CPU.
HPjmeter presents CPU utilization percentages as the number of CPUs x 100 to arrive at the total
possible percent of use. Therefore, expected use of 1.5 CPU would be equal to or greater than
150% of 1 CPU out of a total of 4 available CPU. By applying this value (150%) in the Alert
Controller, HPjmeter notifies you when that value is exceeded during the monitoring session. A
notification is generated for display on the console and recorded in the alert log.
Conversely, if you expect that your application will always use at least 100% of 1 CPU, set the
operator at less than or equal to 100% to trigger a notification that the application is not consuming
resources as expected.
For more information, see also:

• Set Session Preferences (page 37)
• Using Alerts (page 121)
• Percent (%) CPU Utilization (page 158)
• Identifying Unexpected CPU Usage by Method (page 49)

System CPU Usage Alert
This alert measures overall CPU usage for the entire system, not time spent in the system processor
state. Enable this alert to track target levels of system-level CPU usage. Significant variance from
target levels may indicate over- or under-utilization of system resources.
By default, this notification is enabled in Session Preferences, but is turned off in the Alert Controller
until you turn it on. Once turned on, this alert activates when system CPU utilization reaches the
set value. The default value is 50 percent of 1 CPU.
Procedure 4 To Set the System CPU Usage Alert
1. Connect to the server, and click the appropriate check box to enable the System CPU Usage

Alert on the Alerts tab in the Set Preferences window.
2. Once connected to the JVM, open the Alert Controller.
3. Scroll down if needed to see the System CPU Usage Alert. Check this box also to turn this

alert on.
4. Set the utilization threshold to reflect the consumption threshold and designate a duration, if

desired.
5. Click Apply to activate checking for this threshold.
When the set threshold is met, an alert notice is posted on the console.
Double-click on the console alert to display the Percent CPU Utilization visualizer. In this visualizer,
you can see system and process CPU usage during the period of the monitoring session plotted
against the known resources of the server.
As an example, assume that you have a 4-CPU system, and you expect your Java application to
consume no more than 3 CPU over any 5–minute period.
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HPjmeter presents CPU utilization percentages as the number of CPUs x 100 to arrive at the total
possible percent of use. Therefore, maximum use of 3 CPU would be equal to or greater than
300% of 1 CPU out of a total of 4 available CPU. By applying this value (300%) for a 5–minute
duration in the Alert Controller, HPjmeter notifies you each time that value is exceeded for 5 minutes
during the monitoring session. A notification is generated for display on the console and recorded
in the alert log.
Conversely, if you expect that your application will always use at least 100% of 1 CPU, set the
operator at less than or equal to 100% to trigger a notification that the application is not consuming
resources as expected.
For more information, see also:

• Set Session Preferences (page 37)
• Using Alerts (page 121)
• Percent (%) CPU Utilization (page 158)
• Identifying Unexpected CPU Usage by Method (page 49)

Thread Deadlock Alert
By default, this alert is activated when two or more threads are attempting to acquire Java locks
that have been acquired already by a set of threads.
Double-click the alert to display the thread histogram window. This allows you to determine which
threads are deadlocked.
Deadlocked threads represent a multi-threaded program error.
An application experiencing a deadlock may not crash, but it is unresponsive to requests.
If the alert persists, it suggests a problem in the application logic that will need to be addressed
by developers.
See also:
• Thread Histogram (page 152)
• Lock Contention (page 153)

Unfinalized Queue Growth
This alert activates when the average finalizer queue length in a 5–minute period exceeds the
value set in the Alert Controller. The default setting for this alert is 5000 objects.
Double-click the alert in the console to open the Unfinalized Queue Growth visualizer.
See Unfinalized Objects (page 144) for information on how to interpret the data presented in this
visualizer.
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8 Using Visualizer Functions
Visualizers behave somewhat differently depending on the type of data displayed.

Visualizer Behavior When Monitoring Behavior or Analyzing Data
Visualizers that open as a result of selecting metrics from the Monitor menu on the main console
appear as individual, standalone windows. This behavior allows you to view a number of individual
metrics at the same time. You can easily move the visualizers around on your monitor screen when
observing live application behavior or when reviewing a saved data set from a monitoring session.
For details about specific monitoring visualizers, see Using Monitoring Displays (page 135).
Visualizers that open as a result of selecting a profile data file open as tabbed panes within a
viewer. Presenting visualizers within a tabbed pane viewer allows you to open one or more data
sets at the same time. The viewer helps you keep the visualizers for each data set organized as a
group within its own viewer. For details about specific profiling visualizers, see Using Profile
Displays (page 160) and Using Specialized Garbage Collection Displays (page 181).
Viewers are configured to support the type of data collected and to support specialized analysis.
For example, the profiling viewer appears when you open an eprof or hprof file. It provides an
initial set of visualizer tabs to display summary data and an important subset of all the available
profiling metrics. Other metrics are opened into the tabbed pane by selecting them from the Metrics
or Estimate menus in the viewer.

Figure 35 The Profiling Data Viewer

The garbage collection (GC) viewer is specialized to provide a detailed view of -Xverbosegc
data. All available metrics for this data are presented in tabs on opening the data set. No additional
metric menus appear in this viewer.
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Figure 36 The Garbage Collection Data Viewer

Both standalone visualizers and tabbed viewers have tool bars and other controls for manipulating
the data display. See Using Visualizer Tool Bars (page 201).

Locating Information About a JVM and its Environment
HPjmeter collects information about a running JVM and its environment and displays it in the JVM
Summary visualizer. This feature is available by default when monitoring an application or when
viewing a saved file from a monitoring session.
To view the JVM Summary, click Monitor→JVM Summary on the console menu bar.
Use this visualizer to review the settings used to set up the application run and to review the system
configuration.

NOTE: The JVM Summary obtains information from collected JMX data. To disable the transmission
of JMX data from the JVM, you must disable both JVM Summary and JMX Support in the Session
Preferences dialog.

Using Monitoring Displays
Monitoring metric displays are available from the Monitormenu on the main console. The monitoring
displays can be used during live operation of the application and with saved data (.hpjmeter)
files.
HPjmeter monitoring metrics are organized as follows:
Monitor Code and/or CPU Activity Menu (page 136)
• Java Method HotSpots (page 136)
• Thrown Exceptions (page 138)
• Thrown Exceptions with Stack Traces (page 138)
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Monitor Memory and/or Heap Activity Menu (page 140)
• Heap Monitor (page 140)
• Garbage Collections (page 141)
• GC Duration (page 142)
• Percentage of Time Spent in Garbage Collection (page 143)
• Unfinalized Objects (page 144)
• Allocated Object Statistics by Class (page 145)
• Allocating Method Statistics (page 146)
• Current Live Heap Objects (page 147)
• Process Resident Memory (page 149)
• Process Virtual Memory (page 150)
• Data Region Resident Memory (page 150)
• Data Region Virtual Memory (page 151)
Monitor Threads and/or Locks Menu (page 152)
• Thread Histogram (page 152)
• Lock Contention (page 153)
Monitor Network/Sockets Menu (page 154)
• Incoming Socket Connections Frequency (page 154)

• Outgoing Socket Connections Frequency (page 154)

• Network Input Stream (page 155)

• Network Output Stream (page 155)
Monitor JVM and/or System Activity Menu (page 156)
• Method Compilation Count (page 156)
• Method Compilation Frequency (page 157)
• Loaded Classes (page 158)
• Percent (%) CPU Utilization (page 158)
• System Call Rate (page 159)
See also:

• Monitoring Applications (page 46)
• Using the Console (page 110)
• Using Visualizer Tool Bars (page 201)

Monitor Code and/or CPU Activity Menu

Java Method HotSpots
Displays a sampling-based estimate of the CPU time consumed by individual Java methods.
Methods are listed from highest to lowest CPU usage by percentage; over a session lifetime; with
package, method, and method arguments displayed.
Each method's information is written over a graphical representation of the confidence interval
calculated for that method.
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Figure 37 Monitoring Metric: Java Methods HotSpots with Confidence Interval Graphically Displayed
for Each Method

Guidelines

• If this metric shows a large percentage of CPU time spent in just a few methods listed at the
top, it indicates a performance problem or a method performance problem that might be
improved.

• When the top entry represents a single-digit percentage, a performance problem is unlikely
unless the entry describes a method that you did not expect to see.

Details
You can turn off the display of package and argument information from the View menu.
HPjmeter reports select methods that are the root cause of high CPU-time usage, while excluding
others that are rarely relevant. This technique reports methods that are most likely to need additional
optimization.
A common optimization technique is to improve how a method calls helper methods. These helper
methods are not included in the list.
The percentages are not absolute across the entire application, but are computed only with respect
to the methods HPjmeter reports.
HPjmeter does not report small methods, which are frequently inlined, and methods outside your
application, such as those in the java.* package. The goal is to help you zoom in on your core
application logic, including use of helper methods and APIs.
The metric window reports “No hotspot detected at this time” until it detects a Method CPU hot
spot, and then the metric data appears. The survey for hot spots often takes just a few seconds,
but in some cases could take longer.
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NOTE: The data collection for Java Method HotSpots may be significantly delayed if one or more
of these conditions exist:
• The application runs on a single CPU system.

• The application does not consume a lot of CPU.

• The application consumes CPU exclusively in non-profiled methods.
Restarting the application server or node agent will not improve data collection.

Related Topics

• Identifying Unexpected CPU Usage by Method (page 49)
• Data Sampling Considerations (page 213)
• Time Units (page 82)
• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Thrown Exceptions
Displays thrown exception counts according to the exception type and the catching method. If you
need stack trace information, refer to Thrown Exceptions with Stack Traces (page 138).
The integer is a count of how many times this exception has been thrown in this location, and
caught by this method. The percentage gives information on how often this exception is being
thrown in relation to all the detected thrown exceptions.
HPjmeter collects and reports exceptions caught in classes that are instrumented, that is, classes
that the JVM agent instrumentation rules have not excluded. To identify the JVM agent rules in
effect, you can use the JVM agent verbose option.
HPjmeter does not collect or report exceptions that are caught in methods filtered out by the exclude
JVM agent option.
The display shows “No thrown exception detected since the session opened.” until HPjmeter detects
a thrown exception, at which time it displays the information.
The window shows events in a hierarchical tree.
The View menu allows you to control the information displayed in the window:

• Select View→Show Percentages to alternatively hide or show the percentage value of the total
count for each exception, shown next to the count value.

• Select View→Show Packages to alternatively hide or show the Java package names to shorten
the lines in the display.

The results are cumulative over the lifetime of the session.
Related topics

• Thrown Exceptions with Stack Traces (page 138)
• Setting Monitoring Session Preferences (page 117)
• Setting Data Collection Preferences (page 46)

Thrown Exceptions with Stack Traces
Enable this metric in the Session Preferences window only when you need to get information about
where your applications throws exceptions. To view this data, click Monitor→Code/CPU→Thrown
Exceptions.
This metric displays thrown exception counts according to the exception type, the catching method,
and the stack trace of the throwing location.
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The integer is a count of how many times this exception has been thrown in this location, and
caught by this method. The percentage gives information on how often this exception is being
thrown in relation to all the detected thrown exceptions.

NOTE: Collecting the stack trace information could impair the performance of your application
if the application throws a large number of exceptions during the session. To minimize the effect
on your application, you can enable the Thrown Exceptions (page 138) metric, which does not
collect stack traces, when you start your session.

Figure 38 Monitoring Metric: Thrown Exceptions with Stack Traces

HPjmeter collects and reports exceptions caught in classes that are instrumented, that is, classes
that the JVM agent instrumentation rules have not excluded. To identify the JVM agent rules in
effect, you can use the JVM agent verbose option.
HPjmeter does not collect or report exceptions that are caught in methods filtered out by the exclude
JVM agent option.
The display shows “No thrown exception detected since the session opened.” until HPjmeter detects
a thrown exception at which time it displays the information.
The window shows events in a hierarchical tree.
The View menu allows you to control the information displayed in the window:

• Select View→Show Percentages to alternatively hide or show the percentage value of the total
count for each exception, shown next to the count value.

• Select View→Show Packages to alternatively hide or show the Java package names to shorten
the lines in the display.

• Select View→Show Stacktraces alternatively expand or collapse the throw location stack traces
of all the exception nodes, or click on a specific node to expand or collapse its throw location
stack trace only.

The results are cumulative over the lifetime of the session.
Related topics

• Thrown Exceptions (page 138)
• Setting Monitoring Session Preferences (page 117)
• Setting Data Collection Preferences (page 46)
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Monitor Memory and/or Heap Activity Menu

Heap Monitor
Displays free, committed, and used memory sizes in the heap and garbage collection events over
time. The used heap space includes live objects and dead objects that have not yet been collected
as garbage. Specifically, this visualizer shows the heap in use by objects in the eden space and
in the old and survivor generations, but does not include the permanent generation. (See Basic
Garbage Collection Concepts (page 103) if you are unfamiliar with these terms.)
This display indicates whether your application is doing many allocations, which typically
correspond to the load level, or if your application is idle.

Figure 39 Monitoring Metric: Heap Monitor

Guidelines

• Look for extra-wide garbage-collection bars, which correspond to garbage collection pauses.
These could cause transient service-level objective violations.
To reduce intermittent long garbage collection pauses try changing the garbage collection
algorithm with a JVM option. Refer to your JVM documentation.

• If the garbage collection events still take a long time, it may indicate a paging problem where
the physical memory available to the application is too small for the specified maximum size.
The remedies include:

◦ Decrease the maximum heap size, with a corresponding decrease in the maximum load
supported by your application.

◦ Remove other load from the system.

◦ Install more physical memory.
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• When you select a high level of detail, 1 to 20 minutes, and the heap size does not go to the
local maximum before a garbage collection happens, it could indicate excessive calls to
System.gc(). See Identifying Excessive Calls to System.gc() (page 51).

• When you select coarse granularity, 1 to 24 hours, you may notice the overall change of
behavior in heap size and garbage collection pattern. This can help with understanding the
correlation between the application load and the pressure on the heap.
If there is plenty of gray in selected areas of the display, this means that the heap was too
small for the load imposed on the application at that time.

Details
You can pause and resume (page 205) the display scrolling using the clock icon.
Related Topics

• Identifying Excessive Calls to System.gc() (page 51)
• Determining the Severity of a Memory Leak (page 53)
• Reviewing the Percentage of Time Spent in Garbage Collection (page 51)

Garbage Collections
Displays garbage collection events over the period that the application has been running and an
estimated percentage of time spent in garbage collection. These events include collection from the
young, old, and survivor objects in the heap. This display does not include objects in the permanent
generation space. (See Basic Garbage Collection Concepts (page 103) if you are unfamiliar with
these terms.) When running your application with Java 5.0.12 or later or with Java 6.0.01 or
later, the visualizer can show major versus minor garbage collections.

NOTE: For detailed garbage collection information, run your application with —Xverbosegc
or —Xloggc options and view the results in the GC viewer. See Obtaining Garbage Collection
Data (page 94) and Using Specialized Garbage Collection Displays (page 181) for information on
collecting and viewing garbage collection data in HPjmeter.

Figure 40 Monitoring Metric: Garbage Collections
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Guidelines

• For a healthy heap, minor collections should dominate major garbage collections. If the number
of minor collections is too small compared to the number of major garbage collections, the
young generation of the heap may be too small.

• If the heap size shown by garbage collections converges towards the heap limit, the application
has run out of memory, or soon will run out.

• If the old generation is too small, the application will run out of memory. If the total heap size
is too large compared to available physical memory, thrashing occurs.

• A value of 5 percent or less of time spent in garbage collection is acceptable. Values larger
than 10 percent usually indicate an opportunity for improvement.

• With a time span of more than one hour, you can identify possible memory leaks. See
Determining the Severity of a Memory Leak (page 53).

Details
Each point on the graph represents the heap size after a garbage collection completes; it represents
the amount of live memory at that time.
Frequent long garbage collections represent a potential problem, and will be coupled with a high
percentage of time spent in garbage collection. This percentage is displayed in the lower right of
the window.
Related Topics

• Identifying Excessive Calls to System.gc() (page 51)
• Determining the Severity of a Memory Leak (page 53)
• Checking for Long Garbage Collection Pauses (page 50)
• Reviewing the Percentage of Time Spent in Garbage Collection (page 51)
• Checking for Proper Heap Sizing (page 53)
• JMX Memory Tab (page 59)
• Obtaining Garbage Collection Data (page 94)
• Basic Garbage Collection Concepts (page 103)
• Using Specialized Garbage Collection Displays (page 181)

GC Duration
Displays the duration of each garbage collection noted.

Guidelines

• Expect collection times to vary with the size of the heap; the larger the heap, the longer
duration a normal GC will be.

• Collection times that are shorter or longer than expected for the heap size can indicate that
tuning garbage collection could improve performance.
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Details

• For HP Java 1.5.0.12 and later or 6.0.01 or later, this visualizer distinguishes between major
and minor garbage collections such as full GC and scavenge.

Related Topics

• GC Duration Alert (page 128)
• Checking for Proper Heap Sizing (page 53)
• Reviewing the Percentage of Time Spent in Garbage Collection (page 51)
• Allocated Object Statistics by Class (page 145)
• Identifying Excessive Object Allocation (page 54)
• Basic Garbage Collection Concepts (page 103)

Percentage of Time Spent in Garbage Collection
The percentage is an estimated value of the time spent in garbage collection.

Guidelines

• The horizontal red line shows the current average percentage of time spent in garbage
collection.

• An almost steady value of 5 percent or less is considered low and acceptable.

• Sustained values larger than 10 percent suggest room for improvement.

Using Monitoring Displays 143



Details
Here are two possible ways to make improvements:

• Tune the heap parameters for better performance. For HP HotSpot VM, run your application
with the -Xverbosegc option and view the results in HPjmeter.

• If the heap has been already tuned, you can decrease the application pressure on the heap,
that is, decrease the rate of object allocations, by trying these alternatives:

◦ Reusing objects

◦ Changing memory-inefficient algorithms
Object allocation statistics can help identify areas for improvement.

Figure 41 Monitoring Metric: Percentage of Time Spent in Garbage Collection

Related Topics

• Checking for Proper Heap Sizing (page 53)
• Reviewing the Percentage of Time Spent in Garbage Collection (page 51)
• Allocated Object Statistics by Class (page 145)
• Allocating Method Statistics (page 146)
• Identifying Excessive Object Allocation (page 54)

Unfinalized Objects
Shows a measure of the objects that have not been finalized at each garbage collection during
the monitoring period.
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Guidelines

• Escalating numbers of unfinalized objects can indicate that the finalizer queue is growing,
with associated objects holding increasing space in the heap.

Details

• Some or many of the objects in a finalizer queue may no longer be needed by the program
and are waiting to be finalized and then collected.

• Check to see if the finalize () method in your application is being called at appropriate
times and frequency.

• Profiling with –Xeprof will help you to obtain details about the number of unused finalizers
in the heap.

• Use the monitoring or profiling thread histogram to check the state of the finalizer thread
during the recorded period.

Related Topics

• Unfinalized Queue Growth (page 133)
• Thread Histogram (page 152)
• Reading Profiling Histograms (page 87)
• Profiling with -Xeprof (page 72)

Allocated Object Statistics by Class
Shows object allocation statistics according to the object type allocated.

Guidelines
A typical large Java application allocates a lot of strings. This value can reach 25 percent of all
allocations. If any other type, especially an application-defined type approaches or exceeds such
a value, it may indicate inefficient code.
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Details
For those classes that are instrumented (visible through the JVM agent verbose flag), every object
allocation in every method is instrumented to report allocations. However, sampling is used to
minimize overhead, so the metric reports allocation percentages, not total allocation counts. These
percentages are not absolute across the entire application, but are computed with respect to
allocations in instrumented classes.
Sampling minimizes overhead and focuses attention on user code. To discover allocation statistics
about application server classes, use the include and exclude filtering flags in the JVM agent
options.
The reported data is cumulative over the lifetime of the session, and accuracy will improve as the
session length increases.

Figure 42 Monitoring Metric: Allocated Object Statistics by Class

Related Topics

• Identifying Excessive Object Allocation (page 54)
• JVM Agent Options (page 27)
• “Data Sampling Considerations” (page 213)
• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Allocating Method Statistics
Shows the methods that allocate the most objects.
This metric is useful when you choose to decrease heap pressure by modifying the application
code.

Guidelines
Methods listed at the top should become the primary candidates for optimization.

Details
For those classes that are instrumented (visible through the JVM agent verbose flag), every object
allocation in every method is instrumented to report allocations. However, sampling is used to
minimize overhead, so the metric reports allocation percentages, not total allocation counts. These
percentages are not absolute across the entire application, but are computed with respect to
allocations in instrumented classes.

146 Using Visualizer Functions



Sampling minimizes overhead and focuses attention on user code. To discover allocation statistics
about application server classes, use the include and exclude filtering flags in the JVM agent
options.
The reported data is cumulative over the lifetime of the session, and accuracy will improve as the
session length increases.

Figure 43 Monitoring Metric: Allocating Method Statistics

Related Topics

• JVM Agent Options (page 27)
• Allocated Object Statistics by Class (page 145)
• “Data Sampling Considerations” (page 213)
• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Current Live Heap Objects
Use this visualizer to obtain an immediate data summary of live objects in the heap each time that
you click the Refresh Live Objects button. This can be especially useful when trying to understand
unexpected behavior in memory usage.
The display shows information for the classes of live objects found. It does not show indirect
references. See Table 22 (page 148).
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Figure 44 Monitoring Metric: Current Live Heap Objects

Table 22 Data Shown in Current Live Heap Objects Visualizer

DescriptionColumn Heading

Name of class to which object belongsClass

Percent of allocated heap used% Heap Used

Cumulative size occupied by the object (in bytes)Bytes

The total change in the amount of bytes held for this class since the first snapshot was
taken.

+/- First Bytes

The change in the amount of bytes held for this class since the last snapshot was
taken (most recent increment).

+/- Last Bytes

Number of current live instances of the object classCount

The total change in the number of objects held for this class since the first snapshot
was taken.

+/- First Count

The change in the number of objects held for this class since the last snapshot was
taken (most recent increment).

+/- Last Count

Details
When the heap is large with many objects, refreshing the snapshot will affect system performance
more than refreshing from a smaller heap with fewer objects.
Sort by any of the data types by clicking the column heading in the Current Live Heap Objects
table. Continue clicking on the same column heading to toggle the sort between ascending and
descending order for numerical columns and by alphabetical order for columns containing text.
You can copy all or part of the data displayed into a temporary buffer, then paste or append it
into a spreadsheet or other similar software using a keyboard shortcut.
To select a portion of the data, click and drag the cursor across the desired rows and columns of
data. The selected rows change color. Then click Copy Selection to Buffer in the tool bar to capture
the data.
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Figure 45 Copying Selected Current Live Heap Objects Data into Buffer

To select all data for use in a spreadsheet, click Copy All to Buffer in the tool bar.

Figure 46 Copying All Current Live Heap Objects Data into Buffer

Click File →Save to capture all data as an ASCII text file that you can save onto your local machine.
Related topics

• Heap Monitor (page 140)

Process Resident Memory
This feature displays the size of the resident memory for the Java process. This shows the amount
of physical memory that is used by the process. This data is obtained from the PROC_MEM_RES
attribute of Glance Plus. On HP-UX, the calculation of this metric differs depending on whether this
process has used any CPU time since the midaemon process was started. This metric is less accurate
and does not include shared memory regions in its calculation when the process has been idle
since the midaemon was started.
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Related Topics

• Heap Monitor (page 140)

• Process Virtual Memory (page 150)

Process Virtual Memory
This feature displays the size of the virtual memory allocated for the Java process. This shows the
overall virtual memory usage of the process. You can know how much virtual memory is being
used by your Java application over time. This data is obtained from the PROC_MEM_VIRT attribute
of Glance Plus. On HP-UX, this consists of the sum of the virtual set size of all private memory
regions used by this process, plus this process' share of memory regions which are shared by
multiple processes. For processes that use CPU time, the value is divided by the reference count
for those regions which are shared.

Related Topics

• Heap Monitor (page 140)

• Process Resident Memory (page 149)

Data Region Resident Memory
This feature displays the size of the total resident memory occupied by data regions of the Java
process. This metric helps to provide a measure of the size of the C heap for the process. The C
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heap is independent of the Java heap and is used to hold data for native code. This data is obtained
from the PROC_REGION_RES_DATA attribute of Glance Plus.

Related Topics

• Heap Monitor (page 140)

• Data Region Virtual Memory (page 151)

Data Region Virtual Memory
This feature displays the size of the total virtual memory occupied by data regions of the Java
process. This metric helps to provide a measure of the size of the C heap for the process. The C
heap is independent of the Java heap and is used to hold data for native code. This data is obtained
from the PROC_REGION_VIRT_DATA attribute of Glance Plus.

Related Topics

• Heap Monitor (page 140)

• Data Region Resident Memory (page 150)
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Monitor Threads and/or Locks Menu

Thread Histogram
Displays thread states over time. Thread data arrives in time slices. For each time slice, color-coded
bars represent the percentage of time the thread spent in each state. The reported states are:
Waiting The thread has been suspended using Object.wait() method.
Lock Contention The thread is delayed while attempting to enter a Java monitor that is

already acquired by another thread.
Running All remaining cases.

Guidelines

• Large amounts of red in Thread Histogram indicate heavy lock contention, which is usually a
possible problem. On the other hand, large amounts of green indicate a potential processing
capacity for the involved threads.

• When there is no load, the state for the threads doing the work on behalf of transactions
should be waiting, and marked by the green color.

• Threads terminating normally, or because of uncaught exceptions, appear as a discontinued
row.

• Multiple short-lived threads appear as apparently blank rows in the display. At the same time
the number of displayed threads, shown at the bottom of the display, is large.

• Lock Contention appears as red in the display.

• Deadlocked threads appear as two or more threads spending all their time in lock contention,
red, starting from a given time. This point in time identifies the deadlock occurrence.

Details
For each time slice, represented by a small portion of the X-axis, the display along the Y-axis shows
the percentage of the time slice that the thread spent in each state. It represents a stacked bar
graph for the time slice.

Figure 47 Monitoring Metric: Thread Histogram
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Related Topics

• Identifying Abnormal Thread Termination (page 54)
• Identifying Multiple Short-lived Threads (page 55)
• Identifying Excessive Lock Contention (page 55)
• Change Color Selection for Histogram Display (page 210)

Lock Contention
Provides lock contention statistics.
The percentages for each method represent how much of the total lock contention observed occurred
in that method. For example, if there was a single instance of lock contention during a run, that
method would show 100 percent. Therefore, methods that show a high percentage of lock contention
may not be a problem, unless you see a significant amount lock contention in your application.
Lock contention can be detected either in synchronized methods, or in methods that contain
synchronized blocks.

Guidelines

• Lock contention in a running application does not necessarily indicate a problem.

• If you suspect a lock contention problem with your application, you should look more closely
at the highest-ranked methods in the Lock Contention display.

• The Thread Histogram can also help you determine if there is significant lock contention. Other
system-level tools can also provide information to determine if there is excessive lock contention.

Details
This metric uses sampling to determine the level of lock contention. Therefore, this display shows
percentages of time wasted over the sampling period, not actual time wasted in lock contention.
The reported data is cumulative over the lifetime of the session.

Figure 48 Monitoring Metric: Lock Contention
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Considerations When Comparing Lock Contention and Thread Histogram Metrics:
Lock contention data is sampled less frequently than thread histogram data. When there is lock
contention with a short lifespan, a small amount of lock contention might appear in the Thread
Histogram, but not be shown in the Lock Contention percentages. This can happen when the
contention occurs during a time when the Thread Histogram sample is being taken, but the lock
contention sample is not.

Related Topics

• Thread Histogram (page 152)
• Identifying Excessive Lock Contention (page 55)
• Identifying Deadlocked Threads (page 55)
• Data Sampling Considerations (page 213)

Monitor Network/Sockets Menu
Displays the rate of incoming and outgoing data, and socket connections being communicated
over the network to and from the monitored application over time.

Incoming Socket Connections Frequency
This feature produces a graph that displays the rate at which the monitored application is accepting
socket connections. Specifically, this visualizer shows the number of incoming socket connections
per minute that are being received by the Java program. This display indicates whether your
application is handling many network connections.
Related Topic

• Network Input Stream (page 155)

Outgoing Socket Connections Frequency
This feature produces a graph that displays the rate at which the monitored application is connecting
to sockets of other applications. Specifically, this visualizer shows the number of outgoing socket
connections per minute that are being made by the Java program.
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Related Topic

• Network Output Stream (page 155)

Network Input Stream
This feature produces a graph that displays the rate of incoming data being provided from the
network to the monitored application. This visualizer shows the number of bytes being received
by sockets in the java.net package, per second.
Related Topic

• Incoming Socket Connections Frequency (page 154)

Network Output Stream
This feature produces a graph that displays the rate of outgoing data that the monitored application
is providing over the network to other applications. This visualizer shows the number of bytes being
sent via sockets in the java.net package, per second.
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Related Topic

• Outgoing Socket Connections Frequency (page 154)

Monitor JVM and/or System Activity Menu

Method Compilation Count
Displays a list of all the methods compiled from the time the session was opened, showing the
number of times a particular method was compiled.
The metric window reports “No methods compiled since the session opened.” until the next method
compilation occurs, and then the metric data appears.

Guidelines

• The normal values for this metric are single-digit numbers.

• If the top item or items show a much larger value than the rest of entries, and the value
constantly grows, it suggests excessive method compilation.

• Normally, a method is compiled once or just a few times, which results in a very flat profile,
with none of the entries showing large numbers.
However, a JVM may have a performance problem in which a certain method, or methods,
is compiled repeatedly. Such a problem manifests itself in one entry clearly dominating the
list and showing constant growth over time.
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Figure 49 Monitoring Metric: Method Compilation Count

Related Topics

• Identifying Excessive Method Compilation (page 56)
• Method Compilation Frequency (page 157)
• Find a Search Pattern (page 204)

Method Compilation Frequency
Produces a graph that shows the compilation frequency. This is a companion to the existing Method
Compilation Count. The Method Compilation Frequency metric provides a view of how much effort
the JVM is spending on method compilation.

Guidelines

• A typical profile shows a lot of compilations as a Java application is starting up, then it usually
goes down to a small number as things reach a steady state.

Figure 50 Monitoring Metric: Method Compilation Frequency
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Related Topics

• Identifying Excessive Method Compilation (page 56)
• Method Compilation Count (page 156)

Loaded Classes
HPjmeter displays the number of classes loaded into memory for processing. This number usually
stabilizes over time as processing progresses.

Guidelines

• The number of classes loaded at any one time tends to oscillate within a narrow range; typically
less than 2 percent of all loaded classes will be unloaded or reloaded during application
processing.

• If the number of loaded classes constantly grows, it indicates a possibility that the new classes,
possibly dynamically created, may eventually fill the available memory and cause the
application to crash.

Figure 51 Monitoring Metric: Loaded Classes

Related Topics

• Identifying Too Many Classes Loaded (page 57)
• Class Loaders (page 173)

Percent (%) CPU Utilization
Displays total system and process CPU consumption.

Guidelines

• Percentages are displayed as number of CPUs x 100%.

• Excessive use of CPU resources (greater than 80% of the total number of CPUs) may indicate
that the application load limit is close, even though the application may appear to be
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performing well. At higher consumption rates, CPU consumption can become a bottleneck to
good performance.

• When system CPU consumption is significantly higher than process consumption, this may
indicate that “alien” or undesired processes are using CPU resources that the preferred
application could be using. It may also indicate that the application is abusing the operating
system kernel.

Figure 52 Percent CPU Utilization for System and Processes

Related Topics

• Process CPU Usage Alert (page 131)
• System CPU Usage Alert (page 132)

System Call Rate
This feature displays the rate of HP-UX system calls over time. This metric currently provides
information about three systems calls related to threads:ksleep, kwakeup and sched_yield.
These values are indicative of thread behavior in Java applications. High rates for these system
calls can impact application performance.
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Related Topics

• Thread Histogram (page 152)
• Lock Contention (page 153)

Viewing Profiling or GC Data in HPjmeter
To view metrics for saved data:
• From the main console, click File→Open to open a file browser window and locate your saved

file. You can also drag and drop the file onto the console.
Selecting the file automatically opens a data viewer.
In addition, a data representation for your file appears in the console main pane.
Double-clicking this representation brings an already open viewer to the top or opens a new
viewer if the original viewer has been closed.

• Where available, use the Metrics and Estimate menus to access additional available metrics
and the Edit menu for special actions available for the different data types.

NOTE: A grayed-out menu item indicates that data is not available in the collected profile.

See also:
• Using Profile Displays (page 160)
• Using Specialized Garbage Collection Displays (page 181)
• Visualizer Behavior When Monitoring Behavior or Analyzing Data (page 134)

Using Profile Displays
Profiling metric displays are available from the Metrics and Estimate menus in the profiling viewer.
These visualizers display data collected with -Xeprof and hprof options. Note that the hprof
data does not provide both CPU and clock times.
The following figure shows a profile viewer as it appears when first opened.
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On the Summary tab, as with any field whose value is too long for its column width, if the JVM
Arguments value shown at the bottom of the upper panel is extensive and runs beyond its column,
you can mouse over the value to display a yellow pop-up box that shows all the JVM arguments.
When you mouse away from it, the yellow box disappears. However, if you double click the JVM
arguments value, a pop-up box displays and remains until you close it:
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The profile displays are categorized as follows under the Metrics menu:

• Profile Code and/or CPU Activity (page 163)
• Profile Memory and/or Heap Activity (page 168)
• Profile by Threads (page 175) (Threads/Locks submenu)
• Profile by Locks (page 177) (Threads/Locks submenu)
These heuristic displays appear under the Estimate menu:

• Inline Candidates (page 180)
• Exceptions Thrown (page 180)
• Memory Leaks (page 180)
See also:

• Profiling Applications (page 69)
• Using Visualizer Tool Bars (page 201)
• Viewing Profiling or GC Data in HPjmeter (page 160)
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Menu Choices
The menu bar can contain one or more of these choices, depending on the data type and visualizer
you are viewing:

• File — Contains selections for printing, saving, and comparing data, closing the window, or
opening another window that is viewing the same data file. Opening another window is useful
when you want to view more than one metric at the same time.

• Edit— When viewing eprof or hprof data, this menu provides the find functionality also
present on the tool bar for quickly navigating through tabular data. This menu also provides
two selections, Scale and Scale Special, that help to compensate for differences in time, for
example, when one or more files are being compared. See also Mark an Item for Search
(page 203) and Scaling Comparison Data (page 86)
When viewing vgc data, this menu contains options for manipulating or resetting the default
time interval seen in the graphical data presentation.
When monitoring an application, this menu contains options for selecting a portion or all of
the data set displayed in the Current Live Heap Objects visualizer.

• View — Provides mechanisms for hiding or revealing aspects of the window controls and
visualizer information, and when in the garbage collection viewer, provides many of the same
controls available from the button toolbar for manipulating the data display.

• Metrics — Contains these submenus and their associated profiling metrics:

Code/CPU◦
◦ Memory/Heap

◦ Threads / Locks

• Estimate — Provides heuristic profiling metrics that are estimated based on collected data.

• Sort — Provides a selector for choosing different ways to sort and display thread data. You
can sort threads chronologically, by combined weight (the default), by selected method usage,
by CPU usage, by lock contention, and by number of created objects.

• Scope — Provides selector for changing thread scope. You can look at scope by process,
thread, or thread group. See Adjusting Scope (page 83) for details.

• Tree— For call graph metrics, this menu provides controls for more quickly navigating the call
graph tree. See also Using Call Graph Trees (page 89).

• Help — Provides links to contextual help entries.

NOTE: Some profiling metrics may appear grayed out. These metrics may have been disabled
by specifying a JVM agent option. To obtain data with these metrics enabled requires running the
application with the appropriate JVM option.

Profile Code and/or CPU Activity
This section contains metrics that are derived from other metrics. The derived metrics are marked
by an asterisk (*). They are usually less frequently used, as they not always are immediately useful
in detecting performance bottlenecks. For each metric that presents the average values per call,
only methods called at least twice are taken into account.

Method Call Count
Use this metric visualizer to see the methods called, the callers of each method, and the cumulative
number of calls from each caller.
The methods are sorted by decreasing number of calls. Listed to the left of each method is the
number of times it was called. By default, the list of methods includes the package in which each
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one is located. The gray horizontal bars provide a graphical representation of the number of times
a method was called.
Double-click the method name to see a list of its callers with the cumulative number of calls from
each caller.
Related Topics

• Approaches to Analyzing Performance Data (page 81)
• Profiling with -Xeprof (page 72)
• Profiling with -agentlib:hprof (page 76)
• Data Sampling Considerations (page 213)
• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Exclusive Method Times (CPU)
Use this visualizer to see CPU time spent by methods found in the captured data. CPU time spent
is given in milliseconds, and for each method, as a percentage of all CPU time used during the
capture period. Times are exclusive times.
A remark "(virtual times)" may be displayed after the metric title, if the collected times are
virtual CPU times.
The methods are sorted by decreasing time spent in CPU. The gray horizontal bars provide a
graphical representation of the time a method spent (in milliseconds) for the period of the collected
sample.
Other data shown include packages and arguments associated with each method.
Related Topics

• Average Exclusive Method CPU Times* (page 166)
• Profiling with -Xeprof (page 72)
• Profiling with -agentlib:hprof (page 76)
• Approaches to Analyzing Performance Data (page 81)
• Inclusive Versus Exclusive Time (page 82)
• Time Units (page 82)
• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Exclusive Method Clock Times
The standard Java methods java.lang.Thread.sleep and java.lang.Object.wait are
not included in this metric. This is because usually the time spent in these methods is a few orders
of magnitude larger than in any other method. At the same time, the total time spent in sleep or
wait has hardly any relationship to any possible performance bottlenecks, and including these two
methods would only distract the user.
Related Topics

• Inclusive Versus Exclusive Time (page 82)
• Time Units (page 82)
• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)
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Call Graph Tree with Call Count
The call graph with the method call count.
Related Topics

• Using Call Graph Trees (page 89)
• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Call Graph Tree with CPU
The inclusive CPU time shown on the call graph.
Related Topics

• Using Call Graph Trees (page 89)
• Inclusive Versus Exclusive Time (page 82)
• Time Units (page 82)
• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Call Graph Tree with Clock Time
The inclusive clock time shown on the call graph.
Related Topics

• Using Call Graph Trees (page 89)
• Inclusive Versus Exclusive Time (page 82)
• Time Units (page 82)
• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Inclusive Method CPU Times
A remark “(virtual times)” may be displayed after the metric title, if the collected times are virtual
CPU times. To see all callers of a given method with the accumulated inclusive CPU time spent in
all calls to this method, double click on the method name.
Related Topics

• Inclusive Versus Exclusive Time (page 82)
• Time Units (page 82)
• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Inclusive Method Clock Times
To see all callers of a given method with the accumulated inclusive clock time spent in all calls to
this method, double click on the method name.
Related Topics

• Inclusive Versus Exclusive Time (page 82)
• Time Units (page 82)
• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)
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Average Exclusive Method CPU Times*
Exclusive CPU Method Time divided by the number of calls to the method. This is the average CPU
cost for the body of the method.
Related Topics

• Inclusive Versus Exclusive Time (page 82)
• Time Units (page 82)
• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Average Exclusive Method Clock Times*
Exclusive Clock Method Time divided by the number of calls to the method. This is the average
time spent within the method.
Related Topics

• Inclusive Versus Exclusive Time (page 82)
• Time Units (page 82)
• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Average Inclusive Method CPU Times*
Inclusive CPU Method Time divided by the number of calls to the method. This gives the average
CPU cost for a high-level operation.
Related Topics

• Inclusive Versus Exclusive Time (page 82)
• Time Units (page 82)
• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Average Inclusive Method Clock Times*
Inclusive Clock Method Time divided by the number of calls to the method. This gives the average
turn-around (response) time for a high-level operation.
Related Topics

• Inclusive Versus Exclusive Time (page 82)
• Time Units (page 82)
• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Starvation by Method*
Shows the starvation for each method. For our purposes, starvation is defined as time unaccounted
for. During this time, the thread was not suspended by java.lang.Thread.sleep or
java.lang.Object.wait, and it was not delayed at the monitor lock entry. The thread was
runnable (in the Java sense), yet it was not running; that is, the context had switched out.
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These are possible reasons for reported starvation:
• the real starvation caused by the operating system scheduler - this should be distributed over

all methods in proportion to the exclusive CPU time consumed by each method
• waiting for the class loader to load a class
• waiting on an internal VM lock (mutex)
• time consuming system calls
• explicit or implicit Garbage Collection invocation (frequent or massive memory allocation by

the method)
• excessive virtual memory paging
• suspending the thread by external means (i.e. by a debugger)
Related Topics

• Class Loaders (page 173)
• Inclusive Versus Exclusive Time (page 82)
• Time Units (page 82)
• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Starvation Ratio*
Shows the starvation (see above) divided by the Exclusive Method Clock Time for each method.
Values close to one indicate that the method did not consume CPU, but nevertheless delayed
execution of the program. Such methods are worthwhile to investigate to understand the reason
of their behavior.
Related Topics

• Inclusive Versus Exclusive Time (page 82)
• Time Units (page 82)
• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Methods with Loops*
This metric tries to locate the most intensive loops in the application. The value is the average
number of times a loop within a given method was executed over all invocations of the method.
The actual loops are not instrumented (measured), and the calculations are based on the call counts
collected for the call graph, so the metric always provides only an estimate.
Related Topics

• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Exclusive Class CPU Times*
The total of the Exclusive Method Times (CPU), summed over all methods of the class. To see the
list of all contributing methods, double click on the class name.
Related Topics

• Inclusive Versus Exclusive Time (page 82)
• Time Units (page 82)
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• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Exclusive Class Clock Times*
The total of the Exclusive Method Times (Clock), summed over all methods of the class. To see the
list of all contributing methods, double click on the class name. The standard methods
java.lang.Thread.sleep and java.lang.Object.wait do not contribute to this metric, however, they
will be shown on the list of all contributing methods for the respective classes.
Related Topics

• Inclusive Versus Exclusive Time (page 82)
• Time Units (page 82)
• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Profile Memory and/or Heap Activity
Most of the heap metrics are available only when analyzing a heap dump file. When using the
hprof tool to generate a heap dump, use the profiling option -agentlib:hprof=heap=all.
See the metrics table to check how to collect the profile data in order to obtain a specific metric.
The types of objects allocated on heap are classes and arrays. If the profile data file does not
contain the specific information related to objects, HPjmeter estimates Objects Created by Method
and Created Objects (Count) based on the number of class constructors called. In such cases, you
will see "(data estimated)" next to the metric label.
The estimation entirely misses the arrays, and may report inaccurate numbers. Some of the calls
to constructors may remain unprofiled, or be not recognized as such by HPjmeter. It is also possible
to err on the plus side, when HPjmeter does not properly recognize the class hierarchy.
These metrics – Reference Graph Tree, Reference Sub-tree by Size, Residual Objects (Count), and
Residual Objects (Bytes) – show the residual objects. These are objects remaining on the heap at
the time the profile data file is written.

Objects Created by Method
Number of objects of all types created by each method. Double click on the method name to see
the distribution of the number over object types.
Related Topics

• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Created Objects (Count)
Number of objects of a given type, created by all methods, presented by object types. Double
click on the object type to see which methods created the objects.
Related Topics

• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Created Objects (Bytes)
Number of bytes occupied by objects of a given type, created by all methods, presented by object
types. Double clicking on the type name provides a list of allocation sites (methods) with the number
of bytes allocated by each listed method.

168 Using Visualizer Functions



Related Topics

• Allocation Site Statistics (page 185)
• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Live Objects (Count)
The number of live objects presented by object types. Live objects are those that could be accessed
through a chain of references from the set of program variables when the heap dump took place.
Related Topics

• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Live Objects (Bytes)
The number of bytes occupied by live objects of a given type, presented by object types.
Related Topics

• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Live Array Sizes
The list of all live arrays remaining in the heap, sorted by their size.
Related Topics

• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Unfinalized Objects
The number of objects with pending finalization, arranged by their type and sorted by the number
of objects of each type. These are all objects with the finalize() method available, but not yet
invoked.
Related Topics

• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)
• Threads Histogram (page 175)
• Unfinalized Objects (page 144)
• Unfinalized Queue Growth (page 133)

Reference Graph Tree
Shows all live objects and references between them.
Expanding the nodes shows which references a given object holds.
HPjmeter uses heuristics to detect soft or weak references and uses special symbols ~-> for them,
while the hard (regular) references are marked by ->. Double-click on an object to view additional
information: all references to the object, and the number of bytes held in the heap by this object.
This number is the total amount of bytes that could be reclaimed by garbage collection if all
references to this object were nullified. This piece of information is sticky — once this value is
calculated for an object, it will be displayed in the Reference Graph.
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Displaying large reference graphs puts a lot of stress on the underlying Swing components, so
please be patient when dealing with huge heap dumps.
Related Topics

• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)
• Class Loaders (page 173)

Reference Sub-Trees by Size
This visualizer shows the cluster of objects that are directly or indirectly referenced from the root
of the tree, along with the cumulative size of all the references.
This metric is similar to Reference Graph Tree, with the following differences:

• You can see the amount of memory allocated to a sub-tree (a node and its contents) as well
as to the node itself. The memory held by the node appears in parentheses ( ), and the memory
held by the sub-tree appears in brackets [ ].

• The table on the right side displays object and primitive values for any selected node object
in the tree.

In Figure 53, an object of type VecTest3 is selected in the tree. The table on the right is showing
the Attributes tab, which displays a list of the non-static fields in the object.

Figure 53 Reference Sub-Trees by Size Visualizer – Attributes table

NOTE: The symbol // indicates a reference for which memory occupied has already been
counted elsewhere in the tree, and therefore, it is not included in the memory held by the parent
node of this particular reference.
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Object and Primitive Value Tables
For binary heap dump files, the tables on the right side of this visualizer display object and primitive
values for any selected node object in the tree:
• The Attributes table shows the names and values of the non-static fields in the node object.

• The Statics table shows the names and values of the static fields in the node object.
Notice that the table content changes as you choose different tree nodes. If you click the tree root
node, all root node information is shown in the Attributes table. If the table size is not large enough
vertically, use the scroll bar to view more data.

NOTE: The values of fields and arrays of primitive types are available only for binary heap dump
files, not for ASCII heap dump files.

The Attributes and Statics tables have 3 columns: Type, Name, and Value. The type of data in the
Value column will differ depending on the data type (see Figure 53 for the examples given below):
• For the eight primitive types (boolean, byte, char, short, int, long, float, and

double), the Value column shows the real value. For example, the Attributes table for the
selected object node shows an int type with a value of 1, and a boolean type with a value
of true.

• For instances, classes, and arrays (except string and char arrays), the Value column shows
the object id. For example, the Attributes table for the selected object node shows an array
type MyElement3[ ] with an object id value of 74afb930.

• For string and char arrays, see “String and char arrays” (page 172).
In Figure 54, the same object node (VecTest3) is selected in the tree, but with the table showing
the Statics tab, which displays a list of the static fields in the object.

Figure 54 Reference Sub-Trees by Size Visualizer – Statics Table
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String and char arrays

For string and character arrays, the Value column has been enhanced to show the string or char
value, not the object id, in the table cell. In Figure 55 (page 172), for example, the Attributes table
for the selected object node shows a String type with a value beginning with ‘There either
is or is not,…’, which is too long to fit in the table. If a string is too long, you can mouse
over it to display a tooltip pop-up box containing the entire string. You can also double-click the
string value to display a pop-up window containing the entire string content, which remains until
you close it.

Figure 55 Long String Pop-up Box

For char arrays, the Value column shows the character value for each element of the array:
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Figure 56 Character array

Related Topics

• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Class Loaders
This visualizer displays the name and count of class loaders found operating in the application.
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Figure 57 Class Loaders Visualizer

You can double click one of the listed class loaders to get a pop-up window displaying the class
types that have been loaded by that class loader. You can then mark a type and look for it in the
other visualizers:

Figure 58 Class Types Pop-up Window
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Guidelines

• Class types reside in the Permanent Generation space, which is usually more limited in size
than other areas of memory. Continuing incorporation of additional instances of a class loader
can begin to fill this area, creating an out-of-memory error in the Perm Gen region of memory.
Check the Class Loaders metric — are the number of instances of each class loader what you
expect?

• Use Mark and Find functions in the visualizers to locate references to the class loader and its
loaded classes in other related visualizers. Do you find any classes that you think should have
been garbage collected, but are not? Note how much space is held by the class loader.
Garbage collection cannot be thorough when application code has created a reference that
is keeping the class loader and its classes active beyond the time they are needed in the
program.

TIP: If you have instrumented the application with Java Management Extensions, you can also
open a monitoring session in HPjmeter and use the JMX Memory Tab (page 59) to quickly observe
a rough gauge of activity in various regions of the allocated memory, including the Perm Gen and
the Survivor space. See Using the JMX Viewer (page 57) for additional information.

Related Topics

• Identifying Too Many Classes Loaded (page 57)
• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)
• Reference Graph Tree (page 169)
• Reference Sub-Trees by Size (page 170)
• Residual Objects (Count) (page 175)
• Unfinalized Objects (page 169)
• Profiling with -agentlib:hprof (page 76)

Residual Objects (Count)
The number of residual objects presented by object types. Residual objects are those remaining
on the heap while the heap dump occurred. Not all residual objects are live.
Related Topics

• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Residual Objects (Bytes)
The number of bytes occupied by residual objects of a given type, presented by object types.
Related Topics

• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Profile by Threads

Threads Histogram
This visualizer shows all threads created by the application. The horizontal bars represent the
lifetime of the threads with respect to the lifetime of the whole application. An explanation follows
the image.
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Figure 59 Threads Histogram with Pie Chart

Thread state indicator
The colored areas of each line or line segment show relative proportions of time that a thread has
spent in a particular state. Double-click anywhere on the line to open the pie chart and see actual
percentages for the states of the selected thread.
Color change

In this image, the default color for starvation has been changed from white to purple using the
color chooser.
Use the selections in the Sort menu to change the criteria by which the threads are ordered and
presented. See Menu Choices (page 163)
Related Topics

• Reading Profiling Histograms (page 87)
• Change Color Selection for Histogram Display (page 210)

Thread Groups Histogram
This visualizer presents all thread groups created by the application. The horizontal bars represent
the lifetime of the thread groups, with respect to the lifetime of the whole application. The lifetime
of the thread group is defined as the time span between the creation of the first thread belonging
to the group and the death of the last thread belonging to the group.
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Figure 60 Threads Groups Histogram

Slider
In this metric visualizer, the slider lets you extend the view to encompass either the thread or thread
group view or a portion of both views.
Related Topics

• Reading Profiling Histograms (page 87)
• Change Color Selection for Histogram Display (page 210)

Profile by Locks
The lock delay is a measure for lock contention. The delay is caused by the lock being busy, and
is larger if the thread holding the lock is spending much time within the monitor, or when there are
many threads attempting to enter the same monitor.
Do not confuse lock delay with the time spent in the java.lang.Object.wait() method, or
with the time spent by a given thread within a Java monitor.
Lock metrics are produced only by the -Xeprof profiling option.
Note that the lock metrics do not show individual locks, but only values accumulated over all locks
used by a given method. Most methods, however, contain only one synchronization statement or
none at all, so identifying the contended lock should be easy if the source code is available.
Uncontested locks remain unprofiled for two reasons:
• Many locks are in use by a Java program, not always as the programmer's conscious choice.

For example, a java.util.Hashtable object used exclusively by only one thread or
accessed within a monitor, may be “synchronized” upon multiple times, yet with today's
advanced JVM technologies this behavior creates no penalty for the application performance.
Lock claims for such objects are not helpful to present.

• Because of the ubiquitous synchronization in many Java standard packages, profiling all locks
would be detrimental to the profiler's performance.

Using Profile Displays 177



This section contains some metrics derived from other metrics. The derived metrics are marked by
an asterisk (*). They are usually less frequently used, as they not always are immediately useful in
detecting performance bottlenecks. For each metric that presents the average values per call, only
methods called at least twice are taken into account.
The following metrics are available.

Contested Lock Claims by Method
The number of all attempts by individual methods to acquire a Java monitor lock while the lock
was being held by another thread, thus entailing a delay, even if only a very short one.
Related Topics

• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

All Lock Claims by Method
The number of all Java monitor locks acquisitions by individual methods. The data is inherently
incomplete, because the metric is accumulated only since the first lock conflict for each lock. You
will see “partial data)” displayed after the metric label.
Related Topics

• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Lock Delay - Method Exclusive
Accumulated lock delay, wasted in the method acquiring the lock(s). The lock delay is the time
between an attempt to get the lock and the actual acquisition of the lock.
Related Topics

• Inclusive Versus Exclusive Time (page 82)
• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Lock Delay - Call Graph Tree
The inclusive lock delay shown on the call graph. Be sure to read the page on using the trees.
Related Topics

• Using Call Graph Trees (page 89)
• Inclusive Versus Exclusive Time (page 82)
• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Lock Delay - Method Inclusive
Accumulated lock delay, wasted in the method acquiring the lock(s) and all methods called from
it and their descendants.
Related Topics

• Inclusive Versus Exclusive Time (page 82)
• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)
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Lock Contention Ratio by Method*
Contested Lock Claims divided by All Lock Claims for each method. This gives the average frequency
with which the method encountered a taken lock. A method must have claimed a lock at least five
times to be included in this metric.
Related Topics

• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Average Exclusive Method Lock Delay*
Method Exclusive Lock Delay divided by the number of calls to the method. For synchronized
methods, this is the average delay caused by calling the method.
Related Topics

• Inclusive Versus Exclusive Time (page 82)
• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Exclusive Method Lock Delay / Clock Time*
Method Exclusive Lock Delay divided by the Exclusive Clock Time. For each method, this gives the
ratio of time wasted on synchronization to the total time spent in the method.
Related Topics

• Inclusive Versus Exclusive Time (page 82)
• Time Units (page 82)
• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Average Inclusive Method Lock Delay*
Method Inclusive Lock Delay divided by the number of calls to the method. This gives the average
delay caused by synchronization for a high-level operation.
Related Topics

• Inclusive Versus Exclusive Time (page 82)
• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Inclusive Method Lock Delay / Clock Time*
Method Inclusive Lock Delay divided by the Inclusive Clock Time. For each high-level operation,
this gives the ratio of time wasted on synchronization to the total time spent in the operation.
Related Topics

• Inclusive Versus Exclusive Time (page 82)
• Time Units (page 82)
• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Exclusive Class Lock Delay*
The total of the Exclusive Method Lock Delay, summed over all methods of the class. To see the list
of all contributing methods, double click on the class name. If a class is used as a monitor with
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many synchronized methods, the individual methods may not exhibit excessive lock contention,
but the problem might get visible using this metric.
Related Topics

• Inclusive Versus Exclusive Time (page 82)
• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)

Using Heuristic Metrics from the Estimate Menu
HPjmeter provides three estimated measures to aid in narrowing the field of your problem-solving
or performance tuning inquiry.

Inline Candidates
Use this estimate to see a list of packages, classes, and methods that are possible candidates for
inlining activity during processing. For some candidates, the table lists amount of time estimated
to be wasted during the execution of the method.
Use the Mark button to capture the method name, then use Find in other tabular metric visualizers
to locate the method in relation to the other data presented.
Related Topics

• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)
• Using Heuristics to Locate Possible Hot Spots (page 92)

Exceptions Thrown
Use this estimation to obtain a list of methods, packages, and classes and a count of thrown
exceptions associated with each method or package.
Use the Mark button to capture the method name, then use Find in other tabular metric visualizers
to locate the method in relation to the other data presented.
Related Topics

• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)
• Using Heuristics to Locate Possible Hot Spots (page 92)
• Thrown Exceptions (page 138)(available in monitoring mode)

Memory Leaks
Use this estimation to obtain a list of packages and package types where leaks are suspected to
be occurring, and the amount of memory associated with each listed package.
Use the Mark button to capture the package name, then use Find in other tabular metric visualizers
to locate the method in relation to the other data presented.
Related Topics

• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)
• Using Heuristics to Locate Possible Hot Spots (page 92)
• How Memory Leak Detection Works (page 214)
• Java Collection Leak Locations Alert (page 129) (available in monitoring mode)
• Array Leak Locations Alert (page 130) (available in real-time mode)
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Using Specialized Garbage Collection Displays
GC data displays are available immediately on opening a .vgc file that was generated by running
your application with -Xverbosegc or -Xloggc options. This data is presented in the following
visualizers:

• Heap Usage After GC (page 181)
• Duration (Stop the World) (page 182)
• Cumulative Allocation (page 183)
• Creation Rate (page 184)
• Allocation Site Statistics (page 185)
• User-Defined X-Y Axes (page 191)
• Multiple User-Defined (page 192)
• Glance Data (page 194)
• Glance System Call Data (page 198)
See also:

• Basic Garbage Collection Concepts (page 103)
• Profiling Applications (page 69)
• Using Visualizer Tool Bars (page 201)
• Viewing Profiling or GC Data in HPjmeter (page 160)
For an explanation of Java memory terminology, see the Sun Developer Network publication
Memory Management in the Java HotSpot™ Virtual Machine (.pdf)
For an explanation of Java memory terminology, see the Sun Developer Network publication
Memory Management in the Java HotSpot™ Virtual Machine
(http://java.sun.com/j2se/reference/whitepapers/memorymanagement_whitepaper.pdf)

Heap Usage After GC
This visualizer shows heap usage in the eden space and in the old, survivor, and permanent
generations after each garbage collection. When viewed with consideration of the type of each
event, this graph provides a general picture of the heap resources minimally required by an
application.

NOTE:
Difference in Display of Garbage Collection in the Heap Monitor and the Heap Usage After GC
Visualizers
Monitoring visualizers like the Heap Monitor show only object data from the eden, survivor, and
old generation spaces. Visualizers that display GC data, like the Heap Usage After GC visualizer,
show object data from the permanent generation, as well as from the eden, survivor, and old
generation spaces.

Using Specialized Garbage Collection Displays 181

http://java.sun.com/j2se/reference/whitepapers/memorymanagement_whitepaper.pdf


Figure 61 GC Metric: Heap Usage After GC

Related Topics

• Using Visualizer Tool Bars (page 201)
• Changing Time Interval in GC Data Visualizers (page 206)
• Basic Garbage Collection Concepts (page 103)
• Current Live Heap Objects (page 147) (available in monitoring mode)
• Heap Usage Alert (page 129) (available in monitoring mode)

Duration (Stop the World)
This visualizer shows the amount of stop-the-world time spent for each garbage collection event.
A well-tuned application shows a relatively large number of short scavenges with less frequent,
but more expensive, full garbage collections.
This graph is also useful for exposing the cost of explicit System.gc() method calls within an
application, which often result in expensive and unneeded garbage collection overhead.
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Figure 62 GC Metric: Duration

Related Topics

• Using Visualizer Tool Bars (page 201)
• Changing Time Interval in GC Data Visualizers (page 206)
• Basic Garbage Collection Concepts (page 103)
• Identifying Excessive Calls to System.gc() (page 51) (available in monitoring mode)

Cumulative Allocation
This visualizer shows the cumulative amount of storage for new objects requested by the application
over time, which can indicate the overall progress of the application. Because the rate at which
an application creates new objects is often an indicator of its performance, changes in the slope
of this curve may indicate opportunities for tuning garbage collection.
To see a more dramatic presentation of incremental changes in object creation, see the Creation
Rate (page 184) visualizer.
Note that storage recovered by the garbage collector for unused objects is not deducted from the
cumulative amount.
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Figure 63 GC Metric: Cumulative Allocation

Related Topics

• Using Visualizer Tool Bars (page 201)
• Changing Time Interval in GC Data Visualizers (page 206)
• Basic Garbage Collection Concepts (page 103)
• Creation Rate (page 184)

Creation Rate
This panel shows the incremental object creation rate for the application as observed at each
garbage collection event. The increment at each data point is the amount of elapsed time since
the previous GC event.
The rate of object creation can be a good measure of your application's overall performance. By
correlating GC events with changes in the object creation rate, you can discover opportunities for
improving this performance through heap parameter tuning.
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Figure 64 GC Metric: Creation Rate

Related Topics

• Using Visualizer Tool Bars (page 201)
• Changing Time Interval in GC Data Visualizers (page 206)
• Basic Garbage Collection Concepts (page 103)

Allocation Site Statistics
This visualizer displays the sites (methods) in the JDK and user's Java code where objects have
been created. The display includes the number of objects created at each site (Invoke Count), the
percent of memory allocated to the objects generated by the compiled portion of the running Java
application (% Allocated), the average size of each object in bytes (Average Size (Byte)), and the
amount of memory occupied by the objects (Bytes Allocated). This metric is useful when you choose
to decrease heap pressure by modifying the application code.
The data displayed in this visualizer can be refreshed from the verbose GC file during the collection
period by clicking the button. The data display shows the cumulative results of all the dumps of
the allocation sites statistics collected up to that point or the different allocations separated by time.

Requires use of  -XX:+PrintAllocStatistics in the run command:
See Collecting Allocation Site Statistics for Viewing in HPjmeter (page 98) for an example of
command syntax.

Allocation sites can originate from interpreted as well as compiled Java code. When specifying
–XX:+PrintAllocStatistics, only allocations from compiled code are reported. However,
because the Java Virtual Machine detects and compiles the most active Java methods as early as
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possible, the most active allocation sites (the sites most likely to cause GC performance problems)
are reported.
The allocation data can be displayed as either combined or separated time sets. Use the toolbar
button combined (the default) and separated to toggle between them.

When the button is toggled to combined, the clock button is disabled, and the background color
is white. The default sort on this table is determined by % Allocated, and values in this column are
displayed in descending order, from greatest area of memory use to least. Making code changes
first in the area where memory use is greatest can have more significant impact on the heap. The
Combined Sets and Show Clock Time entries are also listed under the View menu.

Figure 65 GC Metric: Combined Sets of Allocation Site Statistics

When the button is toggled to separated, a Time column is added to the left side of the table to
display the time at which the allocations were made, and the clock button on the toolbar is
enabled to let you choose clock time or elapsed time. If the table has more than one time set, the
background color of the first set will be white, the second will be gray, the third will be white
again, and so on. The default sort on this table is determined by Time, with values in this column
displayed in ascending order.
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Figure 66 GC Metric: Separated Sets of Allocation Site Statistics.

The filter button opens a pop-up dialog box where you can provide various filters to narrow
down the data. A Filter entry is also listed under the Edit menu.
If the sets are combined, the columns and filter dialog box show as combined. With the filter dialog
box still displayed, pressing the Toggle Allocation Data into Combined or Separated Sets button
would then show the columns and filter dialog box as separated. Enter filter field values to narrow
down the data and then click Apply Filters for the results. To display the complete Allocation Site
Statistics table again, click Reset and Apply Filters.
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Figure 67 GC Metric: Allocation Site Statistics - Combined Sets, Filter Dialog Box
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Figure 68 GC Metric: Allocation Site Statistics - Separated Sets, Filter Dialog Box

Filter Field Descriptions:
• Time – Only visible for separated sets. Select the time set from the dropdown list, which contains

a sorted list of all time sets for the GC file. If there is more than one time set, the value All is
also listed, which if chosen will display all time sets for this GC file in the table.

• % Allocated – Choose the equality = (the default), or one of the the comparative operators (>
or <) from the dropdown list, and then supply a percentage value in the text field using
numbers 0-9, and the decimal point (.) or percent (%) characters. Both 0.01 and 0.01% will
supply a filter value of .01%.

• Bytes Allocated – Use the equality or comparitive operators and supply a numerical value in
the text box.

• Invoke Count – Use the equality or comparitive operators and supply a numerical value in the
text box.

• Average Size – Use the equality or comparitive operators and supply a numerical value in the
text box using numbers 0-9, and optional comma. Both 10,000 and 10000 will supply a
filter value of 10,000.

• Allocation Site – Enter any characters to match an allocation site listed in the table. Wildcards
are allowed. You can enter the entire string or part of a string, making sure to match lowercase
and uppercase. If an allocation site listed as a row in the table contains more than one string
entered in the filter, any string that matches will match that row.

• Type – Enter any characters to match an allocation site type listed in the table. Wildcards are
allowed. You can enter the entire string or part of a string, making sure to match lowercase
and uppercase.
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How a Snapshot of Allocation Sites Statistics is Shown in GC Visualizers

Figure 69 Presentation of Allocation Sites Statistics and Xverbosegc Data Collected During the Same
Time Period
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Figure 70 Presentation of Allocation Sites Statistics and Zero Preparation GC Data Collection During
the Same Time Period

Related Topics

• Collecting Allocation Site Statistics for Viewing in HPjmeter (page 98)
• Collecting GC Data with Zero Preparation (page 99)
• Using Visualizer Tool Bars (page 201)
• Basic Garbage Collection Concepts (page 103)
• Identifying the Site of Excessive Object Allocation (page 54)

User-Defined X-Y Axes
This visualizer is supplied to help you to experiment with your own combinations of data gathered
by -Xverbosegc or -Xloggc.
Select variables for the X and Y axes from the drop-down lists. HPjmeter plots the X-Y relationships
for your captured data file. For a partial list of available metrics, see -Xverbosegc and -Xloggc
Options and Their Corresponding Metrics (page 101).
For some user-defined selections, it is possible that the data capture obtained the GC type without
being able to ascertain the numerical value of the data point. Data points with unknown numerical
values are shown in gray near zero (0) on the X or Y axis of a graph. To determine the GC type
of a data point, check the color in the legend given below the graph.
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Figure 71 User-Defined Comparisons of GC Metrics

Related Topics

• Using Visualizer Tool Bars (page 201)
• Changing Time Interval in GC Data Visualizers (page 206)
• Basic Garbage Collection Concepts (page 103)

Multiple User-Defined
This visualizer is supplied to help you experiment with your own combinations of data gathered
by -Xverbosegc or -Xloggc, including Glance Data (page 194) that you might have collected.
The Heap Usage After GC metric is shown by default.
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Figure 72 Multiple User-Defined Metrics

Click the toolbar button to open a metric configuration pop-up box that lets you select the metrics
you want to display:

Figure 73 Multiple User-Defined Metric Configuration Box

Choose the Metric Selection Mode by clicking the Single or Multiple metric radio button. Then click
the check boxes to select the desired metric or combination of metrics. When you check a metric,
it is immediately added to the chart. Uncheck it, and it is removed from the chart.
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When displaying multiple metrics, HPjmeter tries to share the default y-axis if possible. If not, it
creates additional y-axes to the right of the graph, in units appropriate to the selected metrics. For
example, Figure 72 (page 193) shows four metrics, but only three y-axes. The units for the Heap
Usage After GC and Old After metrics are MBytes, so they share the same default MBytes y-axis
to the left of the graph. The GC Count units are in integers (indicated by Count), and the Cumulative
GC Duration units are in seconds, so they are each given their own y-axis.
For a partial list of available metrics, see -Xverbosegc and -Xloggc Options and Their Corresponding
Metrics (page 101).
If Glance data was collected, then the Glance metrics are also included for selection in the metric
configuration pop-up box.
Related Topics

• Using Visualizer Tool Bars (page 201)
• Glance Data (page 194)
• Changing Time Interval in GC Data Visualizers (page 206)
• Basic Garbage Collection Concepts (page 103)

Glance Data
The Glance Adviser visualizer displays a subset of HP GlancePlus metrics collected during a Java
application run.

Requires use of the /opt/hpjmeter/bin/javaGlanceAdviser.ksh command to collect
Glance data:
See Collecting Glance Data for Viewing in HPjmeter (page 98) for an example of command syntax.

The metrics display as the Y-axis values on the graph. These metrics provide information about the
global state of the HP-UX server and the specific process that was selected by process id (pid)
when the Glance data collection was started. By default, the visualizer displays the Process CPU
metric:
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Figure 74 GC Metric: Glance Data

You can display a different Glance metric or a combination of multiple metrics using the toolbar
button. This opens a metric configuration pop-up box that lets you select the metrics you want to
display:
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Figure 75 Glance Data Metric Configuration Box

Click the Single or Multiple metric radio button to choose the Metric Selection Mode. Then click the
check boxes to select the desired metric or combination of metrics. When you check a metric, it
is immediately added to the chart. Uncheck it, and it is removed from the chart.
You can also view these metrics together with GC metrics and Glance system call metrics on the
Multiple User-Defined tab.
Table 23 (page 196) describes the metrics available for display in the metric configuration pop-up
box of the Glance Adviser visualizer. For additional detail on these metrics, see the HP GlancePlus
for HP-UX Dictionary of Operating System Performance Metrics provided with your HP GlancePlus
product.

Table 23 Metrics Shown in Glance Adviser Visualizer

Description
HP GlancePlus Dictionary
Metric Name

Glance Adviser Metric
Name

Percent of available swap space that was being used by
running processes in the interval.

GBL_SWAP_SPACE_UTILGlobal Swap Utilization

Percentage of file table entries currently used by file
descriptors.This metric is updated every 30 seconds or the
sampling interval, whichever is greater.

TBL_FILE_TABLE_UTILGlobal File Table

Percentage of time the CPU was not idle during the interval.GBL_CPU_TOTAL_UTILGlobal CPU

Percentage of time the CPU was in system mode during the
interval.

GBL_CPU_SYS_MODE_UTILGlobal System Mode
CPU

Percentage of time the CPU was in user mode during the
interval.

GBL_CPU_USER_MODE_UTILGlobal User Mode CPU
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Table 23 Metrics Shown in Glance Adviser Visualizer (continued)

Description
HP GlancePlus Dictionary
Metric Name

Glance Adviser Metric
Name

Average number of threads waiting in the run queue over the
interval.

GBL_RUN_QUEUERun Queue Average

Total private virtual memory (in MBs unless otherwise
specified) at the end of the interval. This is the sum of the

GBL_MEM_VIRTGlobal Private Virtual
Memory

virtual allocation of private data and stack regions for all
processes.

Percentage of physical memory in use during the interval.
This includes system memory (occupied by the kernel), buffer

GBL_MEM_UTILPhysical Memory
Utilization

cache and user memory. On HP-UX 11iv3 and above, this
includes file cache also.

Total number of page outs to the disk per second during the
interval. This reflects paging activity between memory and

GBL_MEM_PAGEOUT_RATEGlobal Pageout Rate

paging space. It does not include activity between memory
and file systems.

Average number of page outs to the disk per second over
the cumulative collection time. This includes pages paged out
to paging space and to the file system.

GBL_MEM_PAGEOUT_RATE_CUMGlobal Cumulative
Pageout Rate

Percentage of buffer cache reads resolved from the buffer
cache (rather than going to disk) during the interval. Buffer

GBL_MEM_CACHE_HIT_PCTGlobal Buffer Cache Hit

cache reads can occur as a result of a logical read (for
example, file read system call), a read generated by a client,
a read-ahead on behalf of a logical read, or a system
procedure.

Number of physical IOs per second during the interval. Only
local disks are counted in this measurement. NFS devices are

GBL_DISK_PHYS_IO_RATEGlobal Disk IO Rate

excluded. All types of physical disk IOs are counted, including
file system IO, virtual memory IO, and raw IO.

Number of successful packets per second received through
all network interfaces during the interval. Successful packets

GBL_NET_IN_PACKET_RATEGlobal Net Inbound
Packet Rate

are those that have been processed without errors or
collisions.

Number of inbound errors per second on all network
interfaces during the interval.

GBL_NET_IN_ERROR_RATEGlobal Net Inbound Error
Rate

Number of successful packets per second sent through the
network interfaces during the interval. Successful packets are
those that have been processed without errors or collisions.

GBL_NET_OUT_PACKET_RATEGlobal Net Outbound
Packet Rate

Number of outbound errors per second on all network
interfaces during the interval.

GBL_NET_OUT_ERROR_RATEGlobal Net Outbound
Error Rate

Total CPU time consumed by a process or kernel thread as
a percentage of the total CPU time available during the
interval.

PROC_CPU_TOTAL_UTILProcess CPU

Percentage of time that the CPU was in system mode in the
context of the process or kernel thread during the interval.

PROC_CPU_SYS_MODE_UTILProcess System Mode
CPU

Percentage of time the process or kernel thread was using
the CPU in user mode during the interval.

PROC_CPU_USER_MODE_UTILProcess User Mode CPU

Size (in KB) of virtual memory allocated for the proces or
kernel thread.

PROC_MEM_VIRTProcess Virtual Memory

The size (in KB) of resident memory allocated for the process
or kernel thread.

PROC_MEM_RESProcess Resident Memory
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Table 23 Metrics Shown in Glance Adviser Visualizer (continued)

Description
HP GlancePlus Dictionary
Metric Name

Glance Adviser Metric
Name

Size (in KBs unless otherwise indicated) of the total virtual
memory occupied by data regions of this process. This value

PROC_REGION_VIRT_DATAData Region Virtual
Memory

is not affected by the reference count since all data regions
are private.

Size (in KBs unless otherwise indicated) of the total resident
memory occupied by data regions of this process. This value

PROC_REGION_RES_DATAData Region Resident
Memory

is not affected by the reference count since all data regions
are private.

Total number of kernel threads for the current process.PROC_THREAD_COUNTProcess Kernel Threads

Number of files the current process has remaining open as
of the end of the interval.

PROC_FILE_OPENProcess Open Files

Number of physical IO KBs per second used by this process
or kernel thread, either directly or indirectly, during the
interval.

PROC_IO_BYTE_RATEProcess Physical IO Rate

Average number of physical disk IOs per second made by
the process or kernel thread during the interval.

PROC_DISK_PHYS_IO_RATEProcess Physical Disk IO
Rate

Related Topics

• Collecting Glance Data for Viewing in HPjmeter (page 98)
• Multiple User-Defined (page 192)
• Using Visualizer Tool Bars (page 201)
• Changing Time Interval in GC Data Visualizers (page 206)
• Basic Garbage Collection Concepts (page 103)

Glance System Call Data
The Glance System Call display provides a graph of data obtained from the PROC_SYSCALL loop
in Glance Plus. For additional details, see the HP GlancePlus for HP-UX Dictionary of Operating
System Performance Metrics. At each sampling interval, all system calls that exceed a predefined
rate are written to the data file. Six items are recorded for each system call. They are shown below,
with the GlancePlus items they correspond to in parentheses:
• Count for this system call since the last sample (PROCSYSCALL_CALL_COUNT)

• Cumulative count for this system call (PROCSYSCALL_CALL_COUNT_CUM)

• Rate for this system call (PROCSYSCALL_CALL_RATE)

• Cumulative rate for this system call (PROCSYSCALL_CALL_RATE_CUM)

• Time spent in this system call (PROCSYSCALL_TOTAL_TIME)

• Cumulative time spent in this system call (PROCSYSCALL_TOTAL_TIME_CUM)
These metrics provide information about the system call behavior of the selected process. You can
use the display to look for high system call activity.
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Figure 76 GC Metric: Glance System Call Data

You can display a different Glance system call metric or a combination of multiple metrics using
the toolbar button. This opens a metric configuration pop-up box that lets you select the metrics
you want to display:
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Figure 77 Glance System Call Metric Configuration Box

Click the Single or Multiple metric radio button to choose the Metric Selection Mode. Then click the
check boxes to select the desired metric or combination of metrics. When you check a metric, it
is immediately added to the chart. Uncheck it, and it is removed from the chart.

You can also view these metrics together with GC metrics and Glance Adviser metrics on the
Multiple User-Defined tab.
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Related Topics

• Collecting Glance Data for Viewing in HPjmeter (page 98)
• Glance Data (page 194)
• Using Visualizer Tool Bars (page 201)
• Changing Time Interval in GC Data Visualizers (page 206)
• Basic Garbage Collection Concepts (page 103)

Using Visualizer Tool Bars
All visualizers offer buttons and other controls that help you manipulate the information displayed.
See the following sections for details.

• Common Tool Bar Buttons (page 201)
• Tool Bar Buttons for Manipulating Tabular Data (page 201)
• Tool Bar Buttons for Manipulating Graphical Data (page 202)
• Special Button or Other Gadget Functions (page 203)

Common Tool Bar Buttons
A few buttons appear on most visualizers. They are the following:

Bring Console to Front Bring console to the front of all other HPjmeter visualizers and
viewers.

Compare Data Compare data from one or more comparable data sets. For
details, see Comparing Profiling Data Files (page 85) or
Comparing Garbage Collection Data Files (page 102).

Refresh Data Refresh the visualizer presentation. When viewing a live
monitoring session, the refresh will be a new snapshot of the
current state of the application. When viewing vgc data, the
refresh will update the visualizer with the most recent data from
a log file.

Print Print the data presented in the visualizer pane.

Save to File Save data from a metric display into a file for later viewing.
For example, a graphic display of a metric will be saved as a
Portable Network Graphics (PNG) file for viewing in software
that can interpret this file type.

Tool Bar Buttons for Manipulating Tabular Data
These buttons appear depending on the metric in the visualizer.

Find Brings up a dialog for keyword entry to start a search
through the data. See Find a Search Pattern (page 204) for
details.

Find Immediately Immediately start searching on current keyword. See Find
a Search Pattern (page 204) for details.

Mark Mark an item for search across visualizers. See Mark an
Item for Search (page 203) for details.

Find Previous Selected Item Cycle back to a previously selected item. See Find a Search
Pattern (page 204) for details.

Find Next Selected Item Cycle forward to a previously selected item. See Find a
Search Pattern (page 204) for details.
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Refresh Live Objects Collect data and immediately display live objects in the
heap at that moment.

Copy Selection to Buffer Copy a selected portion of the current data display into a
buffer. Use standard keyboard shortcuts to paste this
temporarily stored data into a spreadsheet or other similar
document.

Copy All to Buffer Instantly copy all of the current data display into a buffer.
Use standard keyboard shortcuts to paste this temporarily
stored data into a spreadsheet or other similar document.

Tool Bar Buttons for Manipulating Graphical Data
These buttons appear depending on the metric in the visualizer.

Unfreeze Display Allow the display to continue to scroll as data is updated. SeePause or
Resume Graphical Time-based Scrolling (page 205) for details.

Freeze Display Stop the data display from scrolling. See Pause or Resume Graphical
Time-based Scrolling (page 205) for details.

Tool Bar Buttons for Manipulating Garbage Collection Data
These buttons appear depending on the metric in the visualizer.

Show Hours:Minutes Show data along the X-axis according to the hour and
minutes at which each event occurred.

Show Cumulative Seconds Show data along the X-axis according to the cumulative
number of seconds that have passed since the recording
started.

Connecting Lines On Show GC events with black lines connecting each
representative dot in order of occurrence.

Connecting Lines Off Show GC events as unconnected dots .

Color Distinctions for GC Types On Show colors that indicate the types of garbage collection
used during the application run.

Color Distinctions for GC Types Off Turn off colors that indicate the types of garbage collection
used during the application run.

Zoom Out Zoom out from selected interval to show entire graphed area
for current metric.

Apply Selected Interval to All
Metrics

Apply interval selected in current metric to all other metrics
in viewer. Note that the graph automatically zooms in on
the Y-axis to provide a more fine-grained view of the data
points while in this mode. See also Changing Time Interval
in GC Data Visualizers (page 206).

Reset Default Interval for All
Metrics

For all metrics in the viewer, reset the current interval to the
default setting.

Filter Allocation Site Data Bring up a pop-up window to filter allocation site statistics
data.

Display Allocation Site Data in
Combined Sets

Display allocation site statistics data in combined sets.

Display Allocation Site Data in
Separated Sets

Display allocation site statistics data in separated sets
grouped by times. The time column is added at the left side
of the table to display the date, which is collected at different
times. A clock icon is enabled on the toolbar to toggle
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between a display of elapsed time in seconds and clock
time.

Select Metrics for Display For the Multiple User-Defined, Glance Adviser, and Glance
System Call tabs, opens a pop-up window that lets you
configure the metrics you want to display by using the check
boxes to select the desired metric or combination of metrics.

Special Button or Other Gadget Functions
This section gives you more detailed information about the functions of some visualizer buttons to
help you make better use of these features. See the following sections for details.

• Mark an Item for Search (page 203)
• Find a Search Pattern (page 204)
• Pause or Resume Graphical Time-based Scrolling (page 205)
• Changing Time Interval in GC Data Visualizers (page 206)
• Changing Time Interval in Monitoring Visualizers (page 209)

Mark an Item for Search
To enable you to work efficiently with multiple windows, the visualizers provide a simple means
of marking selected items such as methods, types, objects, and classes, and then locating marked
items in other windows, or in displays showing other monitoring metrics. The marking mechanism
is based on names, so it works across different data files provided they contain items with matching
names.
When you select an item in a display to mark (single-click the item with the left mouse button), click
the Mark button [ ] in the tool bar, or Mark to Find in the Edit menu. Marking an item copies the
name and/or other properties of the current item (highlighted by blue-green color) into the search
pattern. A status message will display in the lower right bottom of the visualizer widow, confirming
the selection that is the current mark. The message will look similar to this:
Marked java.util.BitSet.recalculatedUnitsinUse

Using the Marked Object List on the Console
Each time an object is marked in a visualizer, a history list on the console is updated. The list is
limited to the seven most recent marked items.
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Use this list to locate marked objects across sessions or data files; anywhere within the data sets
that are currently viewable in the console.
To use this feature, do the following:
1. Open the Marked drop-down and view objects marked thus far in HPjmeter visualizers.
2. Click the object that you want to locate.

This makes the selected object in the drop-down become the current marked object.
3. Now open the visualizer where you want to search for the object.
4. Click the Find or Find Immediately button to search for the object.

Find a Search Pattern
In the Edit menu (and on the tool button bar), there are two find options:
Find Immediately [ ], which uses the current values in the search pattern (usually stored by the
most recent Mark operation) or Find [ ], which opens a dialog window that allows you to edit the
search pattern before starting the search.
The elements of the search pattern used for matching the items depend on the actual kind of items
being searched (types, methods, objects, for example) and are a subset of the following list:

• Java package name
• Java class name
• Java type name (classes, primitive types, and arrays)
• Java method name
• Java object reference (ID)
As a result of the search, all found items are highlighted. The first found item becomes the current
selected item (shown with a blue background), and the window is scrolled automatically to make
it visible. The remaining selected items, if any, are displayed on a light yellow background. The
number of matches displays briefly in the message area in the lower right bottom of the visualizer
window.
If there are multiple selected items, you can change the current item using Find Previous Selected
and Find Next Selected from the Edit menu or use the appropriate buttons on the tool bar. These
actions also automatically scroll the window. (See Tool Bar Buttons for Manipulating Tabular Data
(page 201) for the complete list of Mark and Find buttons and their meaning.)
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You can also add additional items to the highlighted set by holding down the SHIFT key while
clicking the left mouse button. Each new item added to the selected set is also highlighted in light
yellow.

Figure 78 Locating an Item

Editing the Finder
For each search field , you can either type in a different value, or you can click Clear to eliminate
information from the search. You can broaden the search (search on the package name only) or
narrow the search (search on the class name and/or method name only).
Once the fields are the way that you want them, click Find All to start the search.

Pause or Resume Graphical Time-based Scrolling
You can pause and resume graphical time-based scrolling by clicking the clock icon in the upper
left corner just above the visualizer display area.
The following image shows a display that is running. Pressing the clock would pause the scrolling
of the data. Pressing the clock again would allow the display to resume scrolling.
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Figure 79 Using the Pause Clock

Changing Time Interval in GC Data Visualizers
The GC viewer provides several ways for you to manipulate the breadth of the data in the
specialized GC visualizer displays. You can

• select a subset of the available data.

• continue selecting subsets to zoom in to specific events in ever smaller periods of time and/or
ever narrowing range of data.

• apply a selected interval across all of the metrics, making it easy to look at the same time
period from different metric points of view.

• quickly return to the original graphs of the metric or metrics in order to select a new area of
the graph to explore in more detail.

Select a Subset of the Available Data
To select a subset of data, click one location on the graph and drag the mouse cursor across the
graph area from left to right until you have defined an area that you want to explore in more detail.
Release the mouse button, and the screen repaints with the new interval filling the entire graphical
area.
Using the View menu, you can choose whether to base the selection on the X axis, the Y axis , or
both. The X axis is the default setting.

Figure 80 The View Menu Selections in the GC Viewer
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To drill in further, repeat this method of defining the area of view until you reach your desired
resolution.
Use the slider underneath the graph to view additional ranges in the data without changing the
resolution interval.
The following images show a selected area on a graph and the resulting display.

Figure 81 Specialized GC Graph with Area Selected for Finer Resolution
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Figure 82 New Resolution After Selection

Apply Selected Interval Across All Metrics

When you have your desired resolution in one metric visualizer, click the button to apply the
selected time interval across all metrics in the GC viewer. This resolution will apply until the reset
button is clicked or a new resolution is chosen.
Note that although the X-axis (Clock Time) has not changed from the previous figure, the graph
automatically zooms in on the Y-axis to provide a more fine-grained view of the data points while
in this mode.
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Figure 83 Resolution After Interval Applied to All Metrics

Reset Interval to Default Settings Across All Metrics

Click the button to reset all metrics to their original graphic display seen on first opening the
GC viewer.

Changing Time Interval in Monitoring Visualizers
To change the time interval currently displayed, click the drop down in the top right of a graphical
monitoring visualizer, and select the time interval that you want to see. Shorter time intervals allow
you to see more detail; longer intervals allow you to see trends over time. The following image
shows a heap monitor set to show activity occurring over the past hour.
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Figure 84 Time Interval Use in a Monitoring Visualizer

Change Color Selection for Histogram Display
The console provides you with the ability to change colors on thread histogram displays in order
to better support variations in color vision capability and to help you selectively improve contrast
for items you are particularly interested in.
To access the color changer on these displays, double-click the color rectangle (in the legend) that
you would like to change.
A color chooser will open. Select the color that you want to use for the selected data type and
click OK. The display will immediately repaint with the new color.
In the following graphic, you can see that a new color is being selected for CPU representation.
The color chooser shows a small block of the original color so that you can compare your new
color choice to the default color setting.
To re-display the original color choice in the color chooser, click the Reset button.
Use Cancel to quit the color chooser with no changes made to the data display.
To reset all colors to the default settings, select Edit→Standard Preferences→Reset Default Color
Preferences on the main console.
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Figure 85 Using the Color Changer on Histogram Displays

Related Topics

• Thread Histogram (page 152)

• Profile by Threads (page 175)
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9 Understanding How HPjmeter Works
Here are details on how HPjmeter works to collect and display metrics.

Performance Overhead on Running Applications
HPjmeter is designed to minimize data collection overhead on deployed applications. The most
significant change you will notice is slightly longer application server startup times.

Application Server Startup Time
HPjmeter uses load-time bytecode instrumentation to reduce overhead in deployment situations.
The load-time processing increases application server startup time, the time from invoking the
application server startup script until the application server is ready to accept requests, by several
minutes.
This overhead also allows HPjmeter to avoid preprocessing application server or user code.

Monitoring Overhead
HPjmeter provides lightweight data collection designed for deployment-time monitoring of live
applications. For a typical Java application, when a session is not open (the HPjmeter JVM agent
is in dormant mode), the application overhead is very low. When a session is open and collecting
data (active mode), overhead is higher than in dormant mode with default settings , but still is
typically low. Once a session is closed, overhead returns to a very low level.
Overhead depends on the set of filters and flags you specify. To minimize overhead, you can use
the nohotspots and noalloc options to disable the Java Method HotSpots and Object Allocation
metrics for the lifetime of the JVM agent.
Using include and exclude filters, may increase or decrease overhead, respectively. The
include option provides more monitoring detail but increases overhead while the exclude
option decreases overhead by providing less monitoring detail.
By default, application server classes are not instrumented, which minimizes overhead and focuses
measurements on your code.

Changes in Memory Overhead With Dynamic Attach
Users running their application with Java 6.0.03 can take advantage of dynamic attach features
in HPjmeter 4.3. With support for dynamic attach, HPjmeter can find JVMs automatically upon
connecting to a server, without needing to start the JVM with HPjmeter options on the command
line. Until the HPjmeter JVM agent is dynamically loaded into the JVM, no overhead is incurred.
In addition, bytecode instrumentation is removed when the console is disconnected from the JVM
agent. Temporarily removing the instrumentation also lowers the overall overhead of a monitoring
session.

Profiling Overhead and Intrusion
A major side effect of profiling is that the profiling itself consumes memory and CPU time. This
introduces two problems. One is overhead - you'll notice that the profiling runs take longer than
normal runs—sometimes substantially longer. The other problem is intrusion. When the metrics
collection uses the same resources that you want to measure, you get the numbers not only for the
application, but rather for the application plus whatever you use to collect the metrics.

Node Agent Overhead
CPU usage is negligible for a node agent with no connections, a node agent without a console
attached, and a node agent with a small number of open sessions. The reason is that the node
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agent spends almost all its time blocked on socket and first-in first-out (fifo) waits. When the node
agent is managing open sessions, overhead is extremely low.
The physical memory footprint of the node agent is about 1 MB when idle and 1.5 MB when
active.

Console Overhead
You should not run the console on a machine that is a managed node to minimize impact on your
system.
The console uses 512 MB of memory on Microsoft Windows and 1 GB of memory on UNIX systems
by default. For a long-running monitoring session, you should start the console with >1 GB of Java
heap or more.

Data Sampling Considerations
HPjmeter uses sampling, rather than exact counts, to minimize the overhead of data collection on
applications. The accuracy of data collected by sampling increases with the number of samples.
The time required to collect enough samples to get good accuracy varies, depending on the
sampling frequency.
The sampling frequency employed by HPjmeter can vary among metrics. A disparity in sampling
frequency can create seeming discrepancies between some data displays when the real issue is
that you are viewing different data samples or cumulative records of different sample intervals.
Keep this in mind when comparing data presented in various related metrics.

Using Confidence Interval to Indicate Sample Validity
HPjmeter uses a confidence interval to give you a real-time view of the current accuracy of certain
metrics.
For example, the Java Method HotSpots window shows the confidence interval numerically as a
plus-or-minus percentage that appears just to the right of the measured value. A gray diamond
underlies the text to show a graphical representation of the confidence level.
The horizontal positioning of each gray diamond represents the measured value in relation to the
other measured values in the display. The width of the diamond represents the percent confidence
interval. The real value measured lies somewhere within the range of confidence represented by
the diamond.
During a live session, the width of the confidence interval shrinks over time as the statistical
confidence in the value increases.
This example shows a high confidence in the results, denoted by the narrow gray diamonds in the
display.

This example shows low confidence in the results, denoted by the wide gray diamond shapes.
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Until the algorithm can show the data with confidence, the graphical confidence interval is displayed
as a gray bar showing only relative relationship.

How Memory Leak Detection Works
HPjmeter constantly monitors all open sessions and analyzes the heap size after each garbage
collection. It tries to detect a longtime, increasing trend in the heap sizes. If it determines that a
dependency exists between elapsed time and the heap size, and that the heap size is always
greater than a certain linear function of time, it calculates a potential memory leak rate.
The next figure shows the heap size after each garbage collection plotted over time, using the
standard Garbage Collectionsdisplay. The metrics show that as time passes, the lowest post-garbage
collection heap size increases, indicating that a growing area of heap is un-collectible.

Figure 86 Early Indicator of Possible Memory Leak Using Garbage Collections Visualizer

The uncollectible and retained memory eventually fills the heap, as shown in this Heap Monitor
display.
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Figure 87 Early Indicator of Possible Memory Leak Using Heap Monitor Display

HPjmeter uses the long term linear upward trends in the heap size after garbage collections to
calculate the presence of memory leaks.
Short-term increases in heap size are normal. HPjmeter measures this rate in MB/hour.
HPjmeter does not report a leak in situations in which the heap size increase is only temporary,
or in situations in which the slope of the fitted line is too small to raise an alarm.
However, sometimes a healthy Java application is diagnosed with a memory leak. When the heap
size returns to its previous range, such an erroneous diagnosis is revoked, reverting to its original
state.
Leak detection accuracy improves over time, so if a memory leak alarm fluctuates on and off, or
in value, you should base your analysis on the present alarm state.
With high leak-rate, you can consider having the IT administrator start another JVM and stop the
old one in a controlled way, in a clustered environment, when the garbage collection percentage
becomes excessive. What is considered excessive depends more on the rate of change of garbage
collection percentage or the estimated number of minutes before the heap will run out.
Related Topics

• Java Collection Leak Locations Alert (page 129)
• Confirming Java Memory Leaks (page 53)
• Determining the Severity of a Memory Leak (page 53)
• Memory Leak Applications (page 43)
• Basic Garbage Collection Concepts (page 103)

Tapping in to Standard Management of the Java Virtual Machine
HPjmeter retrieves information about the state and activity of the JVM (Java 1.5 or higher) on HP-UX
by making use of the JSR-174 API (http://www.jcp.org/en/jsr/detail?id=174). HPjmeter collects
information about MXbean notifications, attributes, and operations for display in the JMX viewer.
It uses control aspects of the API to allow you to see and manipulate your own MBean attributes
and operations in real time.

Tapping in to Standard Management of the Java Virtual Machine 215



HPjmeter also uses data collected from the JVM to enrich the quality and kind of information
presented in HPjmeter monitoring metrics and to expand the number of alerting notifications
HPjmeter is able to provide via the Alert Controller.
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10 Troubleshooting
Here is information to help you find answers and possible solutions to problems you might see.

Documentation and Support
You can find printable PDF versions of the user's guide and the release notes in the installation
directory within the doc subdirectory. Updates to documentation are made available at the HP
Business Support Center at http://www.hp.com/go/hpux-java-docs.
You can find printable PDF versions of the user's guide, the release notes, and the getting started
guide in the installation directory within the doc subdirectory. Updates to documentation are made
available at the online HP Business Support Center at http://www.hp.com/go/hpux-java-docs.
Problem resolution is available from HP Response Centers worldwide all day every day as part of
operating system support contracts. For regional HP Response Center phone numbers, please
contact your local HP sales office. The Response Center number in the United States is
1-800-633-3600.
You can also obtain assistance by sending e-mail to java-tools-support@hp.com.
When reporting a defect, please include a reproducible code example, a description of the problem,
and the product name and product number (if available). Also include the version string returned
when you enter: java -version and the version string returned when you enter: uname -a .

Identifying Version Numbers
Assume that JMETER_HOME represents your installation directory for HPjmeter. Use these commands
when you need to identify the version numbers of HPjmeter components:

• Node agent for HP-UX
$ what JMETER_HOME/bin/nodeagent -version

• JVM agent for HP-UX on PA-RISC
$ what $JMETER_HOME/lib/PA_RISC*/libjmeter.sl

• JVM agent for HP-UX on Itanium
$ what $JMETER_HOME/lib/IA64*/libjmeter.so

• HPjmeter console on other platforms
From the console, click Help→About HPjmeter.

Installation
• The HPjmeter installer does not include its own Java runtime. Instead, during installation, the

installer locates a Java runtime that is appropriate for running the console, and embeds the
path to that JRE into the listed scripts.
HPjmeter fails to start if you move or delete the JRE after you install.
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To fix this problem, you can make either of these changes:

◦ Reinstall a JRE in the expected location specified in the HPjmeter scripts.

◦ Edit the HPjmeter scripts to specify the path to an existing JRE.
The scripts containing the path to the JRE are in the location defined by JM_JAVA_HOME
in the bin/ directory. These are the scripts:
– hpjmeter - Runs the HPjmeter GUI console.
– run_simple_jvmagent - Runs a simple Java program together with the HPjmeter

JVM agent.
– setup_jvmagent_environment- Displays a sample command line for starting

Java with the JVM agent.
See also To Take Advantage of Dynamic Attach (page 26).

• If you have problems installing the HPjmeter console, you can gather additional information
by adding command-line options to the installation process:
1. Examine the installation’s log file—A log file is automatically created as part of the

installation process. Assuming that you used the defaults suggested by the installation
wizard, the following are examples of where the log file can be found:

◦ On Windows:
nl

C:\Program
Files\HPjmeter\_HPjmeter_installation\Logs\HPjmeter_Install_<date>
.log

◦ On Linux:
nl

/opt/HPjmeter/_HPjmeter_installation/Logs/HPjmeter_Install_<date>.log
2. Execute the installation with a specific Java version—

nl

[sh] hpjmeter_console_4.3.00.00_*_setup[.exe|.sh] LAX_VM <path to
Java>

◦ For a Windows system, because there can be spaces in directory names, you are
required to add quotes around the file name. Depending on the version and
installation of Java, an example on Windows might be,
hpjmeter_console_4.3.00.00_windows_setup.exe LAX_VM
“C:\Program Files\Java\jdk1.6.0_37\jre\bin\java.exe”

◦ Depending on the version and installation of Java, an example on Linux might be,
nl

$ sh hpjmeter_console_4.3.00.00_linux_setup.sh LAX_VM
/usr/java/jdk1.7.0_10/bin/java

Console
• If a node agent is not running, the console cannot connect to JVM agents and you will get this

message in the console status bar when you try to attach to a managed node:
Connection to hostname failed.
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You can set up the node agent to run as a daemon or service for automatic, continuous
operation, or as a normal process when you do not need continuous operation. The setup
process depends on your platform.

◦ Managing Node Agents On HP-UX (page 47)

• The console graphical interface uses the HP One Voice look and feel for presentation. When
you run the console remotely, performance with this look and feel can be sluggish. Use the
standard Java Metal look and feel when displaying the console remotely.

• The console may occasionally report an incorrect application name.

• As expected for any Java application during long-running or intensive monitoring sessions,
the console may run out of memory. In this case, the console will not terminate; instead, it
stops reporting data, closes the active session if possible, and reports an OutOfMemoryError.
A message appears in the controlling terminal and on the main window's status bar. This can
also occur if you try to open a data file that is larger than the memory allowed for the console.
Try restarting the console with the -Xmx option set to a larger value. The default for -Xmx is
512 MB of memory on Microsoft Windows and 1 GB of memory on UNIX systems. Please
see the next section on JVM agent troubleshooting to see how the JVM agent behaves under
this condition.

• Occasionally, HPjmeter might encounter a stack overflow when processing a complex data
file. For example, some heap dump files might contain very long chains of object references,
and this could occasionally produce a message such as the following when attempting to
open a new metric:
WARNING: Unable to launch feature
java.lang.StackOverflowError

When this occurs, you should restart the HPjmeter console with a larger stack size. You can
increase the stack size using the -Xss command-line option. For example:
/opt/hpjmeter/bin/hpjmeter –Xss16m

• On occasion, you can successfully connect to the JVM and open a session, but discover that
no metrics are available for viewing (menu options are grayed out). This can occur if the
application is experiencing a long GC at the time that you open the session.
Once the GC completes, the console should begin receiving data and behave normally.

• You can set a log level on the console, which allows you to collect varying amounts of
information about the console and node agent. To set the log level, use this command to
manually start a console:
$ JMETER_HOME/bin/hpjmeter -log level_of_detail

Available log levels:

◦ FINEST (most impact on performance)

◦ FINER

◦ FINE

◦ CONFIG

◦ INFO

◦ WARNING (default setting)

◦ SEVERE (least impact on performance)

◦ OFF (turn off logging)
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JVM agent
• If the console runs out of memory during an open session, the JVM agent will close its session

a few minutes later. Then the JVM agent prints out this to standard error on its controlling
terminal:
HPjmeter JVM agent
warning: Session communication channel failure.  Forcing session closure. 

When you start a new console, you can reopen a session with the JVM agent.

• You may see an OutOfMemoryError when your application is running with the JVM agent.
One possible cause is that after HPjmeter inserts the agent bytecode instrumentation, the
loaded class data is larger and it needs more space in the Java heap. In the case of HotSpot,
more permanent space is used. If the required permanent space size exceeds HotSpot's default
MaxPermSize, which is determined by the HotSpot version, HotSpot will throw the
OutOfMemoryError. You can use the HotSpot nonstandard option -XX:MaxPermSize=
to set a larger MaxPermSize to avoid the OutOfMemoryError.

• If you see this JVM agent error on startup:
The HPjmeter JVM agent could not
load a class from agent.jar. Please check your classpath and Xbootclasspath.
The HPjmeter agent has encountered an error  (log file: HPjmeter.jvmagent_28766.log).
Please contact java-tools-support@hp.com for support.

Check for these conditions:

◦ The -Xbootclasspath option may be missing from the command line. (This should
not be the problem if you are using the -agentlib switch. -Xbootclasspath is
optional when used with -agentlib.)

◦ If you have an -Xbootclasspath argument, then make sure the path it is pointing to
is correct.

• On an HP Integrity (Itanium) server, you see that the JVM agent is not starting and the error
message indicates that the HPjmeter shared library cannot be found, as follows:
Error occurred during initialization of VM Could
not find -Xrun library: libjmeter.so 

Check to see what Java version you are using. If you are running Java 1.4.2_07, try setting
SHLIB_PATH, rather than using LD_LIBRARY_PATH to define the shared library location. If
this doesn't work, you may need to update to a newer JDK.

• You can set a log level on the JVM agent, which lets you collect varying amounts of information
about the console and JVM agent. For example:
$ /opt/java1.5/bin/java -Xms256m -Xmx512m -agentlib:jmeter=logging=level_of_detail

Available log levels:

◦ FINEST (most impact on performance)

◦ FINER

◦ FINE

◦ CONFIG

◦ INFO

◦ WARNING (default setting)

◦ SEVERE (least impact on performance)
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Node agent
On HP-UX systems, the node agent may occasionally leave files in /var/opt/hpjmeter/fifos,
with names ending with *fifo. These files are used for node agent communication, and you
should not remove them while a node agent or JVM agent is active. You can delete these files
when the node agent is not running if they begin to accumulate.

• On HP-UX you may sometimes not be able to restart the node agent with the same port. If you
stopped the node agent and then tried to run it again, you may see the following:
Can't use port port_number. Try using the -port option to select a port from 9505 to 9515.

To work around the problem, restart the node agent using a different port number.
If the problem with the un-terminated connections persists, you can reduce the frequency by
using this command as root:
   $ ndd -set /dev/tcp tcp_fin_wait_2_timeout
300000  

This sets the timeout in milliseconds for the leftover connections. The example sets this timeout
to 5 minutes (300000 milliseconds). After about five minutes, you should be able to restart
the server using the same port number as before.

• You can set a log level on the node agent, which lets you collect varying amounts of information
about the console and node agent. To set the log level, use this command to manually start
a new node agent:
$ JMETER_HOME/bin/nodeagent -logging=level_of_detail

Available log levels:

◦ FINEST (most impact on performance)

◦ FINER

◦ FINE

◦ CONFIG

◦ INFO

◦ WARNING (default setting)

◦ SEVERE (least impact on performance)

For more information about the node agent, see Managing Node Agents (page 47).

Zero Preparation Profiling
We have suggested that you use -usr2 to start and stop zero preparation profiling from the
command line. Because some applications use this same signal, you may want to disable the ability
to do zero preparation profiling altogether to avoid interfering with your application. To disable
zero preparation profiling, use -xeprof:off

Unexpected Behavior in Visualizers
For best results, update the HPjmeter node agent on your server(s) when you update the console.
This allows you to take advantage of new metrics or improved support for newer JDKs/JREs.

Node agent 221



A Quick References
Connecting to the HPjmeter Node Agent

For information on how to connect to the node agent, see Connect to the Node Agent from the
Console (page 34).

Table 24 Fields Used When Creating a Connection to the HPjmeter Node Agent.

PurposeExpected InputField

Required. Designates the location of the server running the
HPjmeter node agent or the location of the designated SSH

Fully qualified domain nameHost Name

host. The SSH designate machine can be the machine where
the node agent is running.

Optional. Designates a nonstandard communication port on
the server running the HPjmeter node agent or on the SSH
designate machine.

Port numberOptional Port

Required for SSH connection only. Designates the location of
the delegate tunneling server.

IP addressExternal IP

Required for SSH connection only. Designates the
communication port on the delegate server that will allow

Port numberExternal Port

communication going from the HPjmeter console to the
HPjmeter node agent.

Required for SSH connection only. Designates the
communication port on the delegate server that will allow

Port numberInternal Port

communication going from the HPjmeter node agent to the
HPjmeter console.

Determining Which HPjmeter Features Are Available With a Specific JVM
Version

Table 25 HPjmeter Features Available by JVM Version

Command Line Option or Action
JVM

HPjmeter Feature
Java 7.xJava 6.xJava 5.xJava 1.4x

kill -USR2 pidXX
(5.0.04+)

—Start and stop eprof data
collection with zero
preparation

-Xrunjmeter——XSpecify JVM agent

-agentlib:jmeter*XX—Specify JVM agent

NoneX
(6.0.03+)

–—Dynamic attach of the JVM
agent

-Xrunhprof——XCollect hprof data

-agentlib:hprofXX—Collect hprof data

-agentlib:jmeter*XX—Access JMX Viewer

-Xverbosegc, -XloggcXXXObtain detailed garbage
collection metrics

-Xverbosegc, -XloggcX
(6.0.01+)

X
(5.0.12+)

—View major versus minor
garbage collection metrics
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Table 25 HPjmeter Features Available by JVM Version (continued)

Command Line Option or Action
JVM

HPjmeter Feature
Java 7.xJava 6.xJava 5.xJava 1.4x

-XX:+PrintGCDetails and
-XX:+PrintHeapAtGC

X——View results of running print
GC details and print heap at
GC together

kill -PROF pid or kill
-21 pid

X (6.0.02)X (5.0.14)—Start and stop verbose GC
data collection with zero
preparation

-Xverbosegc and
-XX:+PrintAllocStatistics

X (6.0.02)X (5.0.14)—Obtain allocation site statistics
and -Xverbosegc data
together

-XX:+UseG1GCX
(7.0.04+)

———Garbage First

* This HPjmeter switch is optional when running Java 6.0.03 or later.

Default Location of Xverbosegc and Allocation Site Statistics Data Files
Table 26 GC Data File and Allocation Site Statistics Locations By Command Option Selection

Resulting Data LocationAction UsedJVM Option(s) Used

Standard outNo special action-Xverbosegc and
-XX:+PrintAllocStatistics

myfile.vgcNo special action-Xverbosegc:myfile.vgc and
-XX:+PrintAllocStatistics

Standard outNo special action-XX:+PrintAllocStatistics

java_pid.vgckill -21 pidNo special option

java_pid.vgckill -21 pid-XX:+PrintAllocStatistics

Standard outkill -21 pid-Xverbosegc and
-XX:+PrintAllocStatistics

myfile.vgckill -21 pid-Xverbosegc:myfile.vgc and
-XX:+PrintAllocStatistics

Standard outkill -21 pid-Xverbosegc

myfile.vgckill -21 pid-Xverbosegc:myfile.vgc
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Glossary
active mode An HPjmeter JVM agent that is part of an open console session and is collecting data from the

JVM and application and is sending it to a console.
agent A module that represents HPjmeter in your environment. HPjmeter provides two types of agents,

a node agent and a JVM agent.
Batch mode An HPjmeter JVM agent that is installed, configured, and is collecting data, but is not connected

to a console and is not part of a session. The collected data is stored in a file on the managed
node that you can open later from the console.

BCI See bytecode instrumentation.
bytecode
instrumentation

Instrumentation of Java bytecode inserts a special, short sequence of bytecode at designated
points in the Java classes of an application to facilitate runtime analysis of those classes during
monitoring.

cached session A session created when a running JVM terminates on its own, or when you close an active session.
The data in a cached session is available for analysis, but it is no longer connected to a running
JVM and is no longer collecting additional data.

call graph Displays the capture of “call” relationships between the methods. The nodes of the call graph
represent the program methods, while the directed arcs represent calls made from one method
to another. In a call graph, the call counts or the timing data are collected for the arcs.

call graph trees Call graph data presented in a collapsible and expandable tree hierarchy. See also call graph.
clock time The time as measured by an external independent clock.
confidence The measure of reliance or assurance that HPjmeter diagnosed the situation correctly.
confidence interval The HPjmeter graphical representation of probability that the displayed values are correct. As

the number of samples taken increases, the probability increases.
console The main window containing the menu and button controls for monitoring live applications and

analyzing captured data.
Console filters The Session Preferences window allows you to specify the classes to measure when you open a

session with a JVM agent. For details, see Controlling Data Collection and Display (page 46)
CPU time Time spent by any central processing unit (CPU) to execute a thread.
CPU virtual times Times when a thread is runnable, but not necessarily running. Depending on the actual hardware,

operating system, and Java VM, this time may also include I/O time, but generally CPU virtual
times are a good approximation of real CPU time consumed by the application.

creation rate The calculated rate at which new objects are occupying the heap.
dormant mode An HPjmeter JVM agent that is installed and configured, but is not part of an open console session

and is, therefore, not collecting data from the JVM and applications and is not sending data to
a console.

dynamic attach In HPjmeter, the ability to find and connect to a running JVM on a machine that has the HPjmeter
node agent running, but the JVM was started without using HPjmeter options.

eden That part of the heap where new and/or short-lived objects (the young generation) are created
and used.

ephemeral port
number

a temporary port number assigned from a range of numbers designated for this purpose.

exclusive times The accumulated total times used by a method, but not including the time used by the methods
that were called from it.

filter To exclude the measurement of specified classes. HPjmeter provides two methods to control how
information is collected and displayed, JVM agent filters and console filters. For details, see
Controlling Data Collection and Display (page 46)

garbage collection The process of automatically freeing memory by removing objects that are no longer referenced
by the program.
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hot spot A section of code, typically a method, with a higher-than-normal level of execution or access
requiring high CPU usage.

inclusive time The accumulated total time used by all invocations of the method and all methods that were called
from it directly or indirectly.

inlining Replacing a call to a function with an instance of the function; usually done at compile time.
Java Management
Extensions

See JMX .

JMX™ Java Management Extensions. API for managing and monitoring applications, devices, services,
and JVMs. For API specifics, see the Java Community Process web
(http://jcp.org/en/home/index): Java Management Extensions (JMX) Specification (JSR3) and
JMX Remote Specification (JSR160).

JVM Java Virtual Machine
JVM agent A module running on each managed node that collects data and sends it to the node agent,

which sends it to the console.
JVM agent filters The include and exclude options to the JVM agent allow you to filter metrics by class name.

For details, see Controlling Data Collection and Display (page 46)
JVMPI JVM Profiler Interface
JVMTI JVM Tool Interface
lingering objects accumulated live objects that clog the heap, creating memory leaks.
lock contention The summary time measured from the moment the thread requests a Java lock until the lock is

actually granted.
Lock Delay The time elapsed between the moment a thread tries to acquire a lock and the time the thread

enters the monitor.
managed node A computer on which the HPjmeter node agent and JVM agent are installed.
memory leak HPjmeter uses the long term linear upward trends in the heap size after garbage collections to

calculate the likely presence of memory leaks. See How Memory Leak Detection Works (page 214)
metadata Objects needed by the Java interpreter and for reflection in garbage collection.
method A function defined in a class. Unless specified otherwise, a method is not static.
method call count The number of times each function (method) of the program was called during a run.
method clock time The actual time spent in each of the methods of the program.
metric In this context, a mapping that associates numerical values with static or dynamic elements such

as program functions, variables, classes, objects, types, or threads.
node agent A process that manages communication between JVM agents and a console. Node Agent

(page 23)
old generation Objects in the heap that have survived a successive number of garbage collections, and have

been moved to the old space in the heap.
package A group of types. Packages are declared with the package keyword.
reduction Accumulating data during tracing such that consecutive calls from the same caller to the same

callee increase the recorded time value for a call.
scavenge Incremental, lightweight garbage collection of primarily short-lived objects in order to free space.
scope The breadth of view across thread-based profile data. HPjmeter lets you look at a single thread,

a group of threads, or the entire application.
service-level
objective

service-level objective. A service-level objective (SLO) partitions a service-level agreement (SLA)
into metrics and operational information to enforce and/or monitor the SLA.

session An open, live connection between an console and a JVM agent running on a managed node.
An open session has associated with it a set of metrics, filters, and alerts that are configured
when you open the session.

severity The measure of the expected impact of the detected situation on the application stability.
SLO See service-level objective.
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SSL Secure Sockets Layer
stop-the-world
time

Duration of a full garbage collection where processing stops during the collection time.

thrashing Excessive paging due to a disparity between physical memory actually available to the application
and the specified maximum size for memory usage.

thread spectrum When profiling, the distribution of thread lifetime over the possible thread states.
time slice Time slice entries represent the life span of the current monitoring session for an application. You

can view data throughout the life span of a time slice.
train Optional structure within the heap that is intermediate between the eden space and the old space.

The train is a related collection of smaller memory spaces (cars) that have garbage collected
incrementally according to the train algorithm.

train algorithm Mathematical formula that describes incremental garbage collection of related old objects. The
purpose of train garbage collection is to reduce the length of pause due to GC that is visible to
users of the software.

visualizer The pop-up screens where you see graphical or tabular displays of data. Visualizers provide
contextual controls based on the data displayed. See Using Visualizer Tool Bars (page 201)

young generation New and/or short-lived objects in the heap. Usually garbage collections are done frequently in
the young generation by scavenging the eden space.
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Index

Symbols
-agentlib

effect on application performance, 27, 77
JVM agent options, 27
locating Java version, 27
specifying hprof agent for Java 1.5, 77
specifying JVM agent option for Java 1.5, 27

-agentlib:hprof, 69
collecting profile data, 76
options, 77
profiling data capture, 69

-d64
64-bit JVM agent, 26

-jmap tool, 79
-log

console option, 219
-logging

JVM agent option, 29, 220
node agent option, 221

-port
node agent option, 47, 48, 221

-Xeprof, 69, 177
collecting profile data, 72
profiling data capture, 69

-Xeprof options, 73, 79
file, 73
ie, 74
inlining, 73
time_on, 73
time_slice, 73

-Xloggc, 94
collecting data for garbage collection analysis, 100
GC data capture, 94

-Xms, 26
-Xmx, 26

console memory, 219
-Xrunhprof

specifying hprof agent for Java 1.4.x, 77
-Xrunjmeter

JVM agent options, 27
locating Java version, 27

-Xverbosegc, 94
collecting data for garbage collection analysis, 94
GC data capture, 94
options, 94

.eprof
file name suffix, 78

.hpjmeter
file name suffix, 49

.hprof.txt
file name suffix, 78

.vgc
file name suffix, 101

80–20 rule, 70

agent unresponsive, 113

application stopped, 113

application warning, 113

Color distinctions on, 202

Compare data, 201

Connect to server, 114

Connecting lines off, 202

Copy all to buffer, 202

Copy selection to buffer, 202

filters and bytecode instrumentation, 28, 46

Find immediately, 201

Find next selected item, 201

Find previous selected item, 201

Find matching selection, 201

connected node agent icon, 112
, 112

node agent alert, 112

_icon for open file, 114

pending node agent, 112

_icon for returning console to front, 201
, 113

connected node agent icon
via SSH, 112

_icon for toggling clock to hours:minutes, 202

_icon for toggling clock to total seconds, 202

unconnected node agent, 112

Freeze display, 202
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agent running, 112

Mark item for search, 201

open alert controller, 114, 202

open session preferences, 114

Print, 201

Refresh live objects, 202

Save to file, 201

Save to snapshot file, 114

session active, 113

session unavailable, 113

Time slice life span, 113

Apply selected interval to all metrics, 202

Close file or connection, 114

Display allocation site data in combined sets, 202

Display allocation site data in separated sets, 202

Filter allocation site statistics data, 202

Generate extended profiling data file, 114

Reset default interval for all metrics, 202

Select metrics for display, 203

Zoom Out, 202

Connecting lines on, 202

Unfreeze display, clock running, 202

Warning, 113
warning, 117

A
abnormal

thread termination, 54
access controls

agents, 48
active mode

performance overhead, 212
agent

Can't use port port_number, 221

configuring node, 47
data icons, 112, 113
out of memory warning, 220
requirements, 24
security, 48

alert
abnormal thread termination, 126
Array Leak Locations, 130
excessive compilation, 128
expected OutOfMemory error, 128
gc duration, 128
heap usage, 129
memory leak locations, 129
process CPU usage, 131
reactivating or deactivating, 124
responding to, 126
system CPU usage, 132
thread deadlock, 133
unfinalized queue growth, 133

alert controller, 215
console, 123
log, 125
reactivate or deactivate alerts, 124
threshold, 124

Alert Notification Editor, 125
alerts

controller, 123
enabling, 119
events, 121
thread deadlock, 44
threshold time constraint, 124
viewing log history, 125

allocation
method statistics, 146
metrics by class, 145
object statistics, 145
objects by method, 146
site statistics, 185
using filters, 146

Allocation site statistics
default location of saved data file, 223

allocation site statistics
collecting, 98
using -XX:+PrintAllocStatistics, 98

application
analyzing garbage collection of objects, 94
configuring, 34
configuring to use JVM agent, 25
console reporting name incorrectly, 218
expected time for startup, 212
heap monitor, 50
load, 50
locating command line options in use, 135
profiling performance, 69
scope of display, 83
termination, 57

application performance
-agentlib, 27, 77
-Xrunjmeter, 27
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appserver_port, 27
arc

call graph tree, 90
array

leak location, 130
live sizes, 169

automatic find immediately, 84

B
batch

JVM agent options, 29, 48
saving session data, 48

BEA
lock contention, 55

benchmark
creating for performance testing, 71
guidelines, 71

bytecode instrumentation
filtering, 28

bytes
total allocated, 106

C
call count, 89

methods, 163
call graph, 70, 82
Tree menu, 163

call graph tree
call count, 89
clock time, 89
CPU time, 89
cumulative calls, 90
interpreting data, 90
lock delay, 89, 178
method call count, 165
method nodes, 90
node colors, 89
object reference, 89
reference graph, 89
using, 89
with clock time, 165
with CPU, 165

call tree
Auto Expand, 91
changing display of, 91
expanding automatically, 91
pruning, 91
Restore Roots, 91
searching, 92
Set as Root(s), 91
using sub-trees for easier navigation, 91

calls
cumulative number of to method, 163

Can't use port port_number, 221
class

average exclusive clock times, 168
average exclusive CPU times, 167
filtering, 28
loaded, 57, 158

loader, 173
loading status, 58
lock delay, 179
object allocation, 54
types, 174

clock
call graph, 89
method, 69
metrics, 69
time, 69, 82, 83
toggle hours to total seconds, 202
toggle total seconds to hours:minutes, 202

cluster
deployment, 55

CMS
mark first pause, 104
mark second pause, 104

CMS (concurrent mark-sweep), 103
code/CPU monitoring menu, 116
code/CPU profiling menu, 163
color

call graph tree node key, 89
change selection in histogram, 210
reset defaults, 115

command
locating options in use during monitoring session, 135

command line usage
-Xverbosegc, 94

command-line options
-agentlib, 27
-agentlib:hprof, 69, 76
-d64, 26
-Xeprof, 69
-Xloggc, 94, 100
-Xrunjmeter, 27
-Xverbosegc, 94

Compare button, 85, 102
compare files
.eprof, 85, 102
.hprof.txt, 85, 102
.vcg, 85, 102

compilation
count frequency, 157
count method, 156
excessive method, 56

concepts
agent, 22, 23
console, 22
managed node, 22

concurrent mark and sweep GC, 95
reasons for completion, 96
reasons for non-completion, 96

concurrent mark-sweep
incomplete, 104

concurrent mark-sweep (CMS), 103
confidence interval

sampling, 213
Configure

remote operations, 75
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connect
to node agent through firewall, 35
via SSH, 35

connection failed
node agent not running, 47

console
-log option, 219
bring to front, 201
command-line options, 219
filters, 46
guide, 116
launching from HP Systems Insight Manager, 110
main data pane, 111
main window, 110
memory use, 117
OutOfMemoryError, 218
performance, 218
performance overhead, 213
reports incorrect application name, 218
requirements, 24
session preferences, 117
starting, 34, 110
starting from command line on HP-UX, 110
starting on Linux, 110
starting on Microsoft Windows, 110
status bar, 117
using marked object history to find objects, 203

console guide
enable or disable, 34

contention
threads, 55

controller
alert, 123

controls
Alert Notification Editor, 126

count
method calls, 69
method compilation, 56

CPU
call graph, 89
exclusive method times, 164
monitoring percent usage, 158
time, 82, 83, 88
virtual time, 83

cpu
hprof options, 78

CPU usage
by processes, 131
by system, 132

crash
application, 57

cutoff
hprof options, 78

D
daemon

node agent, 47
verifying node agent, 47

data

capturing a snapshot of current live heap objects, 163
collection, 46
comparing, 163
comparing files, 85, 102
confirming integrity of, 32
display, 46
interpreting, 82
locating summaries, 83, 102
precision, 106
printing, 163
protecting confidentiality, 32
saving, 113, 163
saving from console, 49
scaling for comparison, 86
selecting filters, 46
setting collection preferences, 46
zooming in on a subset in GC viewers, 206

deadlock
detecting, 62
threads, 55

delegate
SSH tunnel host, 36

depth
hprof options, 78

display
monitoring, 135
node color example, 90
possible problem methods, objects, 92
profile, 160
unknown values for GC type, 191

dormant mode
performance overhead, 212

dying
threads, 54

dynamic attach, 25, 212

E
e-mail

alert notification, 119, 125
Eden

space, 105
sub-space in new generation, 98

Edit menu
find functions, 163
Scale, 163
Scale Special, 163

errors
installation, 217
JRE path, 217

Estimate menu, 92, 134, 180
exceptions thrown, 180
locating inlining candidates, 180
memory leak possibilities, 180

event
alerts, 121

example
JVM agent option usage, 31
node color display, 90

exceptions
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filters, 138, 139
metrics, 138
stack traces, 139
thrown, 180
uncaught, 54
uncaught statistics, 127

excessive compilation
set threshold for alert, 124

exclude=, 28
exclusive method clock time, 81
exclusive method CPU time, 81
exclusive time, 82

F
features, 21

and JVM version, 222
file
-Xeprof options, 73
compressed, 49
default location for allocation sites statistics data, 223
default location for Xverbosegc data, 223
directories, 25
open, 114

File menu, 115, 163
file name suffix
.eprof, 78
.hpjmeter, 49
.hprof.txt, 78
.vgc, 101

files
comparing, 85, 102

filter
adding to change monitoring preferences, 121
allocation statistics, 146
classes, 28
creating sets of packages or classes, 121
editing to change monitoring preferences, 120
exceptions, 138, 139
excluded packages, 28
JMX MBean list, 63, 64
JMX server list, 64
JVM agent options, 28
packages, 28
performance overhead, 212
specifying, 120
thread list in JMX viewer, 62
types, 46

finalizer
queue growth, 133

find
Edit menu, 163
mark item for, 203
search patterns, 204

firewall
connecting through to node agent, 35
working with tunnel, 32

format
hprof options, 78

full garbage collection, 103

full GC, 95
comparing percent time spent, 107
old, 104
old expanded, 104
other, 104
percent time spent, 106
permanent, 104
print data, 94
start from JMX viewer, 61
train algorithm, 104

G
G1 Cleanup, 104
G1 Evacuation

pause, 104
G1 Initial Mark

Evacuation Pause, 104
G1 Remark, 104
garbage collection

activity summary, 106
average allocation rate, 106
average ideal allocation rate, 106
basic concepts , 103
comparing percent time spent, 107
displays, 181
duration alert, 128
duration metric, 142
duration of measurement, 106
event metric, 141
events, 106
forced by JVMTI, 104
heap monitor, 140
HotSpot VM, 141
memory leaks, 53
object persistence, 103
options and corresponding metrics, 101
pauses, 50
percent time spent, 106
percent time spent in full, 106
percentage of spent, 51
percentage spent, 143
program time at beginning, 97
reasons for, 95
residual bytes, 106
size of object allocation, 97
start from JMX viewer, 61
stop-the-world duration, 98
Summary tab, 105
system details tab, 107
System.gc(), 51, 104
thread state, 88
time spent, 106
total bytes allocated, 106
type, 100
types, 103

garbage collection data
understanding the use of, 94
viewing, 41

garbage collection viewer
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behavior, 134
tabs, 134

garbage first
incomplete, 104

GC data
-Xloggc, 100
-Xverbosegc, 94
-Xverbosegc options, 94
collecting, 94
collecting with zero preparation, 99

GC event
cumulative duration, 60
duration, 100

GC events
total count, 60

get started
console guide, 34
monitoring application, 34

Glance data, 194
collecting, 98
using javaGlanceAdviser.ksh, 98

Glance system call data, 198
graphical scrolling

pause and resume, 205
group_private, 27

H
heap

activity, 168
capacity, 105
capturing a snapshot of , 163
checking size for best allocation, 53
current live objects metric, 147
current usage, 58
decrease pressure, 54
hprof options, 77
memory usage in, 59, 75
percent of allocated used, 147
set threshold for usage alert, 124
usage, 106
usage after GC event, 100
usage alert, 129
usage before GC event, 100
usage maximum, 100

heap dump triggered GC, 104
heap monitor

application load, 50
application paging, 50
excessive System.gc() calls, 51
garbage collection pauses, 50
memory leaks, 53
metrics, 140

help
-Xverbosegc, 94

helper methods, 137
histogram

change color selection, 210
interpreting, 89
reading, 87

thread color values, 88
thread groups, 87, 176
threads, 87
time considerations, 87

history
alert log, 125

hot spots
java methods, 49

HotSpot
Garbage Collector, 94

HotSpot JVM, 136
CPU usage, 49
garbage collection, 141
method compilation, 57
out of memory, 220
too many loaded classes, 57

HP-UX
*fifo files, 221
/tmp, 221
node agent daemon, 47

HPjconfig, 24
hpjmeter script, 218
hprof

profiling with, 69, 76
hprof options, 79
cpu, 78
cutoff, 78
depth, 78
format, 78
heap, 77
thread, 78

I
ie
-Xeprof options, 74

include=, 28
inclusive time, 82
inlining
-Xeprof options, 73
candidates, 180
locating candidates for, 92

input/output
time, 88

installation
errors, 217
notes for Itanium-based systems, 26

intrusion
profiling, 212

Itanium-based systems
shared library path, 26

J
Java Method HotSpots

description, 136, 137
Java SDK 1.4.x

shared library path, 26
Java Virtual Machine

locating configuration in use during monitoring session,
135
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standard management (JMX), 215
JBoss

excluded packages, 28
JM_JAVA_HOME

installation, 26, 217
jmap tool, 79
JMX server

filter list of, 64
JMX server view, 63
JMX summary view, 58
JMX viewer, 215

change MBean attributes, 64
launching, 57
see thread list, 62
set deadlock detection, 62
set memory thresholds, 61
set notifications, 63
track live threads, 61
using, 57
view runtime data, 63

jps command, 79
JVM

Summary, 116, 135
version and HPjmeter features, 222

JVM agent
-logging option, 220
active mode, 212
command-line options, 220
concepts, 22
data icons, 112
filters, 46
performance overhead, 212

JVM agent options, 27
group_private, 27
include=, exclude=, 28
logging, 29
monitor_batch, 48
noalloc, 30
noarrayleak, 30
noclassload, 30
nocompilation, 30
noeprof, 31
noexception, 30
nogc, 30
nohotspots, 30, 212
nojmx, 31
noliveheap, 31
nolockcon, 31
nomemleak, 30
nosocket, 31
nothreads, 31
nothrownstack, 30
owner_private, 31
port, 27
public, 31
usage examples, 31
verbose, 31
version, 31

JVM agents

dormant mode, 212
JVM option

noalloc, 212
JVM switches
-Xverbosegc, 94

JVM version
locating, 63

JVM/system monitoring
submenu, 116

K
kernel parameters

thread per process limit, 56
key

call graph node color, 89
reported thread states, 87

L
LD_LIBRARY_PATH

configure , 26
leak

array, 130
confirming memory, 53
detection, 214
heap monitor, 53
memory, 129

LIBPATH
configure, 26

library
alternate for support of PA –V2 option, 27

license
copy for software agreement, 2

Linux
starting console on, 110

load
heap monitor, 50

loaded classes
crashes, 57
excessive, 57
metrics, 57, 158

lock claims
by method, 178

lock contention, 88, 89
identifying, 55
locating likely contributors, 153, 177
metrics, 153
ratio by method, 179
thread histogram, 55
threads, 152
WebLogic, 55

lock delay, 89
call graph tree, 178
class exclusive, 179
lock contention, 177
method exclusive, 178
method exclusive average, 179
method exclusive with clock time, 179
method inclusive, 178
method inclusive average, 179
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method inclusive with clock time, 179
locks

uncontested, 177
log

alerts, 125
changing capacity (number of lines), 125
viewing alert history, 125

logging, 29, 219, 220, 221
look and feel

menu, 115

M
main window

close, 114
console, 110
console guide, 116
console main data pane, 111
delete, 114
edit, 114
open, 114
tool bar, 114

mark and sweep GC, 95
marked object history

accessing, 203
MaxPermSize

HotSpot JVM, 220
MBean

attributes, 65
Attributes tab in JMX viewer, 64
change attributes in JMX viewer, 64
enabling notifications for attributes, 67
filter list of, 63, 64
list of, 64
Notification tab, 67
Operations tab, 66
relational information, 67
tab navigation in JMX viewer, 64
using operations functions in the JMX viewer, 66

measurement
disabled for zero preparation GC data collection, 106
enabled for zero preparation GC data collection, 106

memory
allocation statistics, 58
checking heap allocation, 53
confirming leaks, 53
console use, 117
designating area of interest in JMX viewer, 60
heap monitor, 53
JMX tab, 59
leak detection, 214
leak location, 129
leak possibilities, 180
leak sample application, 43
leak severity, 53
leak window, 128
locating assignment, 63
locating inefficiencies in usage, 82
locating problems, 92, 140, 168
paging, 50

set threshold for expected out-of-memory alert, 124
set threshold for leak location alert, 124
spaces, 59
usage, 60
usage fluctuations in heap, 59
usage thresholds in JMX viewer, 61

menu
Edit, 115

menus
console, 115
Estimate, 163, 180
File, 115, 163
Help, 115, 163
look and feel, 115
Metrics, 41, 163
Metrics →Code/CPU , 163
Monitor, 39
Scope, 163
Sort, 163
Tree, 163
View, 163
visualizer, 163

messages
JMX viewer, 67

method
average exclusive clock times, 166
average exclusive CPU times, 166
average inclusive clock times, 166
average inclusive CPU times, 166
call count, 163
callers, 163
created objects, 168
exceptions thrown, 180
excessive compilation, 56
excessive object allocation, 54
exclusive clock times, 164
exclusive CPU times, 164
helper, 137
high usage, 137
inclusive clock times, 165
inclusive CPU times, 165
locating all lock claims, 178
locating contested lock claims, 178
lock contention, 179
lock delay, 178, 179
looping as an indicator, 167
monitoring CPU time consumed by, 136
starvation, 166

method call count, 81
call graph tree, 165
example usage, 87

method compilation count
metrics, 156

method compilation frequency
metrics, 157

Method hot spots
CPU usage, 49

metrics
access monitoring data for viewing, 121
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Allocation Site Statistics, 185
analyzing profile data, 81
Creation Rate, 184
Cumulative Allocation, 183
Current Live Heap Objects, 147
derived, 163, 177
disabled, 116, 163
Duration (Stop the World), 182
enable, 116, 163
garbage collection, 51, 53, 141
garbage collection duration, 142
Glance data, 194
Glance system call data, 198
heap monitor, 53, 140
Heap Usage After GC, 181
how sorted, 81
Java Method HotSpots, 136
load data for viewing, 160
loaded classes, 57, 158
lock contention, 153
menus, 116
method compilation count, 156
method compilation frequency, 157
Multiple User-Defined for GC analysis, 192
naming GC data files, 101
naming monitoring data files, 49
naming profile data files, 78
object allocation by class, 54, 145
object allocation by method, 54, 146
OutOfMemory error, 128
percentage spent in garbage collection, 143
saving session data, 48
specifying, 118
system call data, 198
thread histogram, 152
thread histogram and abnormal thread termination, 54
thread histogram and lock contention, 55
thread histogram and short-lived threads, 55
thrown exceptions, 138
thrown exceptions with stack trace, 138
unfinalized objects, 144
User-Defined X-Y Axes for GC analysis, 191
viewing, 39, 41

Metrics menu, 39, 134
modes

active, 212
dormant, 212

Monitor menu, 39
visualizer behavior, 134

monitor_batch, 48
saving session data, 48

Multiple User-Defined tab in GC viewer, 192

N
native idle, 88
noalloc, 30

JVM options, 212
noarrayleak, 30
noclassload, 30

nocompilation, 30
node

color display example, 90
node agent
-logging option, 221
-port option, 47, 48, 221
Can't use port port_number, 221
command-line options, 47, 48, 221
concepts, 23
configuring, 47
confirm status, 34
connecting to, 34, 35
connection options, 222
daemon, 47
data icons, 112
multiple, 48
not running, 47
performance overhead, 212
port number, 47, 48, 221
security, 48
starting, 47
stopping, 48

noeprof, 31
noexception, 30
nogc, 30
nohotspots, 30

JVM options, 212
nojmx, 31
noliveheap, 31
nolockcon, 31
nomemleak, 30
nosocket, 31
nothreads, 31
nothrownstack, 30
notification

e-mail alert, 125
enabling alert e-mail, 119
enabling for MBeans attributes, 67
JMX tab, 63
JMX viewer, 67

O
object

copying data into a spreadsheet, 148
created (by count), 168
created (in bytes), 168
created by method, 168
cumulative size, 147
current live instances, 147
live, 169, 170
live (by count), 169
live (in bytes), 169
monitoring live in heap, 147
newborn tenuring threshold, 98
not yet finalized, 144
reflective, 98
residual by count, 175
residual in bytes, 175
sorting in Current Live Heap Objects table, 148
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storage of in permanent generation, 98
unfinalized, 169

object allocation by class
excessive, 54
metrics, 145

object allocation by method
excessive, 54
metrics, 146

object reference
call graph, 89

Object Reference Graph
pruning, 91

old full GC, 104
old generation, 95, 103, 105

print data, 94
spaces, 98

old too full GC, 104
operating system version

locating, 58
optimization

method compilation, 56
options

alert e-mail notification, 126
JVM agents, 27
node agents, 47

options used
locating, 63

Oracle9i
excluded packages, 28

out-of-memory
alerts, 128
confirming, 53
console, 219, 220
HotSpot JVM, 220
program termination, 57

overhead
performance, 212
profiling, 88, 212

owner_private, 31

P
package

filtering, 28
paging

heap monitor, 50
parallel scavenge, 103
patches

required, 24, 25
PATH

configure, 26
path

JRE and installation, 217
pattern

locating in search, 204
pause in garbage collection

heap monitor, 50
peak utilization

heap, 105
percent of time spent in garbage collection , 143

performance
console, 218
overhead, 212
tuning, 70

perm full GC, 104
permanent generation

spaces, 98
pooling

threads, 55
port

configuring node agents, 47
JVM agent options, 27
node agent daemon, 47

port number
Can't use port port_number, 221

preferences
alerts, 119
delete, 115
look and feel, 115
session, 117
standard, 115
window, 115

print
full GC data, 94
old generation data, 94
scavenge garbage collection data, 94
screens or data, 163

procedure
set process CPU usage alert, 131
set system CPU usage alert, 132

process
CPU usage (%), 131
swap indicator, 106

profile
overhead, 88

profile data
-agentlib:hprof, 76
-agentlib:hprof options, 77
-Xeprof, 72
-Xeprof options, 73
collecting, 72
collecting with zero preparation, 74
create benchmark, 71
intrusion, 212
overhead, 212
overview, 69
reading histograms, 87
tracing, 70
understanding the use of, 69
viewing, 39

profiling
Configure remote operation, 75
locating hot spots, 92
options and corresponding metrics, 79
using sampling with, 70
zero preparation, 221

profiling viewer
behavior, 134
changing scope, 163
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scope, 83
tabs, 134

program termination, 57
Prune, 91
public, 31

R
recursive calls

indicator, 91
recursive methods

and time, 82
time, 91

reference graph
call graph tree, 89
sub-trees by size, 170
tree of live objects, 169

Remote operation window
configuration, 75

requirements
agent, 24
console, 24
patch, 24, 25
system, 24

restrictions
access, 48

run_simple_jvmagent script, 42, 43, 45, 218
runtime

JMX tab, 63
statistics, 63

S
sample application

memory leak, 43
running, 42
thread deadlock, 44

sampling
considerations, 213

saving
from application session, 48

scalability
assess for application, 89

Scale, 86
Scale Special, 86
scaling data

examples, 86
scavenge, 95, 103

during CMS, 103
non-parallel, 95
parallel, 95, 103
print data, 94

scope
adjusting, 83
automatic find immediately, 84
changing in profiling viewer, 163

scripts
hpjmeter, 218
run_simple_jvmagent, 42, 43, 45, 218
setup_jvmagent_environment, 218

search

mark item for, 203
patterns, 204

SecureShell tunnel, 35
security, 32

node agents, 48
session

cached, 113
data icons, 113
saving data, 48

session preferences, 117
setting, 37, 46

setup_jvmagent_environment script, 218
shared library path

Itanium-based systems, 26
SHLIB_PATH

configure, 26
Show Formula, 87
size

setting for alert log, 125
sleeping

thread state, 88
SLO violations, 57
snapshot

saving session data, 48
SSH delegate, 36
stack traces

exceptions, 139
uncaught exceptions, 128

starvation, 166
change color selection in histogram, 210
ratio, 167
thread state, 88
threads, 89

state
reported for threads, 87

statistics
allocated object, 144, 145
allocating method, 146
allocation site, 185

status bar
console, 117

stop-the-world, 98
submenu

code/CPU monitoring, 116
code/CPU profiling, 163
JVM/system monitoring, 116
memory/heap monitoring, 116
memory/heap profiling, 163
threads/locks monitoring, 116
threads/locks profiling, 163

summary
JMX tab, 58
locating for GC data sets, 102
locating for profile data sets, 83

SunOne
excluded packages, 28

support
obtaining, 217

survivor
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sub-space in new generation, 98
survivor space, 103, 105
swap space

locating statistics, 63
system

CPU usage (%), 132
system call data, 198
System.gc(), 104

comparing percent time spent, 107
excessive calls, 141
heap monitor, 51

T
tabs

garbage collection viewer, 134
JMX memory, 59
JMX Summary, 58
MBean Attributes, 64
MBean notification, 67
MBean Operations, 66
Notifications, 63
profiling viewer, 134
Runtime, 63
threads, 61

termination
abnormal thread, 54
application, 57

thread
hprof options, 78

thread histogram
abnormal thread termination, 54
deadlocked threads, 55
excessive threads, 56
metrics, 152
short-lived threads, 55

thread spectrum, 87
threads

abnormal termination, 54, 126
activity in JMX viewer, 62
color values for in histogram, 88
CPU time, 88
current state in JMX viewer, 62
deadlock, 44, 133
deadlocked, 55
detecting deadlock, 62
excessive, 56
filter list in JMX viewer, 62
garbage collection, 88
GC, 95
group histogram, 176
group lifetime, 176
histogram, 152
input/output time, 88
JMX tab, 61
key to states, 87
lifetime, 175
lock contention, 55, 88, 152
native idle, 88
pooling, 55

profiling histogram, 175
profiling overhead, 88
running, 152
scope of display, 83
set threshold for abnormal termination alert, 124
set threshold for deadlock alert, 124
short-lived, 55
sleeping, 88
sorting choices in histogram, 163
sorting in histogram, 176
spectrum analysis, 89
starvation, 88, 89
state indicator, 176
tracking live, 61
tuning per process limit, 56
waiting, 88, 89, 152

threshold
alert controller, 124
set memory usage in JMX viewer, 61
setting for alert notification, 124
tenure, 98

thrown exception
locating likely contributors, 92, 138
metrics, 138

time
and recursive methods, 82
beginning of garbage collection, 97
clock, 83
CPU, 83
cumulative, 100
inclusive, 90
inclusive versus exclusive measures, 82
sampling, 83
setting default interval in GC viewer, 163
spent in garbage collection, 51
treatment of profiling overhead, 83
units, 82

time interval
applying across GC visualizers, 208
changing in a monitoring visualizer, 209
changing in GC visualizers, 206
reset to default values across all GC visualizers, 209

time slices
data icons, 113

time_on
-Xeprof options, 73

time_slice
-Xeprof options, 73

tmp
*fifo files, 221

tool bar
main window, 114
visualizers, 201

tracing, 70
train full GC, 104
troubleshooting

documentation, 217
obtaining support, 217
zero preparation profiling, 221
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U.S. Government License, 11
uncaught exception, 127

abnormal thread termination, 54
stack traces, 128

unfinalized objects, 144, 169
unknown values

display of in GC viewer, 191
uptime

locating, 63
user access

configuring, 32

V
verbose, 31
verbose GC

start logging from JMX viewer, 61
stop logging from JMX viewer, 61

version, 31
identifying, 217
locating for Java, 27

viewer
JMX, 57

virtual server
lock contention, 55

visualizer
behavior when monitoring, 134
behavior when profiling, 134
pause scroll of display, 205
resume scroll of display, 205
tool bar buttons, 201
using, 201

W
waiting

thread state, 88
threads, 89

wall clock time, 106
warranty, 11
WebLogic

excluded packages, 28
lock contention, 55

WebSphere
excluded packages, 28

window
main, 110

X
Xbootclasspath

configure, 26
Xmx

console memory, 219
Xverbosegc

default location of saved data file, 223

Z
zero preparation GC data collection

starting, 99
stopping, 99

zero preparation profiling
starting, 74
stopping, 74

zooming in on a data subset, 206
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